
Customer Release Notes
Fiery Command WorkStation Package, v6.3

This document contains important information about this release. Be sure to provide this information to all users
before proceeding with the installation.

About this release

The following applications are included in this release:

• Fiery Command WorkStation Package v6.3.0.333

• Fiery Command WorkStation v6.3.0.58

• Fiery Hot Folders v3.12.0.35

• Fiery Software Manager for Mac v4.2.0.16

• Fiery Software Manager for Windows v4.2.0.16

Note:

This installer will upgrade any existing Fiery Command WorkStation Package or Fiery Extended Applications
Package to the latest Fiery Command WorkStation Package containing Fiery Command WorkStation and Fiery Hot
Folders. Optionally, you can install Fiery Remote Scan by using Fiery Software Manager.
Fiery Command WorkStation Package supports Fiery servers running System 10/10e and later, and Fiery proServer
and Fiery XF 7.0 and later. It will not connect to:

• Fiery servers running Fiery System 9/9e Rel2 software and previous versions

• Fiery XF 6.x servers and earlier

• Fiery Central servers

If you need access to these products, do not upgrade. Fiery Extended Applications Package is still available at 
www.efi.com/cws. For a full list of supported cutsheet printers, see http://fiery.efi.com/CWS/supported-printers.
For more information on technical specifications, refer to www.efi.com/cws.

What's new?

Cutsheet printers: http://fiery.efi.com/CWScutsheetWN
Wide and superwide printers: http://fiery.efi.com/CWSwideformatWN
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64-bit application

Fiery Command WorkStation 6.3 (CWS) is a native 64-bit application for both macOS and Windows platforms.
32-bit operating systems are not supported for CWS 6.3. If Fiery Software Manager is already running on a 32-bit
operating system (OS) such as Windows 7 32-bit, it will not display the update notifications for the CWS 6.3
package. If you attempt to run this version of Fiery Software Manager on a 32-bit OS, you will see a compatibility
error, and Fiery Software Manager will not run. To view the supported operating systems, see http://fiery.efi.com/
cws-specifications.

Fiery Color Profiler Suite and Fiery Command WorkStation 6.3

Fiery Color Profiler Suite 5.0 (CPS) and earlier versions are not fully compatible with Fiery Command WorkStation
Package 6.3 (CWS) for cutsheet printers. We recommend updating to Fiery Color Profiler Suite 5.1.
When using CPS 5.0 with CWS 6.3, you may experience the following issues:

• If you see a message in CWS "Connect the spectrophotometer to your computer" while CPS is currently open,
close CPS and click OK to continue.

• After you create a new calibration setting in Calibrator, the Create new profile button to launch CPS is hidden.
This issue is resolved after upgrading to CPS 5.1.

Note: CWS 6.3 connected to Fiery XF servers with CPS 5.0 is a supported configuration.

Upgrading Fiery JobFlow for use with Fiery Command WorkStation 6.3

Fiery JobFlow 2.5 is compatible with Fiery Command WorkStation Package 6.3. Earlier versions of Fiery JobFlow are
not supported.
Fiery JobFlow 2.5 is backwards compatible with Fiery Command WorkStation versions 5.8 through 6.2. However, if
you upgrade to Fiery Command WorkStation 6.3, you must also update to Fiery JobFlow 2.5. For more information,
see www.efi.com/jobflow.

HiDPI monitor support

Fiery Command WorkStation 6.3 fully supports HiDPI monitors, following the Microsoft Windows Display > Scale
and layout settings, so fonts and other items can be scaled at a different size to the overall display resolution. Some
fonts in the application may appear slightly soft or fuzzy depending on the scaling factor selected in Windows.
However, readability and functionality are not affected.

Discontinued features
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Fiery Hot Folders filters

The following are no longer supported for conversion by Fiery Hot Folders:

• Filters included in Fiery Graphic Arts Package, Premium Edition and Fiery Productivity Package: PDF2GO,
ExportPS, CT-LW, DCS 2.0, and TIFF-IT.

• Conversion from PDF to PS (PostScript) within Fiery Hot Folders has been discontinued because the Adobe
PDF Print Engine (APPE) allows the Fiery server to process and render PDF jobs natively without the need
to convert them to PostScript.

Fiery Remote Scan TWAIN plug-in

The Fiery Remote Scan TWAIN plug-in has been discontinued, which removes the ability to scan pages directly
into third-party applications such as Adobe Acrobat or Adobe Photoshop. However, the Fiery Remote Scan
standalone application remains fully supported to retrieve scan jobs and automatically synchronize scan
mailboxes on a supported Fiery server with your computer.

Fiery JobMaster scanning

Fiery JobMaster 5.0 (included in the Fiery Command WorkStation Package 6.3) no longer supports TWAIN
scan drivers.
Fiery JobMaster 5.0 adds support for:

• WIA (Windows Image Acquisition) drivers

• Mac ICA (Image Capture Application) drivers

• Fiery Remote Scan version 6.7 plug-in (specific to the Fiery JobMaster application)

Fiery Software Manager application shortcuts

Fiery Software Manager does not create application shortcuts on the Windows desktop or in the macOS Dock.
However, Fiery Command WorkStation installations directly on the Fiery server will continue to have
application shortcuts added to the Windows desktop.

Issues fixed in Fiery Command WorkStation Package v6.3.0.333

The following issues are fixed:
Fiery Command WorkStation

• An unhandled exception message no longer occurs when you open certain PDF files in Fiery Impose and Fiery
Preview.

Fiery XF

• It was not possible to create GIFs for VUTEk 32r and h3/h5 printers set up for IP printing if the printer was
previously configured to print to file with the Create GIF preview of RTL files option disabled in the Special
Settings window.

• When selecting calibration settings in Color Tools, the output option Dot size is now correctly displayed as Multi-
strike for Epson SureColor S306X0 printers.
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• The tonal values saved to visual plate compensation files now correspond to those saved in Fiery XF 6.5.

• When optimizing a profile in Color Tools, the position of the Optimize button now remains static. Previously, the
button moved progressively down the window with each iteration and eventually became unavailable.

Issues fixed in Fiery Command WorkStation Package v6.3.0.307

The following issues are fixed:
Fiery Command WorkStation

• You can now easily access Paper Catalog, Align Tray, and Device Center when you log in to a Fiery server as an
Administrator with a password containing special characters and a length of more than 10 characters.

• On macOS computers, Fiery Calibrator launched from Fiery Command WorkStation now beeps when you
recalibrate or create a calibration with the ES-1000 measuring device.

• When you dragged and dropped the spot colors in Device Center > Resources > Spot Colors, Fiery Command
WorkStation stopped responding.

• In some instances, when you opened a job in Fiery Preview, Fiery Impose, Fiery Compose, or Fiery JobMaster,
the preview images appeared blurred.

Fiery XF

• Job Editor was not able to display the line thickness of crop marks correctly.

• In a multi-page nesting job, Job Editor would stop responding if changing the page orientation or the distance
between pages caused a new nesting page to be created.

• In some instances, the Fiery XF server would not start after you upgraded to Fiery Command WorkStation 6.3,
due to the unavailability of the EFI License Manager service.

Issues fixed in Fiery Command WorkStation Package v6.3.0.280

The following issues are fixed:
Fiery Command WorkStation

• On a Fiery server with a large number of Paper Catalog entries, you could not scroll through all the Paper
Catalog entries to assign media to a tray, if Fiery Ticker was running.

• With Fiery Command WorkStation set to a language other than English, when you selected a starting date of a
range in the Job Log, no logs were displayed even though jobs were available in the Job Log.

Fiery XF

• When you select any ISO 12647-7 control bar, the printed job label contains all the information that is required
to achieve ISO compliancy. You cannot deselect these settings. You can, however, select additional settings in
Job Label Editor, if required.

• It was not possible to select an alias spot color in Job Editor if Fiery Command WorkStation was logged on
remotely to a Fiery XF server.

• You can now correctly save cut contour sources and methods as a preset.

• If Borderless printing was selected, the spooled job failed with an Invalid sheet size detected error.
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• With Some combinations of Fiery Command WorkStation and Fiery XF, the M2 measurement mode setting was
not saved when using an Epson SpectroProofer ILS30 measuring device to optimize a profile in Color Tools. Even
if you selected M2 (UV cut), the result included UV, which is measurement mode M1.

• If you tried to optimize a verification measurement using the M2 measuring mode method for the Epson
SpectroProofer IL30, no improvement could be detected because the M2 measurement was not saved.

• On macOS computers, Fiery Command WorkStation stopped responding when jobs were sorted by clicking on
column headings in Job Center.

• In Color Tools > Re-Calibration by Measurement, the recommended steps to be followed after measuring the first
chart were truncated in some languages.

• With dual monitors, you can now re-launch Color Tools on the secondary monitor. Previously, Color Tools
always opened on the primary monitor.

Issues fixed in Fiery Command WorkStation Package v6.3.0.271

The following issues are fixed:
Fiery Command WorkStation

• When you printed spot color samples, some settings from the Job Properties > Image tab were not being applied.

Fiery XF

• It was previously not possible to create white separations for VUTEk 3r/5r/3r+/5r+ printers because the white
separation was missing in the Output folder. The problem has been resolved in the latest release.

• In Color Editor, swatch books must be printed on a default media size. It is no longer possible to define a custom
media size.

Issues fixed in Fiery Command WorkStation Package v6.3.0.259

The following issues are fixed:
Fiery Command WorkStation

• With the Fiery server configured in a language other than English on a macOS computer, when you accessed
Server > Logs > Print > Local Printer > Print, the Print dialog box that opened was in English. .

• Fiery Hot Folders preferences no longer contains a Fiery Impose template path selection. Instead, it uses the
same path as Fiery Command WorkStation.

• Fiery Calibrator starts and responds more quickly.

Fiery XF

• In Job Editor, you could not edit the Scale values to customize a crop area.

• In Color Tools > Create Calibration > Summary, you could not open a media profile in Profile Inspector to
compare its color gamut with that of the calibration file.

• You could only print advanced calibration charts if the operating system was set to English.

• Using a Barbieri Spectro LFP qb measuring device over IP to create a calibration file generated incorrect IT8
data. As a result, you could not open the calibration file in Color Tools > Create Calibration > Summary > Profile
Inspector.
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• If you set up a verify job in Job Editor to measure a dynamic wedge using a built-in measuring device, Job Editor
displayed incorrect delta E results after verification. Both Verifier and Job Editor now display the correct delta E
values.

• When you modified the total ink limit (TIL) value in Color Tools > Create Calibration > Total Ink Limit for any
VUTEk printer, Color Tools stopped responding.

• You could not measure the first chart in the calibration process using the ES-2000 measuring device

Issues fixed in Fiery Command WorkStation Package v6.3.0.234

The following issues are fixed:
Fiery Command WorkStation

• You could not save the Duplex option setting in Spot Colors > Job Properties.

• If you accessed the Calibrator Settings window before recalibrating the Fiery server, Fiery Calibrator stopped
responding.

• While recalibrating using EFI ES-2000 device, if you selected 51 random as patch set value, the printed color
chart and the chart displayed in Fiery Command WorkStation did not match.

• In Calibrator, when you created a calibration, the Generate ACD Data after calibration option was not available
for supported printers.

Fiery XF

• You can now save the PDF box settings in Server Manager > Finishing > Marks > Cut Marks > Contour Cutting.
Previously, only the media box setting could be applied.

• When configuring a printer to print to port, it was not possible to set up a connection to any printer that did not
use port 9100.

• On macOS computers, it is now possible to optimize spot colors. Previously, an incorrect chart was generated
that caused the iteration to fail.

Issues fixed in Fiery Command WorkStation Package v6.3.0.216

The following issues are fixed:
Fiery Command WorkStation

• With the Fiery server configured in a language other than English, when you inserted pages from a job that is
saved on the Fiery server, Fiery Impose or Fiery JobMaster stopped responding.

• In Fiery Impose, when you saved a job as a flattened pdf, layers or objects marked as hidden in Acrobat appeared
on the output.

Fiery XF

• The tile label of scaled tiles is now displayed correctly on the Single Tile View tab.

• Color Tools was not displaying row-by-row measurement data for the calibration and quality control charts.

• When using an i1 Pro2 measuring device to create a profile, the device could not be detected.

• When you set the L*a*b* correction profile (*.3cc) to None, an incorrect error message stated that the profile was
invalid.
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• In some instances, the Fiery XF server would not start after you upgraded to Fiery Command WorkStation 6.3.

• Upgrading to Fiery Command WorkStation 6.3 SP1 caused the C:\Program Data\Fiery\Fiery XF\Client\Working
folder to be deleted. As a result, all measurement data previously saved to this folder was no longer available,
causing incorrect reports to be created.

Issues fixed in Fiery Command WorkStation Package v6.3.0.199

The following issues are fixed:
Fiery Command WorkStation

• You could not print a Booklet Staple job from Hot Folders because of a paper weight error. However, the same
job could be printed from Fiery Command WorkStation without an error.

• On a Japanese-language system, PDF jobs sent to a Hot Folder were not processed if the jobs had a Job Preset
and Impose template.

• If the Preview while processing option was enabled in > Fiery Command WorkStation > Server > Configure > Job
Management, both Fiery Command WorkStation and Fiery server would stop responding while you processed
some imposed jobs.

• When you applied a Server Preset to a job and changed the Server Preset of the same job by right-clicking the job
from the Held queue, the Fiery server would stop responding.

Fiery XF

• On macOS computers, if Fiery Command WorkStation was configured for German, the Cut image values in Job
Editor > Finishing > Marks > Crop Marks were not saved.

• You can now configure printers that are connected to the Fiery server computer through USB. Previously,
selecting the connection type Print via port would display an incorrect message which stated that the selected
port was invalid.

• The maximum overlap/glue area for tiles was set to 3.939 inches. This value has been increased as per a
customer’s request. Overlap/glue margins of more than 6 inches are now possible.

Fixed issues in Service Pack 1 (SP1)

HyperRIP Mode

When you connected to a Fiery server that is FS200 or newer with HyperRIP Mode set to Multiple jobs, the progress
bar may not have been displayed when you sent jobs to Process and Hold.

Fiery Software Manager does not detect the KB2999226 Windows update

The Fiery Software Manager (FSM) version 4.2.0.14 included in later versions of the Fiery Command WorkStation
6.3 SP1 package includes a fix to the following issue: FSM does not detect the KB2999226 Windows update, and
erroneously states that the update still needs to be applied. After you apply the update, the error persists, and in
some cases prevents CWS 6.3 from being installed.
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Notes de mise à jour client
Fiery Command WorkStation Package, version 6.3

Le présent document contient des informations importantes concernant cette version. Distribuez-le à tous les
utilisateurs avant de procéder à l’installation.

À propos de cette version

Cette version comprend les applications suivantes :

• Fiery Command WorkStation Package v6.3.0.333

• Fiery Command WorkStation v6.3.0.58

• Fiery Hot Folders v3.12.0.35

• Fiery Software Manager pour Mac v4.2.0.16

• Fiery Software Manager pour Windows v4.2.0.16

Remarque :

Ce programme d'installation va mettre à niveau tout Fiery Command WorkStation Package ou Fiery Extended
Applications Package existant vers le dernier Fiery Command WorkStation Package contenant Fiery Command
WorkStation et Fiery Hot Folders. Vous pouvez également installer Fiery Remote Scan avec Fiery Software Manager.
Fiery Command WorkStation Package prend en charge Fiery servers qui exécute Fiery System 10/10e et versions
ultérieures, et Fiery proServer et Fiery XF 7.0 et versions ultérieures. Il ne se connecte pas aux serveurs suivants :

• Fiery servers exécutant le logiciel Fiery System 9/9e Rel2 et ses versions précédentes

• Serveurs Fiery XF 6.x et versions antérieures

• Serveurs Fiery Central

Si vous devez accéder à ces serveurs, n'effectuez pas la mise à niveau. Fiery Extended Applications Package est
toujours disponible sur www.efi.com/cws. Pour une liste complète des imprimantes à feuilles prises en charge,
consultez http://fiery.efi.com/CWS/supported-printers.
Pour plus d’informations sur les spécifications techniques, consultez le site www.efi.com/cws.

Nouveautés

Imprimantes à feuilles : http://fiery.efi.com/CWScutsheetWN
Imprimantes grand et très grand format : http://fiery.efi.com/CWSwideformatWN
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Application 64 bits

Fiery Command WorkStation 6.3 (CWS) est une application native 64 bits destinée aux plateformes macOS et
Windows.
Les systèmes d’exploitation 32 bits ne sont pas pris en charge par CWS 6.3. Si Fiery Software Manager est déjà
exécuté sur un système d’exploitation 32 bits (Windows 7 32 bits, par exemple), les notifications de mise à jour du
package CWS 6.3 ne s’affichent pas. Si vous essayez d’exécuter cette version de Fiery Software Manager sur un
système d’exploitation 32 bits, une erreur de compatibilité s’affiche et Fiery Software Manager ne fonctionne pas.
Pour afficher les systèmes d’exploitation pris en charge, consultez le site http://fiery.efi.com/cws-specifications.

Fiery Color Profiler Suite et Fiery Command WorkStation 6.3

Fiery Color Profiler Suite 5.0 (CPS) et les versions antérieures ne sont pas entièrement compatibles avec Fiery
Command WorkStation Package 6.3 (CWS) pour les imprimantes à feuilles. Nous vous recommandons d’effectuer
une mise à jour vers Fiery Color Profiler Suite 5.1.
Lorsque vous utilisez CPS 5.0 avec CWS 6.3, vous pouvez rencontrer les problèmes suivants :

• Si vous voyez le message suivant dans CWS « Connectez le spectrophotomètre à votre ordinateur » alors que
CPS est ouvert, fermez CPS et cliquez sur OK pour continuer.

• Après avoir créé un nouveau paramètre de calibrage dans Calibrator, le bouton Créer nouveau profil permettant
de lancer CPS est masqué. Ce problème est résolu après la mise à niveau vers CPS 5.1.

Remarque : CWS 6.3 connecté aux serveurs Fiery XF avec CPS 5.0 est une configuration prise en charge.

Mise à niveau de Fiery JobFlow pour une utilisation avec Fiery Command WorkStation6.3

Fiery JobFlow 2.5 est compatible avec Fiery Command WorkStation Package 6.3. Les versions antérieures de Fiery
JobFlow ne sont pas prises en charge.
Fiery JobFlow 2.5 est rétrocompatible avec Fiery Command WorkStation, versions 5.8 à 6.2. Toutefois, si vous
effectuez une mise à niveau vers Fiery Command WorkStation6.3, vous devez également effectuer une mise à jour
vers Fiery JobFlow 2.5. Pour plus d’informations, voir www.efi.com/jobflow.

Prise en charge des moniteurs HiDPI

Fiery Command WorkStation6.3 prend entièrement en charge les moniteurs HiDPI et suit les paramètres d’échelle
et de mise en page des écrans Microsoft Windows afin que les polices et d’autres éléments puissent être mis à
l’échelle à une taille différente de la résolution d’écran générale. Certaines polices de l’application peuvent apparaître
légèrement pales ou brouillées selon le facteur de mise à l’échelle sélectionné dans Windows. Cependant, la lisibilité
et les fonctionnalités ne sont pas affectées.

Fonctions supprimées
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Filtres Fiery Hot Folders

Les filtres suivants ne sont plus pris en charge pour la conversion par Fiery Hot Folders :

• Filtres inclus dans Fiery Graphic Arts Package, Premium Edition et Fiery Productivity Package : PDF2GO,
ExportPS, CT-LW, DCS 2.0 et TIFF-IT.

• La conversion de PDF en PS (PostScript) dans Fiery Hot Folders a été interrompue parce qu’Adobe PDF
Print Engine (APPE) permet au Fiery server de procéder au traitement et au rendu des tâches PDF sans les
convertir en PostScript.

Plug-in TWAIN Fiery Remote Scan

Le plug-in TWAIN Fiery Remote Scan a été supprimé, ce qui ne permet plus de numériser des pages
directement dans des applications tierces comme Adobe Acrobat ou Adobe Photoshop. Toutefois, l’application
autonome Fiery Remote Scan reste totalement prise en charge pour récupérer les tâches de numérisation et
synchroniser automatiquement les boîtes sur un Fiery server pris en charge avec votre ordinateur.

Numérisation Fiery JobMaster

Fiery JobMaster 5.0 ( inclus dans Fiery Command WorkStation Package6.3), ne prend plus en charge les pilotes
de numérisation TWAIN.
Fiery JobMaster 5.0 ajoute la prise en charge des éléments suivants :

• Pilotes WIA (acquisition d’image Windows)

• Pilotes Mac ICA (application de capture d’image)

• Plug-in Fiery Remote Scan version 6.7 (spécifique à l’application Fiery JobMaster)

Raccourcis de l’application Fiery Software Manager

Fiery Software Manager ne crée pas de raccourcis d’application sur le bureau Windows ou dans le Dock macOS.
Toutefois, les raccourcis d’application des installations Fiery Command WorkStation directement sur le Fiery
server continueront d’être ajoutés au bureau Windows.

Problèmes résolus dans Fiery Command WorkStation Package v6.3.0.333

Les problèmes suivants ont été résolus :
Fiery Command WorkStation

• Un message d’exception non géré n'apparaît plus lorsque vous ouvrez certains fichiers PDF dans Fiery Impose et
Fiery Preview.

Fiery XF

• Il n’était pas possible de créer des GIF pour les imprimantes VUTEk 32r et h3/h5 configurées pour l'impression
IP si l'imprimante avait été précédemment configurée pour imprimer dans un fichier avec l'option Créer une
prévisualisation GIF ou des fichiers RTL désactivée dans la fenêtre Paramètres spéciaux.

• Lorsque vous sélectionnez des paramètres de calibrage dans Color Tools, l'option de sortie Taille de point est
maintenant correctement affichée en tant que Multi-frappe pour les imprimantes Epson SureColor S306X0.
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• Les valeurs tonales enregistrées dans les fichiers de compensation de plaque visuelle correspondent maintenant à
celles enregistrées dans Fiery XF 6.5.

• Lorsque vous optimisez un profil dans Color Tools, la position du bouton Optimiser reste maintenant statique.
Auparavant, le bouton se déplaçait progressivement vers le bas dans la fenêtre lors de chaque itération, et
finissait par devenir indisponible.

Problèmes résolus dans Fiery Command WorkStation Package v 6.3.0.307

Les problèmes suivants sont résolus :
Fiery Command WorkStation

• Vous pouvez désormais accéder facilement à Catalogue papier, Aligner le bac et Vue périphérique lorsque vous
êtes connecté à Fiery server en tant qu’administrateur avec un mot de passe contenant des caractères spéciaux et
plus de 10 caractères.

• Sur les ordinateurs MacOS, quand Fiery Calibrator est lancé à partir de Fiery Command WorkStation, il émet un
bip sonore lors du recalibrage ou de la création d'un calibrage avec l’instrument de mesure ES-1000.

• Lorsque les tons directs étaient glissés-déposés dans Vue périphérique > Ressources > Tons directs, Fiery
Command WorkStation cessait de répondre.

• Dans certains cas, lors de l'ouverture d'une tâche dans la Prévisualisation Fiery, Fiery Impose, Fiery Compose ou
Fiery JobMaster, les images de prévisualisation apparaissaient floues.

Fiery XF

• Job Editor n'affichait pas correctement l’épaisseur de la ligne des repères de rognage.

• Dans une tâche d'imbrication comportant plusieurs pages, Job Editor ne répondait plus si l'orientation de la page
ou la distance entre les pages étaient changées, ce qui provoquait la création d’une nouvelle page d'imbrication.

• Dans certains cas, le serveur Fiery XF ne démarrait pas après une mise à niveau vers la Fiery Command
WorkStation 6.3, car le service EFI Gestionnaire de licence était indisponible.

Problèmes résolus dans Fiery Command WorkStation Package v 6.3.0.280

Les problèmes suivants sont résolus :
Fiery Command WorkStation

• Sur un Fiery server comportant un grand nombre d'entrées de Paper Catalog, il n’était pas possible de faire
défiler toutes les entrées de Paper Catalog pour affecter un support à un bac, si Fiery Ticker était en cours
d’exécution.

• Si vous avez configuré la Fiery Command WorkStation dans une autre de langue que l’anglais, lorsque vous
sélectionniez une date de début d’une plage dans le Journal des tâches, aucun journal se s'affichait, même si des
tâches étaient disponibles dans le Journal des tâches.

Fiery XF

• Lorsque vous sélectionnez une barre de contrôle ISO 12647-7, l’étiquette de la tâche imprimée contient toutes
les informations nécessaires au respect de la norme ISO. Vous ne pouvez pas désélectionner ces paramètres.
Toutefois, vous pouvez sélectionner des paramètres supplémentaires dans Job Label Editor, si nécessaire.

• Il n'était pas possible de sélectionner une zone de ton direct d'alias dans Job Editor, si la Fiery Command
WorkStation était connectée à distance à un serveur Fiery XF.

Notes de mise à jour client

Fiery Command WorkStation Package, version 6.3

11



• Vous pouvez maintenant enregistrer correctement les sources et méthodes de contour de découpe sous forme de
préréglages.

• Si l'option Impression sans bordure était sélectionnée, la tâche spouleuse échouait et affichait l'erreur Format de
feuille non valide.

• Avec certaines combinaisons de la Fiery Command WorkStation et Fiery XF, le paramètre Mode de mesure M2
n'était pas enregistré lorsque vous utilisiez l'instrument de mesure Epson SpectroProofer ILS30 pour optimiser
un profil dans Color Tools. Même si vous aviez sélectionné M2 (coupe UV), le résultat incluait l'UV, qui est le
Mode de mesure M1.

• Si vous essayiez d’optimiser la mesure de la vérification à l’aide de la méthode de mesure M2 pour l'Epson
SpectroProofer IL30, aucune amélioration n'était détectée, car la mesure M2 n’était pas été enregistrée.

• Sur les ordinateurs MacOS, la Fiery Command WorkStation cessait de répondre lorsque les tâches étaient triées
en cliquant sur les en-têtes de colonne dans Vue tâches.

• Dans Color Tools > Re-calibrage par mesure, les étapes recommandées à suivre après la mesure du premier
diagramme étaient tronquées dans certaines langues.

• Avec deux moniteurs, vous pouvez maintenant lancer à nouveau Color Tools sur le moniteur secondaire. Avant,
Color Tools s'ouvrait toujours sur le moniteur principal.

Problèmes résolus dans Fiery Command WorkStation Package v 6.3.0.271

Les problèmes suivants sont résolus :
Fiery Command WorkStation

• Lorsque vous avez imprimé des échantillons de ton direct, certains paramètres de l’onglet Propriétés de la tâche
> Image ne sont pas appliqués.

Fiery XF

• Auparavant, il n’était pas possible de créer des séparations pour les imprimantes VUTEk 3r/5r/3r+/5r+, car la
séparation blanche ne s'affichait pas dans le dossier de sortie. Le problème a été résolu dans la dernière version.

• Dans Color Editor, les nuanciers de couleurs doivent être imprimés sur un format de support par défaut. Il n’est
plus possible de définir un format de média personnalisé.

Problèmes résolus dans Fiery Command WorkStation Package v 6.3.0.259

Les problèmes suivants sont résolus :
Fiery Command WorkStation

• Avec le serveur Fiery configurés dans une langue autre que l'anglais sur un ordinateur Mac Os, lorsque vous
accédiez à Serveur > Journaux > Impression > Imprimante locale > Imprimer, la boîte de dialogue Impression
s'ouvrait était en anglais.

• Les préférences de Fiery Hot Folders ne contiennent plus la sélection du chemin du modèle Fiery Impose. Au
contraire, il utilise le même chemin que Fiery Command WorkStation.

• Fiery Calibrator démarre et répond plus rapidement.

Notes de mise à jour client
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Fiery XF

• Dans Job Editor, vous ne pouviez pas modifier les valeurs d'Échelle pour personnaliser une zone de rognage.

• Dans Color Tools > Créer calibrage > Résumé, vous ne pouviez pas ouvrir un profil de supports dans Inspecteur
de profil pour comparer ses gammes de couleurs avec celles du fichier de calibrage.

• Vous ne pouvez imprimer des diagrammes de calibrage avancés que si la langue du système d'exploitation était
anglais.

• L'utilisation d'un instrument de mesure Barbieri Spectro PDD QB via IP pour créer un fichier de calibrage
générait des données IT8 incorrectes. Par conséquent, vous ne pouviez pas ouvrir le fichier calibrage dans Color
Tools > Créer calibrage > Résumé > Inspecteur de profil.

• Si vous configuriez une tâche de vérification dans Job Editor pour mesurer une bande de contrôle dynamique à
l'aide d'un instrument de mesure intégré, Job Editor affichait des résultats incorrects de Delta E après la
vérification. Vérifier et Job Editor affichent désormais les valeurs Delta E correctes.

• Lorsque vous modifiiez la valeur de la limite de l'encrage totale (TIL) dans Color Tools > Créer calibrage > Limite
d'encrage totale pour n'importe quel imprimante VUTEk, Color Tools cessait de répondre.

• Vous ne pouviez pas mesurer le premier diagramme dans le processus de calibrage à l'aide de l'instrument de
mesure ES-2000

Problèmes résolus dans Fiery Command WorkStation Package v6.3.0.234

Les problèmes suivants sont résolus :
Fiery Command WorkStation

• Vous ne pouviez pas sauvegarder l'option de paramétrage Recto verso dans les Tons directs > Propriétés de la
tâche.

• Lorsque vous accédiez à la fenêtre de Paramètres du calibrateur avant le recalibrage du serveur Fiery, Fiery
Calibrator cessait de répondre.

• Durant le recalibrage à l’aide du périphérique EFI ES-2000, si vous sélectionniez 51 échantillons aléatoires
comme correctif définissant la valeur, le nuancier imprimé et le diagramme affiché dans Fiery Command
WorkStation ne correspondaient pas.

• Dans Calibrateur, lorsque vous créiez un calibrage, l’option Générer les données ACD après calibrage n’était pas
disponible pour les imprimantes prises en charge.

Fiery XF

• Vous pouvez maintenant enregistrer les paramètres PDF dans Server Manager > Finitions > Repères > Repères
de coupe > Coupe de contour. Auparavant, seuls les paramètres des médias s'appliquaient.

• Lorsque vous configuriez une imprimante pour imprimer sur le port, il n’était pas possible de configurer une
connexion aux imprimantes n'utilisant pas le port 9100.

• Sur les ordinateurs Mac OS, il est désormais possible d’optimiser les tons directs. Auparavant, un diagramme
incorrect était généré provoquant ainsi l’itération à l’échec.

Problèmes résolus dans Fiery Command WorkStation Package v6.3.0.216

Les problèmes suivants sont résolus :

Notes de mise à jour client
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Fiery Command WorkStation

• Avec le serveur Fiery configuré dans une langue autre que l’anglais, lorsque vous insériez des pages à partir d’une
tâche qui était enregistrée sur le serveur Fiery, Fiery Impose ou Fiery JobMaster ne répondait plus.

• Dans Fiery Impose, lorsque vous enregistriez une tâche sous forme de pdf aplati, les couches ou les objets
marqués comme masqués dans Acrobat apparaissaient sur la sortie.

Fiery XF

• L’intitulé des mosaïques mises à l’échelle s’affiche désormais correctement dans l’onglet Affichage mosaïque
simple .

• Color Tools n'affichait pas les données de mesure ligne par ligne pour les graphiques de calibrage et de contrôle
qualité.

• Lorsque vous utilisiez un instrument de mesure i1 Pro2 pour créer un profil, le périphérique ne pouvait pas être
détecté.

• Lorsque vous définissiez le profil de correction L*a*b (*.3cc) sur Aucun, un message d’erreur incorrect indiquait
que le profil n’était pas valide.

• Dans certains cas, le serveur Fiery XF ne démarrait pas après une mise à niveau vers la Fiery Command
WorkStation 6.3.

• La mise à niveau vers Fiery Command WorkStation 6.3 SP1 engendrait la suppression du dossier C:\Program
Data\Fiery\Fiery XF\Client\Working. Par conséquent, toutes les données de mesure précédemment enregistrées
dans ce dossier n’étaient plus disponibles, provoquant la création de rapports incorrects.

Problèmes résolus dans Fiery Command WorkStation Package v6.3.0.199

Les problèmes suivants ont été résolus :
Fiery Command WorkStation

• Vous ne pouviez pas imprimer une tâche d’agrafage de brochure à partir de Hot Folders en raison d’une erreur
de grammage papier. Toutefois, la même tâche pouvait être imprimée à partir de Fiery Command WorkStation
sans erreur.

• Sur un système japonais, les tâches PDF envoyées à un Hot Folder n'étaient pas traités si les tâches possédaient
un modèle de préréglages de tâche et d’Impose.

• Si l'option Prévisualiser pendant traitement était activée dans > Fiery Command WorkStation > Serveur >
Configurer > Gestion des tâches, Fiery Command WorkStation et le serveur Fiery cessaient de répondre pendant
que vous traitiez certaines tâches imposées.

• Lorsque vous appliquiez un Préréglage du serveur à une tâche et modifiiez le préréglage du serveur de la même
tâche par un clic droit sur la tâche à partir de la file d'attente En attente, le serveur Fiery cessait de répondre.

Fiery XF

• Sur les ordinateurs Mac OS, si Fiery Command WorkStation était configuré en allemand, les valeurs Couper
l'image dans Job Editor > Finition > Repères > Repères de coupe n’étaient pas enregistrées.

• Vous pouvez maintenant configurer des imprimantes connectés à l’ordinateur du serveur Fiery via USB.
Auparavant, la sélection du type de connexion Imprimer via le port affichait un message incorrect indiquant que
le port sélectionné n’était pas valide.

• La zone Superposer/Encoller maximale pour les mosaïques était définie sur 3,939 pouces. Cette valeur a
augmenté pour répondre à la demande des clients. Des marges Superposer/Encoller de plus de 6 pouces sont
désormais possibles.

Notes de mise à jour client
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Problèmes résolus dans le Service Pack 1 (SP1)

Mode HyperRIP

Lorsque vous vous êtes connecté à un Fiery server qui est FS200 ou une version ultérieure avec le mode HyperRIP
défini sur Plusieurs tâches, la barre de progression peut ne pas s'être affichée lorsque avez envoyé des tâches à Traiter
et attendre.

Fiery Software Manager ne détecte pas la mise à jour Windows KB2999226

Le Fiery Software Manager (FSM) version 4.2.0.14 inclus dans les versions ultérieures du package Fiery Command
WorkStation 6.3 SP1 comprend un correctif pour le problème suivant : FSM ne détecte pas la mise à jour Windows
KB2999226 et par erreur indique que la mise à jour doit être appliqués. Une fois la mise à jour appliquée, l’erreur
persiste et dans certains cas, empêche l'installation de CWS 6.3.

Notes de mise à jour client
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Note di release per l’utente
Fiery Command WorkStation Package, v6.3

Questo documento contiene importanti informazioni su questa release. Distribuire una copia di questo documento a
tutti gli utenti prima di procedere con l’installazione.

Informazioni su questa release

Questa release comprende le seguenti applicazioni:

• Fiery Command WorkStation Package v6.3.0.333

• Fiery Command WorkStation v6.3.0.58

• Fiery Hot Folders v3.12.0.35

• Fiery Software Manager per Mac v4.2.0.16

• Fiery Software Manager per Windows v4.2.0.16

Nota:

Questo programma di installazione aggiornerà qualsiasi pacchetto di applicazioni esistente Fiery Command
WorkStation Package o Fiery Extended Applications Package all’ultima versione di Fiery Command WorkStation
Package contenente Fiery Command WorkStation e Fiery Hot Folders. Facoltativamente, è possibile installare Fiery
Remote Scan utilizzando Fiery Software Manager.
Fiery Command WorkStation Package supporta Fiery servers che eseguono Fiery System 10/10e e versioni
successive, Fiery proServer e Fiery XF 7.0 e versioni successive. Non si collega a:

• Fiery servers con software Fiery System 9/9e Rel2 e versioni precedenti

• Server Fiery XF 6.x e versioni precedenti

• Server Fiery Central

Se è necessario accedere a questi prodotti, non eseguire l'aggiornamento. Fiery Extended Applications Il pacchetto è
disponibile all'indirizzo www.efi.com/cws. Per l’elenco completo delle stampanti a foglio singolo supportate, vedere 
http://fiery.efi.com/CWS/supported-printers.
Per ulteriori informazioni sulle specifiche tecniche, vedere www.efi.com/cws.

Novità

Stampanti a foglio singolo: http://fiery.efi.com/CWScutsheetWN

HTTP://WWW.EFI.COM/CWS
HTTP://FIERY.EFI.COM/CWS/SUPPORTED-PRINTERS
http://www.efi.com/cws
http://fiery.efi.com/CWScutsheetWN


Stampanti di grandi formati e superwide: http://fiery.efi.com/CWSwideformatWN

Applicazione a 64 bit

Fiery Command WorkStation 6.3 (CWS) è un'applicazione nativa a 64 bit per le piattaforme macOS e Windows.
I sistemi operativi a 32 bit non sono supportati per CWS 6.3. Se Fiery Software Manager è già in esecuzione su un
sistema operativo a 32 bit, ad esempio Windows 7 a 32 bit, non visualizzerà le notifiche di aggiornamento per il
pacchetto CWS 6.3. Se si tenta di eseguire questa versione di Fiery Software Manager su un sistema operativo a 32
bit, verrà visualizzato un errore di compatibilità e Fiery Software Manager non verrà eseguito. Per visualizzare i
sistemi operativi supportati, vedere http://fiery.efi.com/cws-specifications.

Fiery Color Profiler Suite e Fiery Command WorkStation 6.3

Fiery Color Profiler Suite 5.0 (CPS) e versioni precedenti non sono totalmente compatibili con Fiery Command
WorkStation Package 6.3 (CWS) per stampanti a foglio singolo. Si consiglia di eseguire l'aggiornamento a Fiery Color
Profiler Suite 5.1.
Quando si usa Color Profiler Suite 5.0 con CWS 6.3, si potrebbero verificare i seguenti problemi:

• Se in CWS viene visualizzato il messaggio "Connetti lo spettrofotometro al computer" mentre Color Profiler
Suite è aperto, chiudere l'applicazione e fare clic su OK per continuare.

• Dopo aver creato una nuova impostazione di calibrazione in Calibrator, il pulsante Crea nuovo profilo per avviare
Color Profiler Suite è nascosto. Tale problema viene risolto dopo l'aggiornamento a Color Profiler Suite 5.1.

Nota: CWS 6.3 connessa ai server Fiery XF con Color Profiler Suite 5.0 è una configurazione supportata.

Aggiornamento di Fiery JobFlow per l'uso con Fiery Command WorkStation6.3

Fiery JobFlow 2.5 è compatibile con Fiery Command WorkStation Package 6.3. Le versioni precedenti di Fiery
JobFlow non sono supportate.
Fiery JobFlow 2.5 è compatibile con le versioni precedenti di Fiery Command WorkStation dalla 5.8 alla 6.2.
Tuttavia, se si esegue l'aggiornamento a Fiery Command WorkStation6.3, è necessario eseguire l'aggiornamento
anche a Fiery JobFlow 2.5. Per ulteriori informazioni, vedere www.efi.com/jobflow.

Supporto per monitor HiDPI

Fiery Command WorkStation6.3 offre il supporto completo per i monitor HiDPI, in base alle impostazioni in
Schermo > Impostazioni scala e layout in Microsoft Windows. I font e gli altri elementi possono pertanto essere
ridimensionati in base alla risoluzione dello schermo. Alcuni font nell'applicazione potrebbero apparire leggermente
flou o sfocati a seconda del fattore di ridimensionamento selezionato in Windows. Tuttavia, ciò non compromette la
leggibilità e le funzionalità.

Caratteristiche non più disponibili
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Filtri di Fiery Hot Folders

Non è più supportata la conversione dei seguenti formati in Fiery Hot Folders:

• Filtri inclusi in Fiery Graphic Arts Package, Premium Edition e Fiery Productivity Package: PDF2GO,
ExportPS, CT-LW, DCS 2.0 e TIFF-IT.

• La conversione da PDF a PS (PostScript) in Fiery Hot Folders non è più disponibile perché Adobe PDF Print
Engine (APPE) consente a Fiery server di elaborare e riprodurre i lavori PDF in modo nativo senza doverli
convertire in PostScript.

Modulo aggiuntivo TWAIN Fiery Remote Scan

Il modulo aggiuntivo TWAIN Fiery Remote Scan non è più disponibile, e non è più pertanto possibile acquisire
le pagine direttamente nelle applicazioni di terzi quali Adobe Acrobat e Adobe Photoshop. Tuttavia,
l'applicazione standalone Fiery Remote Scan è totalmente supportata per il recupero dei lavori di scansione e per
sincronizzare automaticamente le mailbox di scansione su un Fiery server supportato con il computer in uso.

Scansione in Fiery JobMaster

Fiery JobMaster 5.0 (incluso in Fiery Command WorkStation Package6.3) non supporta più i driver di scansione
TWAIN.
Fiery JobMaster 5.0 prevede il supporto per:

• Driver WIA (Windows Image Acquisition)

• Driver ICA (Image Capture Application) per Mac

• Modulo aggiuntivo Fiery Remote Scan versione 6.7 (specifico per l'applicazione Fiery JobMaster)

Scelte rapide da tastiera di Fiery Software Manager

Fiery Software Manager non crea scelte rapide da tastiera sul desktop Windows o nel Dock macOS. Tuttavia, per
le installazioni di Fiery Command WorkStation direttamente su Fiery server le scelte rapida da tastiera verranno
aggiunte sul desktop di Windows.

Problemi risolti in Fiery Command WorkStation Package v6.3.0.333

I seguenti problemi sono stati risolti:
Fiery Command WorkStation

• Un messaggio di eccezione non gestita non si verifica più quando si aprono determinati file PDF in Fiery Impose
e in Anteprima Fiery.

Fiery XF

• Non è stato possibile creare GIFs per le stampanti VUTEk 32R e H3/H5 configurate per stampa IP, se la
stampante era già stata configurata per la stampa su file con l'opzione Crea GIF anteprima dei file RTL disabilitata
nella finestra Impostazioni speciali .

• Quando si seleziona le impostazioni di calibrazione in Color Tools, l'opzione di output Dimensione punto viene
ora visualizzata correttamente come Multi-Strike per le stampanti Epson SureColor S306X0.

Note di release per l’utente
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• I valori tonali salvati nei file di compensazione lastra visiva ora corrispondono a quelli salvati in Fiery XF 6.5.

• Quando si ottimizza un profilo in Color Tools, la posizione del pulsante Ottimizza ora rimane statica. In
precedenza, il pulsante si spostava progressivamente verso il basso della finestra con ogni iterazione e, infine,
diventava non disponibile.

Problemi risolti in Fiery Command WorkStation Package v6.3.0.307

I seguenti problemi sono stati risolti:
Fiery Command WorkStation

• È ora possibile accedere facilmente a Paper Catalog, Allinea cassettoe Centro periferica quando si accede a Fiery
server come Amministratore con una password contenente caratteri speciali e una lunghezza di più di 10
caratteri.

• Sui computer macOS, Calibrazione Fiery lanciata da Fiery Command WorkStation ora emette un segnale
acustico quando si ricalibra o si crea un calibrazione con il dispositivo di misurazione ES-1000.

• Durante il trascinamento delle tinte piatte in Centro periferica > Risorse > Tinte piatte, Fiery Command
WorkStation ha smesso di rispondere.

• In alcuni casi, all'apertura di un lavoro in Anteprima Fiery, Fiery Impose, Fiery Compose o Fiery JobMaster, le
immagini di anteprima sono apparse sfocate.

Fiery XF

• Job Editor non è stato in grado di visualizzare correttamente lo spessore linea dei segni di ritaglio.

• In un lavoro di raggruppamento a più pagine, Job Editor smette di rispondere se si modifica l'orientamento della
pagina o la distanza tra le pagine causando la creazione di una nuova pagina di raggruppamento.

• In alcuni casi, il server Fiery XF non si avviava dopo l'aggiornamento di Fiery Command WorkStation 6.3.

Problemi risolti su Fiery Command WorkStation Package v6.3.0.280

I seguenti problemi sono stati risolti:
Fiery Command WorkStation

• Su Fiery server con un gran numero di voci di Paper Catalog, non è possibile scorrere tutte le voci di Paper
Catalog per assegnare il supporto a un cassetto, se Fiery Ticker è in esecuzione.

• Con Fiery Command WorkStation impostata su una lingua diversa dall'inglese, quando è stata selezionata una
data di inizio, all'interno di un intervallo, nel job log, non sono stati visualizzati i log anche se i lavori erano
disponibili nel job log.

Fiery XF

• Quando si seleziona un qualsiasi pannello di controllo ISO 12647-7, l'etichetta del lavoro di stampa contiene
tutte le informazioni necessarie per ottenere la conformità a ISO. Non è possibile deselezionare queste
impostazioni. È possibile, tuttavia, selezionare ulteriori impostazioni in Editor etichette lavoro, se necessario.

• Non è stato possibile selezionare un alias tinta piatta in Job Editor se Fiery Command WorkStation era connesso
in remoto a un server Fiery XF.

• È ora possibile salvare correttamente le sorgenti e i metodi di contorno di taglio come preimpostazione.

Note di release per l’utente
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• Se è stata selezionata l'opzione Stampa senza bordi, il lavoro inviato in spool non è riuscito a causa dell'errore
Rilevato formato foglio non valido .

• Con alcune combinazioni di Fiery Command WorkStation e Fiery XF, l'impostazione modo misurazione M2 non
è stata salvata quando si utilizzava un dispositivo di misurazione Epson SpectroProofer ILS30 per ottimizzare un
profilo su Color Tools. Anche se è stato selezionato M2 (UV cut), il risultato include UV, ovvero il modo di
misurazione M1.

• Nel caso si abbia provato a ottimizzare una misurazione di verifica utilizzando il metodo di misurazione M2 per
Epson SpectroProofer IL30, non è possibile rilevare alcun miglioramento perché la misurazione M2 non è stata
salvata.

• Sui computer macOS, Fiery Command WorkStation ha smesso di rispondere quando i lavori sono stati ordinati
facendo clic sulle intestazioni delle colonne in Centro lavori.

• In Color Tools > Ricalibrazione per misurazione, i passi consigliati da seguire dopo la misurazione del primo
grafico sono stati troncati in alcune lingue.

• Con il doppio monitor è ora possibile rilanciare Color Tools sul monitor secondario. In precedenza, Color Tools si
apriva sempre sul monitor primario.

Problemi risolti in Fiery Command WorkStation Package v6.3.0.271

I seguenti problemi sono stati risolti:
Fiery Command WorkStation

• Quando si stampavano campioni di tinta piatta, alcune impostazioni della scheda Proprietà del lavoro >
immagine non venivano applicate.

Fiery XF

• In precedenza non era possibile creare separazioni bianche per le stampanti VUTEk 3R/5r/3R +/5r + perché la
separazione bianca mancava nella cartella di output. Il problema è stato risolto nell'ultima release.

• In Color Editor, i cataloghi di campioni devono essere stampati su un supporto con un formato predefinito. Non è
più possibile definire un formato personalizzato.

Problemi risolti in Fiery Command WorkStation Package v6.3.0.259

I seguenti problemi sono stati risolti:
Fiery Command WorkStation

• Con il server Fiery configurato in una lingua diversa dall'inglese su un computer macOS, quando si accedeva a
Server > Log > Stampa > Stampante locale > Stampa, la finestra di dialogo Stampa aperta era in inglese.

• Le preferenze di Fiery Hot Folders non contengono più una selezione del percorso modello di Fiery Impose.
Utilizza invece lo stesso percorso di Fiery Command WorkStation.

• Fiery Calibrator si avvia e risponde più rapidamente.

Fiery XF

• In Job Editor, non era possibile modificare i valori di Scala per personalizzare un'area di ritaglio.

• In Color Tools > Crea calibrazione > Riepilogo, non era possibile aprire un profilo supporto in Profile Inspector
per confrontarne il gamut cromatico con quello del file di calibrazione.
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• Era possibile stampare grafici di calibrazione avanzati solo se il sistema operativo era stato impostato su inglese.

• L'utilizzo di un dispositivo di misurazione Barbieri Spectro LFP qb su un'IP per creare un file di calibrazione
generava dati IT8 non corretti. Di conseguenza, non era possibile aprire il file calibrazione in Color Tools > Crea
calibrazione > Riepilogo > Profile Inspector.

• Se si configura un lavoro di verifica in Job Editor per misurare una scala di controllo dinamica utilizzando un
dispositivo di misurazione incorporato, Job Editor visualizzava risultati Delta E non corretti dopo la verifica.
Verifier e Job Editor ora mostrano i valori Delta E corretti.

• Quando si modificava il valore di limite di inchiostro totale (TIL) in Color Tools > Crea calibrazione > Limite di
inchiostro totale per qualsiasi stampante VUTEk, Color Tools smetteva di rispondere.

• Non era possibile misurare il primo grafico nel processo di calibrazione utilizzando il dispositivo di misurazione
ES-2000

Problemi risolti in Fiery Command WorkStation Package v6.3.0.234

I seguenti problemi sono stati risolti:
Fiery Command WorkStation

• Non era possibile salvare l'impostazione dell'opzione Fronte-retro in Tinte piatte > Proprietà del lavoro.

• Accedendo alla finestra Impostazioni di calibrazione prima della ricalibrazione del server Fiery, Fiery Calibrator
smetteva di rispondere.

• Durante la ricalibrazione con il dispositivo EFI ES-2000, se veniva selezionato 51 casuale come valore di set di
campioni, la tabella dei colori stampati e il grafico visualizzato Fiery Command WorkStation non
corrispondevano.

• In Calibrator, durante la creazione di una calibrazione, l'opzione Genera dati ACD dopo calibrazione non era
disponibile per le stampanti supportate.

Fiery XF

• È ora possibile salvare le impostazioni del riquadro PDF in Server Manager > Finitura > Segni > Segni di taglio >
Taglio del contorno. In precedenza, era possibile applicare solo l'impostazione del formato supporto.

• Durante la configurazione di una stampante per la stampa su porta, non era possibile stabilire un collegamento
con una stampante che non utilizzasse la porta 9100.

• Sui computer macOS, è ora possibile ottimizzare le tinte piatte. In precedenza, è stato generato un grafico non
corretto conseguente un errore dell'iterazione.

Problemi risolti in Fiery Command WorkStation Package v6.3.0.216

I seguenti problemi sono stati risolti:
Fiery Command WorkStation

• Con il server Fiery configurato in una lingua diversa dall'inglese, quando si insrivano le pagine da un lavoro che
veniva salvato sul server Fiery, Fiery Impose o Fiery JobMaster smetteva di rispondere.

• In Fiery Impose, quando un lavoro veniva salvato come pdf con livelli unificati, i livelli o gli oggetti contrassegnati
come nascosti in Acrobat apparivano sull'output.
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Fiery XF

• L'etichetta segmento di segmenti in scala è ora visualizzata correttamente nella scheda Visualizza singolo
segmento.

• Color Tools non mostrava i dati di misurazione riga per riga per i grafici di calibrazione e di controllo di qualità.

• Quando si utilizzava un dispositivo di misurazione i1 Pro2 per creare un profilo, la periferica non veniva rilevata.

• Se si impostava il profilo di correzione L*a*b* (*.3cc) su Nessuno, veniva visualizzato un messaggio di errore che
indicava che il profilo non era valido.

• In alcuni casi, il server Fiery XF non si avviava dopo l'aggiornamento di Fiery Command WorkStation 6.3.

• L'aggiornamento a Fiery Command WorkStation 6.3 SP1 causava l'eliminazione della cartella C:\Program Data
\Fiery\Fiery XF\Client\Working. Di conseguenza, tutti i dati di misurazione salvati in precedenza in questa
cartella non erano più disponibili, causando la creazione di rapporti errati.

Problemi risolti in Fiery Command WorkStation Package v6.3.0.199

I seguenti problemi sono stati risolti:
Fiery Command WorkStation

• non era possibile stampare un lavoro di graffatura del booklet da Hot Folders a causa di un errore di grammatura
della carta. Tuttavia, lo stesso lavoro poteva essere stampato da Fiery Command WorkStation senza errore.

• In un sistema in lingua giapponese, i lavori PDF inviati a una cartella automatica non venivano elaborati se tali
lavori avevano una preimpostazione lavoro e un modello Impose.

• Se l'opzione Anteprima durante l'elaborazione era attivata in > Fiery Command WorkStation > Server >
Configure > Gestione dei lavori, sia Fiery Command WorkStation che il server Fiery smettevano di rispondere
mentre venivano elaborati alcuni lavori sottoposti a imposizione.

• Quando si applicava una Preimpostazione server a un lavoro e si modificava la Preimpostazione server dello
stesso lavoro facendo clic con il pulsante destro del mouse dalla coda In attesa, il server Fiery smetteva di
rispondere.

Fiery XF

• Sui computer macOS, se Fiery Command WorkStation era configurato per la lingua tedesca, i valori di Taglia
immagine in Job Editor > Finitura > Segni > Segni di ritaglio non venivano salvati.

• È ora possibile configurare le stampanti che sono connesse al server Fiery tramite USB. In precedenza, quando si
selezionava il tipo di collegamento Stampa tramite porta veniva visualizzato un messaggio di errore indicante che
la porta selezionata non era valida.

• L'area massima di sovrapposizione/incollamento per i segmenti era impostata su 3,939 pollici. Questo valore è
stato incrementato in base alla richiesta del cliente. Sono ora consentiti margini dell'area di sovrapposizione/
incollamento di oltre 6 pollici.

Problemi risolti nel Service Pack 1 (SP1)

Modo HyperRIP

Quando ci si collega a un Fiery server vale a dire FS200 o versioni successive con Modo HyperRIP impostate su più
lavori, la barra di avanzamento potrebbe non essere visualizzata quando si inviano i lavori a Elabora e attesa.
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Fiery Software Manager non rileva l'aggiornamento KB2999226 di Windows

La versione 4.2.0.14 di Fiery Software Manager (FSM) inclusa nelle versioni successive del pacchetto SP1 di Fiery
Command WorkStation 6.3 presenta correzioni per il seguente problema: FMS non rileva l'aggiornamento
KB2999226 di Windows e segnala erroneamente che l'aggiornamento deve ancora essere applicato. Dopo aver
applicato l'aggiornamento, l'errore persiste e in alcuni casi impedisce l'installazione di CWS 6.3.
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Release-Informationen
Fiery Command WorkStation Package, v6.3

Dieses Dokument enthält wichtige Informationen zu diesem Release. Stellen Sie diese Informationen allen Benutzern
zur Verfügung, bevor Sie die Installation vornehmen.

Informationen zum Release

Diese Release-Version umfasst die folgenden Anwendungen:

• Fiery Command WorkStation Package V6.3.0.333

• Fiery Command WorkStation V6.3.0.58

• Fiery Hot Folders V3.12.0.35

• Fiery Software Manager für Mac V4.2.0.16

• Fiery Software Manager für Windows V4.2.0.16

Hinweis:  

Dieses Installationsprogramm führt ein Upgrade aller vorhandenen Versionen des Fiery Command WorkStation
Package oder des Fiery Extended Applications Package auf die aktuelle Version Fiery Command WorkStation
Package aus, die Fiery Command WorkStation und Fiery Hot Folders beinhaltet. Mithilfe von Fiery Software
Manager können Sie optional Fiery Remote Scan installieren.
Fiery Command WorkStation Package unterstützt Fiery servers bei der Ausführung von System 10/10e und höher
sowie Fiery proServer und Fiery XF 7.0 und höher. Es stellt keine Verbindung zu folgenden Systemen her:

• Fiery servers Fiery System 9/9e Rel2 Software und frühere Versionen

• Fiery XF 6.x und frühere Versionen

• Fiery Central Server

Wenn Sie weiterhin auf diese Produkte zugreifen müssen, dürfen Sie das Upgrade nicht vornehmen. Fiery Extended
Applications Das Paket ist weiterhin auf www.efi.com/cws verfügbar. Eine vollständige Liste der unterstützten
digitalen Bogendruckmaschinen finden Sie unter http://fiery.efi.com/CWS/supported-printers.
Weitere Informationen zu den technischen Spezifikationen finden Sie unter www.efi.com/cws.

Neuerungen

Bogendrucker: http://fiery.efi.com/CWScutsheetWN

HTTP://WWW.EFI.COM/CWS
HTTP://FIERY.EFI.COM/CWS/SUPPORTED-PRINTERS
http://www.efi.com/cws
http://fiery.efi.com/CWScutsheetWN


Großformat- und Supergroßformatdrucker: http://fiery.efi.com/CWSwideformatWN

64-Bit-Anwendung

Fiery Command WorkStation 6.3 (CWS) ist eine native 64-Bit-Anwendung für macOS- und Windows-Plattformen.
32-Bit-Betriebssysteme werden für CWS 6.3 nicht unterstützt. Wird Fiery Software Manager bereits auf einem 32-
Bit-Betriebssystem wie Windows 7 32 Bit ausgeführt, werden Update-Benachrichtigungen für das CWS 6.3 Package
nicht angezeigt. Wenn Sie versuchen, diese Version von Fiery Software Manager auf einem 32-Bit-Betriebssystem
auszuführen, wird ein Kompatibilitätsfehler angezeigt und Fiery Software Manager kann nicht ausgeführt werden.
Informationen zu den unterstützten Betriebssystemen finden Sie unter http://fiery.efi.com/cws-specifications.

Fiery Color Profiler Suite und Fiery Command WorkStation 6.3

Fiery Color Profiler Suite 5.0 (CPS) und frühere Versionen sind nicht vollständig mit dem Fiery Command
WorkStation Package 6.3 (CWS) für digitale Bogendruckmaschinen kompatibel. Wir empfehlen die Aktualisierung
auf Fiery Color Profiler Suite 5.1.
Bei der Verwendung von CPS 5.0 mit CWS 6.3, können die folgenden Probleme auftreten:

• Wenn in CWS die Meldung „Spektralfotometer mit Ihrem Computer verbinden“ angezeigt wird, während CPS
geöffnet ist, schließen Sie CPS und klicken Sie zum Fortfahren auf OK.

• Nachdem Sie in Calibrator eine neue Kalibrierungseinstellung erstellt haben, wird die Schaltfläche Neues Profil
erstellen für den Start von CPS ausgeblendet. Dieses Problem wird nach dem Upgrade auf CPS 5.1 behoben.

Hinweis:  CWS 6.3 wird in Verbindung mit Fiery XF Servern mit CPS 5.0 unterstützt.

Upgrade von Fiery JobFlow für den Einsatz mit Fiery Command WorkStation6.3

Fiery JobFlow 2.5 ist mit Fiery Command WorkStation Package 6.3 kompatibel. Frühere Versionen von Fiery
JobFlow werden nicht unterstützt.
Fiery JobFlow 2.5 ist abwärtskompatibel mit Fiery Command WorkStation in den Versionen 5.8 bis 6.2. Wenn Sie
jedoch auf Fiery Command WorkStation6.3 aktualisieren, müssen Sie auch auf Fiery JobFlow 2.5 aktualisieren.
Weitere Informationen finden Sie unter www.efi.com/jobflow.

Unterstützung von HiDPI-Monitoren

Fiery Command WorkStation6.3 unterstützt HiDPI-Monitore vollständig gemäß den Einstellungen von Microsoft
Windows unter Anzeige > Skalierung und Anordnung, sodass Schriften und andere Elemente in einer
unterschiedlichen Größe auf die Bildschirmauflösung skaliert werden können. Einige Schriften in der Anwendung
können abhängig von dem unter Windows ausgewählten Skalierungsfaktor etwas weich oder unscharf erscheinen.
Lesbarkeit und Funktion sind jedoch nicht betroffen.

Eingestellte Funktionen
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Fiery Hot Folders Filter

Die folgenden Funktionen werden für die Konvertierung durch Fiery Hot Folders nicht mehr unterstützt:

• Filter in Fiery Graphic Arts Package, Premium Edition und Fiery Productivity Package: PDF2GO, ExportPS,
CT-LW, DCS 2.0 und TIFF-IT.

• Die Konvertierung von PDF zu PS (PostScript) in Fiery Hot Folders wurde eingestellt, da die Adobe PDF
Print Engine (APPE) dem Fiery server das native Verarbeiten und Rendern von PDF-Aufträgen ermöglicht,
ohne sie in PostScript konvertieren zu müssen.

Fiery Remote Scan TWAIN-Zusatzmodul

Das TWAIN-Zusatzmodul von Fiery Remote Scan wurde eingestellt. Dadurch können Seiten nicht mehr direkt
in Anwendungen von Drittanbietern wie Adobe Acrobat oder Adobe Photoshop gescannt werden. Die
eigenständige Anwendung Fiery Remote Scan wird jedoch weiterhin vollständig unterstützt, und zwar für das
Abrufen von Scanaufträgen und das automatische Synchronisieren von Scan-Mailboxen auf einem
unterstützten Fiery server mit Ihrem Computer.

Fiery JobMaster Scannen

Fiery JobMaster 5.0 (im Funktionsumfang von Fiery Command WorkStation Package6.3 enthalten) unterstützt
TWAIN-Scannertreiber nicht mehr.
Fiery JobMaster 5.0 bietet Unterstützung für:

• Treiber für WIA (Windows Image Acquisition)

• Treiber für Mac ICA (Image Capture Application)

• Fiery Remote Scan Zusatzmodul Version 6.7 (speziell für die Anwendung Fiery JobMaster)

Fiery Software Manager Verknüpfungen

Fiery Software Manager erstellt keine Verknüpfungen auf dem Windows-Desktop oder im macOS Dock. Bei
Installationen von Fiery Command WorkStation direkt auf dem Fiery server werden jedoch weiterhin
Verknüpfungen zum Windows-Desktop hinzugefügt.

Probleme in Fiery Command WorkStation Package V6.3.0.333 behoben

Folgende Probleme wurden behoben:
Fiery Command WorkStation

• Eine nicht behandelte Ausnahmemeldung tritt nicht mehr auf, wenn Sie bestimmte PDF-Dateien in Fiery
Impose und Fiery Vorschau öffnen.

Fiery XF

• Es war nicht möglich, GIFs für VUTEk 32R-und h3/h5-Drucker zu erstellen, die für IP-Druck eingerichtet
wurden, wenn der Drucker zuvor auf Ausgabe in Datei konfiguriert wurde und die Option GIF Vorschau von RTL-
Dateien erstellen im Fenster Spezielle Einstellungen deaktiviert ist.

• Wenn Sie die Kalibrierungseinstellungen in Color Tools auswählen, wird die Ausgabeoption Punktgröße nun
korrekt als Mehrfachdruck für Epson SureColor S306X0-Drucker angezeigt.
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• Die in den visuellen Plattenkompensationsdateien gespeicherten Tonwerte entsprechen nun den Werten, die in
Fiery XF 6.5 gespeichert wurden.

• Wenn Sie ein Profil in Color Tools optimieren, bleibt die Position der Schaltfläche Optimieren jetzt statisch.
Zuvor wurde die Schaltfläche mit jeder Iteration schrittweise nach unten im Fenster verschoben und war
schlussendlich nicht mehr verfügbar.

Probleme in Fiery Command WorkStation Package V6.3.0.307 behoben

Folgende Probleme wurden behoben:
Fiery Command WorkStation

• Sie können nun problemlos auf den Papierkatalog, Papierfach ausrichten und das Gerätecenter zugreifen, wenn
Sie sich auf Fiery server als Administrator mit einem Kennwort mit Sonderzeichen und einer Länge von mehr als
10 Zeichen anmelden.

• Wenn der Fiery Calibrator von der Fiery Command WorkStation gestartet wurde, ertönt auf macOS-Computern
nun ein Piepston wenn Sie nachkalibrieren oder eine Kalibrierung mit dem Messinstrument ES-1000 erstellen.

• Wenn Sie die Spot-Farben in Gerätecenter > Ressourcen > Spot-Farben gezogen und abgelegt Fiery Command
WorkStation haben und keine Reaktion mehr erfolgt.

• In einigen Fällen, wenn Sie eine Auftrag in Fiery Vorschau, Fiery Impose, Fiery Compose oder Fiery Jobmaster
geöffnet haben, war die Bildvorschau verschwommen.

Fiery XF

• Der Job Editor konnte die Linienstärke der Beschnittmarken nicht richtig anzeigen.

• In einem mehrseitigen Sammelformen-Auftrag reagierte der Job Editor nicht mehr, wenn die Seitenausrichtung
oder der Abstands zwischen den Seiten geändert wurde, was dazu führte, dass eine neue Sammelform-Seite
erstellt wurde.

• In einigen Fällen kontte der Fiery XF Server nach dem Upgrade auf Fiery Command WorkStation 6.3 nicht
gestartet werden.

Probleme in Fiery Command WorkStation Package V6.3.0.280 behoben

Folgende Probleme wurden behoben:
Fiery Command WorkStation

• Auf einem Fiery server mit einer großen Anzahl von Paper Catalog-Einträgen konnten Sie nicht durch alle Paper
Catalog-Einträge scrollen, um Material einem Fach zuzuweisen, wenn Fiery Ticker ausgeführt wurde.

• Wenn für Fiery Command WorkStation eine andere Sprache als Englisch festgelegt wurde und Sie ein
Startdatum für einen Bereich im Auftragsprotokoll ausgewählt haben, wurden keine Protokolle angezeigt,
obwohl Aufträge im Auftragsprotokoll verfügbar waren.

Fiery XF

• Wenn Sie einen beliebigen ISO 12647-7-Kontrollstreifen auswählen, enthält das gedruckte Auftragsetikett alle
Informationen, die zum Erreichen der ISO-Konformität erforderlich sind. Sie können diese Einstellungen nicht
aufheben. Sie können jedoch bei Bedarf zusätzliche Einstellungen im Auftragsetikett-Editor auswählen.

• Es war nicht möglich, eine Alias-Sonderfarbe in Job Editor auszuwählen, wenn die Fiery Command WorkStation
aus der Entfernung an einem Fiery XF-Server angemeldet war.
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• Sie können nun Schnittkonturquellen und -methoden korrekt als Voreinstellung speichern.

• Wenn Randloser Druck ausgewählt wurde, schlug der Spool-Auftrag mit einem "Ungültige Bodengröße
erkannt" Fehler fehl.

• Bei einigen Kombinationen von Fiery Command WorkStation und Fiery XF wurde die Einstellung für den M2-
Messmodus bei Verwendung eines Epson SpectroProofer ILS30-Messgeräts zur Optimierung eines Profils in
Color Tools nicht gespeichert. Selbst wenn Sie M2 (UV-Schnitt) ausgewählt haben, enthielt das Ergebnis UV, d.h.
den Messmodus M1.

• Wenn Sie versucht haben, eine Verifizierungsmessung mit der M2-Messmodusmethode für den Epson
SpectroProofer IL30 zu optimieren, konnte keine Verbesserung festgestellt werden, da die M2-Messung nicht
gespeichert wurde.

• Auf MacOS-Computern reagierte die Fiery Command WorkStation nicht mehr, wenn Aufträge durch Klicken
auf die Spaltenüberschriften im Auftragscenter sortiert wurden.

• In Color Tools > Neukalibrierung durch Messungwurden die empfohlenen Schritte, die nach dem Messen des
ersten Diagramms ausgeführt werden sollten, in einigen Sprachen abgeschnitten.

• Mit zwei Monitoren können Sie nun Color Tools auf dem sekundären Monitor erneut starten. Bisher wurden die
Color Tools immer auf dem primären Monitor geöffnet.

Probleme in Fiery Command WorkStation Package V6.3.0.271 behoben

Folgende Probleme wurden behoben:
Fiery Command WorkStation

• Beim Drucken von Sonderfarbenmustern, wurden einige Einstellungen auf der Registersite
Auftragseigenschaften > Bild nicht angewendet.

Fiery XF

• Für VUTEk 3r/5r/3r+/5r+ -Drucker war es bisher nicht möglich, weiße Separationen zu erstellen, da die weiße
Separation im Ausgabefolder fehlte. DDas Problem wurde in der neuesten Version behoben.

• Im Color-Editormüssen Farbuster-Bücher auf einem Standardmedienformat gedruckt werden. Es ist nicht mehr
möglich, ein benutzerdefiniertes Medienformat zu definieren.

Probleme in Fiery Command WorkStation Package v6.3.0.259 behoben

Folgende Probleme wurden behoben:
Fiery Command WorkStation

• Wenn der Fiery Server auf einem macOS-Computer in einer anderen Sprache als Englisch konfiguriert ist, war
beim Öffnen von Server > Protokolle > Drucken > Lokaler Drucker > Drucken das Dialogfeld Drucken in Englisch
geöffnet.

• Die Voreinstellungen für Fiery Hot Folders enthalten keine Pfadvorlage für die Fiery Impose-Vorlage. Verwendet
Sie stattdessen Sie den gleichen Pfad wie Fiery Command WorkStation.

• Fiery Kalibrator startet und reagiert schneller.
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Fiery XF

• Im Job-Editor konnten Sie die Skalierungswerte nicht bearbeiten, um einen Zuschneidebereich anzupassen.

• In Farbwerkzeuge > Kalibrierung erstellen > Zusammenfassung konnten Sie kein Medienprofil in Profile
Inspector öffnen, um seinen Farbbereich mit dem der Kalibrierungsdatei zu vergleichen.

• Sie können erweiterte Kalibrierungsdiagramme nur drucken, wenn das Betriebssystem auf Englisch eingestellt
ist.

• Bei Verwendung eines Barbieri Spectro LFP qb-Messgeräts über IP zum Erstellen einer Kalibrierungsdatei
wurden falsche IT8-Daten generiert. Aus diesem Grund konnten Sie die Kalibrierungsdatei nicht in
Farbwerkzeuge > Kalibrierung erstellen > Zusammenfassung konnten Sie kein Medienprofil in Profile Inspector
öffnen.

• Wenn Sie im Job Editor einen Überprüfungsjob einrichten, um einen Dynamic Wedge mit einem integrierten
Messgerät zu messen, zeigt der Job Editor nach der Überprüfung falsche Delta-E-Ergebnisse an. Verifier und Job
Editor zeigen jetzt die korrekten Delta-E-Werte an.

• Wenn Sie den Gesamttintengrenzwert (TIL) in Color Tools > Kalibrierung erstellen > Gesamttintenlimit für einen
VUTEk-Drucker geändert haben, reagiert Color Tools nicht mehr.

• Das erste Diagramm des Kalibrierungsprozesses konnte mit dem ES-2000-Messgerät nicht gemessen werden

Probleme in Fiery Command WorkStation Package v6.3.0.234 behoben

Folgende Probleme wurden behoben:
Fiery Command WorkStation

• Sie konnten bisher die Einstellung für die Duplexoption nicht in Spot-Farben > Auftragseigenschaften speichern.

• Wenn Sie vor der Neukalibrierung des Fiery Servers auf das Fenster Kalibrator-Einstellungen zugegriffen haben,
reagiert der Fiery Calibrator nicht mehr.

• Wenn Sie bei der Neukalibrierung mit einem EFI ES-2000-Gerät 51 zufällig als Patch-Set-Wert ausgewählt
haben, stimmen das gedruckte Farbdiagramm und das angezeigte Diagramm in der Fiery Command
WorkStation nicht überein.

• Wenn Sie in Kalibratoreine Kalibrierung erstellt haben, war die Option ACD-Daten nach Kalibrierung generieren
für unterstützte Drucker nicht verfügbar.

Fiery XF

• Sie können jetzt die PDF-Einstellungen unter Server Manager > Finishing > Markierungen > Markierungen
schneiden > Konturschnitt speichern. Bisher konnte nur die Einstellung der Substratbox angewendet werden.

• Bei der Konfiguration eines Druckers zum Drucken an einen Anschluss konnte keine Verbindung zu einem
Drucker hergestellt werden, der nicht den Anschluss 9100 verwendet hat.

• Auf Mac OS-Computern ist es jetzt möglich, Spot-Farben zu optimieren. Zuvor wurde ein falsches Diagramm
generiert, durch das die Iteration fehlgeschlagen ist.

Probleme in Fiery Command WorkStation Package v6.3.0.216 behoben

Folgende Probleme wurden behoben:
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Fiery Command WorkStation

• Wenn der Fiery Server in einer anderen Sprache als Englisch konfiguriert wurde, reagierten Fiery Impose oder
Fiery JobMaster beim Einfügen von Seiten aus einem Auftrag, der auf dem Fiery Server gespeichert ist, nicht
mehr.

• Wenn Sie in Fiery Impose einen Job als abgeflachte PDF-Datei gespeichert haben, wurden in Acrobat als
ausgeblendet markierte Layer oder Objekte in der Ausgabe angezeigt.

Fiery XF

• Die Kachelbeschriftung der skalierten Kacheln wird jetzt auf der Registerkarte Einzelkachelansicht angezeigt.

• Color Tools zeigte für die Kalibrierungs- und Qualitätsregelkarten keine zeilenweisen Messdaten an.

• Das Gerät konnte bei der Erstellung eines Profils mit einem i1 Pro2-Messgerät nicht erkannt werden.

• Wenn Sie für das L*a*b* Korrekturprofil (*.3cc) Keines ausgewählt hatten, gab es fälschlicherweise eine
Fehlermeldung an, dass es sich um ein ungültiges Profil handele.

• In einigen Fällen wurde der Fiery XF-Server nach dem Upgrade auf Fiery Command WorkStation 6.3 nicht
gestartet.

• Bei einem Upgrade auf Fiery Command WorkStation 6.3 SP1 wurde der Ordner C:\Program Data\Fiery\Fiery XF
\Client\Working gelöscht. Dadurch waren alle zuvor in diesem Ordner gespeicherten Messdaten nicht mehr
verfügbar, wodurch falsche Berichte erstellt wurden.

Behobene Probleme in Fiery Command WorkStation Package V. 6.3.0.199

Folgende Probleme wurden behoben:
Fiery Command WorkStation

• Sie konnten einen Heftstapeldruck aus überwachten Ordnern aufgrund eines Fehlers im Papiergewicht nicht
ausführen. Derselbe Auftrag konnte jedoch aus Fiery Command WorkStation ohne Fehler gedruckt werden.

• Auf einem japanischen System wurden PDF-Aufträge, die an einen überwachten Ordner gesendet wurden, nicht
verarbeitet, wenn die Aufträge eine Auftragsvorgabe und eine Impose-Vorlage besaßen.

• Wenn die Vorschau aktiviert wurde, während die Processing--Option unter > Fiery Command WorkStation  >
Server > Konfigurieren > Auftragsmanagementaktiviert war, würden sowohl Fiery Command WorkStation als
auch Fiery server nicht mehr reagieren, während Sie einige vergebene Aufträge bearbeiten.

• Wenn Sie ein Server Preset auf einen Auftrag angewendet haben und das Server Preset desselben Jobs durch
Rechtsklick auf den Auftrag von der HaltenWarteschlange aus geändert haben, würde der Fiery server nicht
mehr reagieren.

Fiery XF

• Wenn auf Mac OS-Computern die Fiery Command WorkStation für Deutsch konfiguriert wurde, werden die
Bildschnitt-Werte in Job Editor > Weiterverarbeitung > Marken > Schnittmarken nicht gespeichert.

• Sie können jetzt per USB angeschlossene Drucker über den Fiery-Server-Computer konfigurieren. Bisher führte
das Auswählen des Verbindungstyps Via Port drucken zur Anzeige einer falschen Nachricht, die angab, dass der
ausgewählte Port ungültig sei.

• Die maximale Überlappung bzw. der Klebebereich für Kacheln war auf 10 cm festgelegt. Dieser Wert wurde
aufgrund einer Kundenanfrage erhöht. Nun sind Überlappungen/Kleberänder von mehr als 15 cm möglich.
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Behobene Probleme in Service Pack 1 (SP1)

HyperRIP-Modus

Wenn eine Verbindung zu Fiery server, FS200 oder neuer mit Hyperrip-Modus für mehrere Aufträge, hergestellt ist,
wurde die Statusanzeige beim Senden von Aufträgen zum Verarbeiten und Halten möglicherweise nicht angezeigt.

Fiery Software Managererkennt das Windows-Update KB2999226 nicht

Die Fiery Software Manager (FM) Version 4.2.0.14, die in späteren Versionen des Fiery Command WorkStation 6.3
SP1-Pakets enthalten ist, behebt das folgende Problem: FSM erkennt das Windows-Update KB2999226 nicht und
gibt irrtümlicherweise an, dass das Update noch ausgeführt werden muss. Nachdem Sie das Update installiert haben,
bleibt der Fehler bestehen, und in einigen Fällen wird die Installation von CWS 6.3 verhindert
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Notas de la versión para el cliente
Fiery Command WorkStation Package, v6.3

Este documento contiene información importante acerca de esta versión. Asegúrese de proporcionar esta
información a todos los usuarios antes de continuar con la instalación.

Acerca de esta versión

En esta versión se incluyen las siguientes aplicaciones:

• Fiery Command WorkStation Package 6.3.0.333

• Fiery Command WorkStation 6.3.0.58

• Fiery Hot Folders 3.12.0.35

• Fiery Software Manager para Mac 4.2.0.16

• Fiery Software Manager para Windows 4.2.0.16

Nota:

Este instalador actualizará cualquier Fiery Command WorkStation Package o Fiery Extended Applications Package
existente al último Fiery Command WorkStation Package que contenga Fiery Command WorkStation y Fiery Hot
Folders. Opcionalmente, puede instalar Fiery Remote Scan mediante Fiery Software Manager.
Fiery Command WorkStation Package es compatible con Fiery servers con System 10/10e y posteriores, con Fiery
proServer y Fiery XF 7.0 y posteriores. No se conectará a:

• Fiery servers con Fiery System 9/9e Rel2 y versiones anteriores

• Servidores Fiery XF 6.x y anteriores

• Servidores de Fiery Central

No realice la actualización si necesita tener acceso a estos productos. Fiery Extended Applications Package sigue
estando disponible en www.efi.com/cws. Para obtener una lista completa de las impresoras de hojas admitidas,
consulte http://fiery.efi.com/CWS/supported-printers.
Para obtener más información acerca de las especificaciones técnicas, consulte www.efi.com/cws.

Novedades

Impresoras de hojas: http://fiery.efi.com/CWScutsheetWN
Impresoras de formato ancho y superancho: http://fiery.efi.com/CWSwideformatWN

HTTP://WWW.EFI.COM/CWS
HTTP://FIERY.EFI.COM/CWS/SUPPORTED-PRINTERS
http://www.efi.com/cws
http://fiery.efi.com/CWScutsheetWN
http://fiery.efi.com/CWSwideformatWN


Aplicación de 64 bits

Fiery Command WorkStation 6.3 (CWS) es una aplicación nativa de 64 bits tanto para plataformas macOS como
Windows.
No se admiten los sistemas operativos de 32 bits en CWS 6.3. Si Fiery Software Manager ya se está ejecutando en un
sistema operativo (SO) de 32 bits como Windows 7 de 32 bits, no mostrará las notificaciones de actualización para el
paquete CWS 6.3. Si intenta ejecutar esta versión de Fiery Software Manager en un sistema operativo de 32 bits,
aparecerá un error de compatibilidad y Fiery Software Manager no funcionará. Para ver los sistemas operativos
admitidos, consulte http://fiery.efi.com/cws-specifications.

Fiery Color Profiler Suite y Fiery Command WorkStation 6.3

Fiery Color Profiler Suite 5.0 (CPS) y versiones anteriores no son plenamente compatibles con Fiery Command
WorkStation Package 6.3 (CWS) en impresoras de hojas. Le recomendamos que se actualice a Fiery Color Profiler
Suite 5.1.
Al utilizar CPS 5.0 con CWS 6.3, puede experimentar los siguientes problemas:

• Si aparece en CWS el mensaje “Conecte el espectrofotómetro a su ordenador” mientras CPS está abierto, cierre
CPS y haga clic en Aceptar para continuar.

• Después de crear una nueva configuración de calibración en Calibrator, el botón Crear nuevo perfil para iniciar
CPS se encuentra oculto. Este problema se soluciona al actualizarse a CPS 5.1.

Nota: Es posible configurar CWS 6.3 conectado a servidores Fiery XF con CPS 5.0.

Actualización Fiery JobFlow para usarlo con Fiery Command WorkStation6.3

Fiery JobFlow 2.5 es compatible con Fiery Command WorkStation Package 6.3. No se admiten las versiones
anteriores de Fiery JobFlow.
Fiery JobFlow 2.5 es compatible con versiones anteriores de Fiery Command WorkStation (de la 5.8 a la 6.2). Sin
embargo, si se actualiza a Fiery Command WorkStation6.3, también debe actualizarse a Fiery JobFlow 2.5. Para
obtener más información, consulte www.efi.com/jobflow.

Compatibilidad con monitores HiDPI

La versión 6.3 de Fiery Command WorkStation es totalmente compatible con monitores HiDPI, si siguen la
Configuración de escala y diseño de Pantalla de Microsoft Windows de forma que los tipos de letra y otros
elementos puedan adaptarse a un tamaño diferente según la resolución de pantalla general. Algunos tipos de letra de
las aplicaciones pueden verse algo claros o difusos en función del factor de escalado seleccionado en Windows. Sin
embargo, la legibilidad y la funcionalidad no se ven afectadas.

Funciones descatalogadas
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Filtros de Fiery Hot Folders

Fiery Hot Folders ya no admite la conversión de los siguientes elementos:

• Filtros incluidos en Fiery Graphic Arts Package, Premium Edition y Fiery Productivity Package: PDF2GO,
ExportPS, CT-LW, DCS 2.0 y TIFF-IT.

• La conversión de PDF a PS (PostScript) en Fiery Hot Folders se ha retirado porque Adobe PDF Print Engine
(APPE) permite al Fiery server procesar y reproducir trabajos PDF de forma nativa sin necesidad de
convertirlos a PostScript.

Plugin TWAIN de Fiery Remote Scan

El plugin TWAIN de Fiery Remote Scan se ha descatalogado, por lo que se elimina la posibilidad de escanear
páginas directamente en aplicaciones de otros fabricantes como Adobe Acrobat o Adobe Photoshop. Sin
embargo, la aplicación independiente Fiery Remote Scan sigue siendo totalmente compatible para recuperar
trabajos de escaneo y sincronizar automáticamente los buzones de exploración en un Fiery server compatible
con su equipo.

Escaneo con Fiery JobMaster

Fiery JobMaster 5.0 (incluido en Fiery Command WorkStation Package6.3) ya no es compatible con los
controladores de escaneo de TWAIN.
Fiery JobMaster 5.0 es compatible con:

• Controladores de WIA (Windows Image Acquisition)

• Controladores de Mac ICA (Image Capture Application)

• Plugin de Fiery Remote Scan versión 6.7 (específico para la aplicación de Fiery JobMaster)

Accesos directos a aplicaciones de Fiery Software Manager

Fiery Software Manager no crea accesos directos de aplicaciones en el Escritorio de Windows ni en el Dock de
macOS. Sin embargo, si instala Fiery Command WorkStation directamente en el Fiery server, sí se generan
accesos directos a las aplicaciones en el Escritorio de Windows.

Problemas solucionados en Fiery Command WorkStation Package 6.3.0.333

Se han corregido los problemas siguientes:
Fiery Command WorkStation

• Ya no se muestra ningún mensaje de excepción no controlada al abrir determinados archivos PDF en Fiery
Impose y Fiery Preview.

Fiery XF

• Antes no era posible crear GIF para impresoras VUTEk 32r y h3/h5 configuradas para la impresión IP si la
impresora se había configurado previamente para imprimir en el archivo con la opción Crear vista preliminar GIF
de los archivos RTL deshabilitada en la ventana Configuración especial.

• Al seleccionar la configuración de calibración en Color Tools, la opción de salida Tamaño de punto ahora se
muestra correctamente como Pasada múltiple para las impresoras Epson SureColor S306X0.

Notas de la versión para el cliente
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• Los valores de tonos guardados en los archivos de compensación de placa visual ahora corresponden con los
guardados en Fiery XF 6.5.

• Cuando se optimiza un perfil en Color Tools, la posición del botón Optimizar ahora permanece estática.
Previamente, el botón se movía progresivamente por la ventana con cada iteración y en ocasiones dejaba de estar
disponible.

Problemas solucionados en Fiery Command WorkStation Package 6.3.0.307

Se han corregido los problemas siguientes:
Fiery Command WorkStation

• Ahora puede acceder fácilmente a Paper Catalog, Alinear bandeja y Centro de dispositivo al iniciar sesión en
Fiery server como administrador con una contraseña que contenga caracteres especiales y una longitud de más
de 10 caracteres.

• En ordenadores Mac OS, la versión de Fiery Calibrator que se inicia desde Fiery Command WorkStation ahora
emite un pitido al volver a calibrar o al crear una calibración con el dispositivo de medición ES-1000.

• Al arrastrar y colocar los colores planos en el Centro de dispositivo > Recursos > Colores planos, Fiery Command
WorkStation deja de responder.

• En algunos casos, al abrir un trabajo en Presentación Preliminar de Fiery, Fiery Impose, Fiery Compose o Fiery
JobMaster, las imágenes de la presentación preliminar aparecen borrosas.

Fiery XF

• Job Editor no puede mostrar correctamente el grosor de la línea de las marcas de recorte.

• En una trabajo de anidamiento de varias páginas, Job Editor no responde si, después de cambiar la orientación de
la página o la distancia entre páginas, se origina la creación de una nueva página de anidamiento.

• En algunos casos, el servidor Fiery XF no se inicia después de actualizar a Fiery Command WorkStation 6.3 por
la falta de disponibilidad del servicio de administrador de licencias de EFI.

Problemas solucionados en Fiery Command WorkStation Package v6.3.0.280

Se han corregido los problemas siguientes:
Fiery Command WorkStation

• En un Fiery server con un número elevado de entradas de Paper Catalog, no era posible desplazarse por todas las
entradas de Paper Catalog para asignar soportes a una bandeja si Fiery Ticker se estaba ejecutando.

• Con Fiery Command WorkStation configurado con un idioma distinto del inglés, cuando se seleccionaba una
fecha de inicio de un intervalo en el Registro de trabajos, no se mostraba ningún registro aunque hubiesen
trabajos disponibles en el Registro de trabajos.

Fiery XF

• Cuando se selecciona cualquiera de las barras de control ISO 12647-7, la etiqueta impresa del trabajo contiene
toda la información necesaria para obtener la conformidad con la norma ISO. No es posible anular la selección
de este ajuste. Sin embargo, puede seleccionar ajustes adicionales en el Editor de etiquetas de trabajo si es
necesario.

• Antes, no se podía seleccionar un color plano de alias en Job editor si Fiery Command WorkStation había
iniciado sesión en un servidor de Fiery XF de manera remota.

Notas de la versión para el cliente
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• Ahora puede guardar correctamente las fuentes y métodos del contorno de corte como un valor predefinido.

• Si se seleccionaba la opción Impresión sin bordes, se producía un error en el trabajo de la cola con el error
Tamaño de hoja no válido detectado.

• Con algunas combinaciones de Fiery Command WorkStation y Fiery XF, la configuración del modo de medida
M2 no se guardaba al utilizar el dispositivo de medición Epson SpectroProofer ILS30 para optimizar un perfil en
Color Tools. Aunque se seleccionara M2 (filtro de UV), el resultado incluía la luz UV, que es el modo de medición
M1.

• Si se intentaba optimizar una medición de verificación mediante el método de medición M2 para el dispositivo
Epson SpectroProofer IL30, no se apreciaba ninguna mejora debido a que la medición M2 no se guardaba.

• En los equipos macOS, Fiery Command WorkStation dejaba de responder cuando se clasificaban los trabajos
haciendo clic los encabezados de columna en el Centro de trabajos.

• En Color Tools > Recalibración por medición, los pasos recomendados que se mostraban tras medir el primer
gráfico estaban truncados en ciertos idiomas.

• Con monitores dobles, ahora puede volver a iniciar Color Tools en el monitor secundario. Previamente, Color
Tools siempre se abría en el monitor principal.

Problemas solucionados en Fiery Command WorkStation Package v6.3.0.271

Se han corregido los problemas siguientes:
Fiery Command WorkStation

• Al imprimir muestras de colores planos, algunos ajustes de la pestaña Propiedades del trabajo > imagen no se
aplicaban.

Fiery XF

• Antes no era posible crear separaciones blancas para las impresoras VUTEk 3r/5r/3r+/5r+ porque la separación
blanca faltaba en la carpeta de salida. El problema se ha resuelto en la última versión.

• En Color Editor, los libros de muestras deben imprimirse con un tamaño de papel predeterminado. Ya no es
posible definir un tamaño de papel personalizado.

Problemas solucionados en Fiery Command WorkStation Package v6.3.0.259

Se han corregido los problemas siguientes:
Fiery Command WorkStation

• Con el servidor Fiery configurado en un idioma distinto del inglés en un equipo macOS, al acceder a Servidor >
Registros > Imprimir > impresora local > Imprimir, el cuadro de diálogo Imprimir que se abría se mostraba en
inglés.

• Las preferencias de Fiery Hot Folders ya no contienen una selección de la ruta de plantilla de Fiery Impose. En su
lugar, se utiliza la misma ruta que Fiery Command WorkStation.

• Fiery CaLibrator responde mejor y se inicia más rápidamente.
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Fiery XF

• En Job editor, no es posible editar los valores de Escala para personalizar un área de recorte.

• En Color Tools > Crear calibración > Resumen, no se podía abrir ningún perfil de soportes en Profile Inspector
para comparar la gama de colores con la del archivo de calibración.

• Solo se podían imprimir diagramas de calibración avanzados si el sistema operativo estaba configurado en inglés.

• El uso de un dispositivo de medición Barbieri Spectro LFP qb a través de IP para crear un archivo calibración
generaba datos IT8 incorrectos. Como resultado, no se podía abrir el archivo de calibración en Color Tools >
Crear calibración > Resumen > Profile Inspector.

• Si se configuraba un trabajo de verificación en Job Editor para medir una cuña dinámica mediante un dispositivo
de medición integrado, Job Editor mostraba resultados de Delta E incorrectos tras la verificación. Tanto Verifier
como Job Editor ahora muestran los valores Delta E correctos.

• Cuando se modificaba el valor límite de tinta total (TIL) en Color Tools > Crear calibración > Límite total de tinta
para cualquier impresora VUTEk, Color Tools dejaba de responder.

• No se podía medir el primer gráfico del proceso de calibración mediante el dispositivo de medición ES-2000.

Problemas resueltos en Fiery Command WorkStation Package v6.3.0.234

Se han corregido los problemas siguientes:
Fiery Command WorkStation

• No podía guardar la configuración de la opción Dúplex en Colores planos > Propiedades del trabajo.

• Si accedía a la ventana Configuración del calibrador antes de calibrar el servidor Fiery, Fiery Calibrator dejaba de
responder.

• Al llevar a cabo la recalibración mediante el dispositivo EFI ES-2000, si seleccionaba 51 aleatorias como valor del
conjunto de muestras, la carta de color impresa y el gráfico mostrados en Fiery Command WorkStation no
coincidían.

• Cuando creaba una calibración en Calibrador, la opción Generar datos ACD tras la calibración no estaba
disponible para impresoras compatibles.

Fiery XF

• Ahora puede guardar la configuración del cuadro PDF en Server Manager > Terminación > Marcas > Marcas de
corte > Corte de contorno. Anteriormente, solo se podía aplicar la configuración del cuadro de papel.

• Al configurar una impresora para imprimir en el puerto, no era posible configurar una conexión con cualquier
impresora que no utilizara el puerto 9100.

• En equipos macOS, ahora es posible la optimización de colores planos. Previamente, se generaba un gráfico
incorrecto que provocaba que la iteración fallara.

Problemas resueltos en Fiery Command WorkStation Package 6.3.0.216

Se han corregido los problemas siguientes:
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Fiery Command WorkStation

• Con el servidor Fiery configurado en un idioma que no fuera inglés, al insertar páginas desde un trabajo
guardado en el servidor Fiery, Fiery Impose o Fiery JobMaster dejaban de responder.

• En Fiery Impose, al guardar un trabajo como PDF acoplado, las capas u objetos marcados como ocultos en
Acrobat se veían al imprimir.

Fiery XF

• La etiqueta de los mosaicos escalados ya se ve bien en la pestaña Vista de mosaico individual.

• Color Tools no mostraba los datos de medición fila por fila en los gráficos de calibración y control de calidad.

• Al intentar usar un dispositivo de medición i1 Pro2 para crear un perfil, no se detectaba el instrumento.

• Al definir el perfil de corrección L*a*b* (*.3cc) como Ninguno, un mensaje de error indicaba que el perfil no era
válido.

• En algunos casos, el servidor Fiery XF no se iniciaba después de que actualizara Fiery Command WorkStation a
la versión 6.3.

• Al actualizar el software a Fiery Command WorkStation 6.3 SP1, se borraba la carpeta C:\Program Data\Fiery
\Fiery XF\Client\Working. Como resultado, se perdían todos los datos de medición guardados en esta carpeta, lo
que generaba informes incorrectos.

Problemas resueltos en Fiery Command WorkStation Package 6.3.0.199

Se han solucionado los siguientes problemas:
Fiery Command WorkStation

• No puede imprimir un trabajo de cuadernillo grapado desde Hot Folders debido a un error de gramaje del papel.
Sin embargo, el mismo trabajo puede imprimirse desde Fiery Command WorkStation sin error.

• En un sistema japonés, los trabajos en PDF enviados a una carpeta de proceso no se procesaban si los trabajos
tenían una plantilla de Impose y un valor predefinido de trabajo.

• Si se había activado la opción Previsualizar al procesaren > Fiery Command WorkStation > Servidor >
Configurar > Administración de trabajos, tanto Fiery Command WorkStation como Fiery Server dejaban de
responder al procesar algunos trabajos con imposición.

• Si se aplicaba un valor predefinido de servidor a un trabajo y se cambiaba el valor predefinido de servidor del
mismo trabajo haciendo clic con el botón derecho en el trabajo de la cola En espera, el servidor Fiery dejaba de
responder.

Fiery XF

• En equipos macOS, si Fiery Command WorkStation se había configurado para el alemán, los valores de Cortar
imagen de Job Editor > Acabado > Marcas > Marcas de recorte no se guardaban.

• Ahora puede configurar impresoras conectadas al equipo servidor Fiery a través de USB. Anteriormente, al
seleccionar el tipo de conexión Imprimir a través de puerto aparecía un mensaje incorrecto que indicaba que el
puerto seleccionado no era válido.

• La zona máxima de superponer/pegar mosaicos era de 3,939 pulgadas. Este valor se ha aumentado a petición del
cliente. Ahora es posible superponer/pegar márgenes de más de 6 pulgadas.
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Problemas resueltos en Service Pack 1 (SP1)

Modo HyperRIP

Cuando está conectado a un Fiery server que es FS200 o posterior con el modo HyperRIP establecido en Varios
trabajos, puede que la barra de progreso no se muestre al enviar trabajos a Procesar y En espera.

Fiery Software Managerno detecta la actualización KB2999226 para Windows

La versión 4.2.0.14 de Fiery Software Manager (FSM) incluida en las versiones recientes del paquete Fiery Command
WorkStation 6.3 SP1 resuelve el problema siguiente: FSM no detecta la actualización KB2999226 para Windows e
indica por error que la actualización está pendiente. Después de aplicar la actualización, el error persiste y en algunos
casos impide que CWS 6.3 pueda instalarse.

Notas de la versión para el cliente
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Notas de Versão do Cliente
Fiery Command WorkStation Package, v6.3

Este documento contém informações importantes sobre esta versão. Certifique-se de fornecer essas informações a
todos os usuários antes de prosseguir com a instalação.

Sobre esta versão

Os aplicativos a seguir estão incluídos nesta versão:

• Fiery Command WorkStation Package v6.3.0.333

• Fiery Command WorkStation v6.3.0.58

• Fiery Hot Folders v3.12.0.35

• Fiery Software Manager para Mac v4.2.0.16

• Fiery Software Manager para Windows v4.2.0.16

Nota:

Este instalador atualizará qualquer Fiery Command WorkStation Package ou Fiery Extended Applications Package
existente para o Fiery Command WorkStation Package mais recente contendo Fiery Command WorkStation e Fiery
Hot Folders. Opcionalmente, você pode instalar o Fiery Remote Scan usandoo Fiery Software Manager.
O Fiery Command WorkStation Package é compatível com Fiery servers que executam o System 10/10e e versões
posteriores, o Fiery proServer e o Fiery XF 7.0 e versões posteriores. O pacote não se conecta a:

• Fiery servers que executam o software do Fiery System 9/9e Rel2 e versões anteriores

• Servidores Fiery XF 6.x e versões anteriores

• Servidores Fiery Central

Se você precisa ter acesso a esses produtos, não faça a atualização. O pacote do Fiery Extended Applications ainda
está disponível em www.efi.com/cws. Para obter uma lista completa de impressoras compatíveis com cutsheet,
consulte http://fiery.efi.com/CWS/supported-printers.
Para obter mais informações sobre as especificações técnicas, consulte www.efi.com/cws.

O que há de novo?

Impressoras de folhas soltas: http://fiery.efi.com/CWScutsheetWN
Impressoras de grandes e supergrandes formatos: http://fiery.efi.com/CWSwideformatWN

HTTP://WWW.EFI.COM/CWS
HTTP://FIERY.EFI.COM/CWS/SUPPORTED-PRINTERS
http://www.efi.com/cws
http://fiery.efi.com/CWScutsheetWN
http://fiery.efi.com/CWSwideformatWN


Aplicativo de 64 bits

A Fiery Command WorkStation 6.3 (CWS) é um aplicativo nativo de 64 bits para plataformas macOS e Windows.
Não há suporte para sistemas operacionais de 32 bits na CWS 6.3. Se o Fiery Software Manager já estiver em
execução em um sistema operacional de 32 bits, como o Windows 7 de 32 bits, ele não exibirá as notificações de
atualização do pacote da CWS 6.3. Se você tentar executar essa versão do Fiery Software Manager em um SO de 32
bits, ocorrerá um erro de compatibilidade e o Fiery Software Manager não será executado. Para ver os sistemas
operacionais compatíveis, consulte http://fiery.efi.com/cws-specifications.

Fiery Color Profiler Suite e Fiery Command WorkStation 6.3

O Fiery Color Profiler Suite 5.0 (CPS) e as versões anteriores não são totalmente compatíveis com o Fiery Command
WorkStation Package 6.3 (CWS) para impressoras de folhas soltas. Recomendamos atualizar para o Fiery Color
Profiler Suite 5.1.
Ao usar o CPS 5.0 com a CWS 6.3, você pode enfrentar os seguintes problemas:

• Se você visualizar a mensagem na CWS “Conecte o espectrofotômetro ao seu computador” enquanto o CPS
estiver aberto, feche o CPS e clique em OK para continuar.

• Depois de criar uma nova configuração de calibragem no Calibrator, o botão Criar novo perfil que inicia o CPS
ficará oculto. Esse problema é resolvido após a atualização para o CPS 5.1.

Nota: A CWS 6.3 conectada a servidores Fiery XF com o CPS 5.0 é uma configuração compatível.

Atualização do Fiery JobFlow para utilizar com a Fiery Command WorkStation6.3

O Fiery JobFlow 2.5 é compatível com o Fiery Command WorkStation Package 6.3. Versões anteriores do Fiery
JobFlow não são compatíveis.
O Fiery JobFlow 2.5 tem compatibilidade retroativa com as versões 5.8 a 6.2 da Fiery Command WorkStation. No
entanto, se você atualizar para a Fiery Command WorkStation6.3, também deverá atualizar para o Fiery JobFlow 2.5.
Para obter mais informações, consulte www.efi.com/jobflow.

Compatível com monitores HiDPI

A Fiery Command WorkStation6.3 é totalmente compatível com monitores HiDPI, seguindo as configurações do
Microsoft Windows em Vídeo > Ajustar escala e layout para que as fontes e outros itens não apresentem tamanhos
inconsistentes com a resolução do monitor. Algumas fontes no aplicativo podem parecer levemente suaves ou
borradas, dependendo do fator de dimensionamento selecionado no Windows. No entanto, a legibilidade e
funcionalidade não serão afetadas.

Recursos descontinuados
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Filtros do Fiery Hot Folders

Os itens a seguir não terão mais suporte para conversão pelo Fiery Hot Folders:

• Filtros incluídos no Fiery Graphic Arts Package, Premium Edition e no Fiery Productivity Package: PDF2GO,
ExportPS, CT-LW, DCS 2.0 e TIFF-IT.

• A conversão de PDF para PS (PostScript) no Fiery Hot Folders foi descontinuada porque o Adobe PDF Print
Engine (APPE) permite que o Fiery server processe e renderize tarefas PDF de forma nativa sem a
necessidade de convertê-las em PostScript.

Plug-in TWAIN para o Fiery Remote Scan

O plug-in TWAIN para o Fiery Remote Scan foi descontinuado, o que impede a digitalização de páginas
diretamente em aplicativos de terceiros, como o Adobe Acrobat ou Adobe Photoshop. No entanto, o aplicativo
independente Fiery Remote Scan permanece totalmente compatível, permitindo aos usuários acessar tarefas de
digitalização e sincronizar automaticamente as caixas de correio de digitalização com um computador em um
Fiery server compatível.

Digitalização com o Fiery JobMaster

O Fiery JobMaster 5.0 (incluído no Fiery Command WorkStation Package6.3) não é mais compatível com
drivers de digitalização TWAIN.
O Fiery JobMaster 5.0 adiciona suporte para:

• Drivers WIA (Windows Image Acquisition)

• Drivers ICA (Application Capture Application) para Mac

• Plug-in do Fiery Remote Scan versão 6.7 (específico para o aplicativo Fiery JobMaster)

Atalhos do aplicativo Fiery Software Manager

OFiery Software Manager não cria atalhos para o aplicativo na área de trabalho do Windows ou no Dock do
macOS. No entanto, instalações da Fiery Command WorkStation feitas diretamente no Fiery server continuarão
a ter atalhos para o aplicativo adicionados à área de trabalho do Windows.

Problemas corrigidos no Fiery Command WorkStation Package v6.3.0.333

Os seguintes problemas foram corrigidos:
Fiery Command WorkStation

• Uma mensagem de exceção não tratada não ocorre mais quando você abre determinados arquivos PDF no Fiery
Impose e no Fiery Preview.

Fiery XF

• Não era possível criar GIFs para impressoras VUTEk 32r e h3/h5 configuradas para impressão IP se a impressora
tivesse sido configurada previamente para imprimir arquivos com a opção Criar visualização de GIF de arquivos
RTL desativada na janela Configurações especiais.

• Ao selecionar as configurações de calibragem no Color Tools, a opção de saída Tamanho do ponto agora é exibida
corretamente como Multi-strike para impressoras Epson SureColor S306X0.
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• Os valores de tons salvos para arquivos de compensação da chapa visual agora correspondem aos valores salvos
no Fiery XF 6.5.

• Ao otimizar um perfil no Color Tools, a posição do botão Otimizar agora permanece estática. Anteriormente, o
botão se movia progressivamente pela janela com cada iteração e eventualmente se tornava indisponível.

Problemas corrigidos no Fiery Command WorkStation Package v6.3.0.307

Os seguintes problemas foram corrigidos:
Fiery Command WorkStation

• Agora você pode acessar facilmente Catálogo de papéis, Alinhar bandejae Centro de dispositivos ao fazer logon
em um Fiery server como um administrador com uma senha que inclua caracteres especiais e mais de 10
caracteres.

• Em computadores com macOS, o calibrador Fiery iniciado pela Fiery Command WorkStation agora emite um
bipe quando você recalibra ou cria uma calibragem com o dispositivo de medição ES-1000.

• Quando você arrastava e soltava as cores exatas em Centro de dispositivos > Recursos > Cores exatas, a Fiery
Command WorkStation parava de responder.

• Em alguns casos, quando você abria uma tarefa na visualização do Fiery, Fiery Impose, Fiery Compose ou Fiery
JobMaster, as imagens de visualização apareciam borradas.

Fiery XF

• O Job Editor não conseguia exibir corretamente a espessura da linha das marcas de corte.

• Em uma tarefa de encaixe de várias páginas, o Job Editor parava de responder em caso de mudança na orientação
da página ou a distância entre as páginas causava a criação de uma nova página de encaixe.

• Em alguns casos, o servidor Fiery XF não iniciava após a atualização para a Fiery Command WorkStation 6.3
devido à indisponibilidade do serviço EFI License Manager.

Problemas corrigidos no Fiery Command WorkStation Package v6.3.0.280

Os seguintes problemas foram corrigidos:
Fiery Command WorkStation

• Em um Fiery server com um grande número de entradas do Paper Catalog, não era possível percorrer todas as
entradas do Paper Catalog para atribuir mídia a um bandeja se o Fiery Ticker estivesse em execução.

• Com o Fiery Command WorkStation definido com um idioma diferente do inglês, quando você selecionava uma
data inicial de um intervalo no Registro de tarefas, nenhum registro era exibido mesmo que as tarefas estivessem
disponíveis no registrode tarefas.

Fiery XF

• Ao selecionar qualquer barra de controle ISO 12647-7, a etiqueta da tarefa impressa contém todas as
informações necessárias para obter conformidade com a ISO. Não é possível desmarcar essas configurações.
Você pode, no entanto, selecionar outras configurações no Editor de etiquetas de tarefas, se necessário.

• Não era possível selecionar um alias de cor especial no Job Editor se o Fiery Command WorkStation tivesse sido
conectado remotamente a um servidor Fiery XF.

• Agora você pode salvar corretamente as origens e métodos de contorno de corte como uma predefinição.
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• Quando a Impressão sem bordas era selecionada, a tarefa em spool apresentava o erro Tamanho de folha
inválido detectado .

• Com algumas combinações de Fiery Command WorkStation e Fiery XF, a configuração do modo de medição M2
não foi salva ao usar um dispositivo de medição Epson SpectroProofer ILS30 para otimizar um perfil em Color
Tools. Mesmo se você selecionou M2 (corte UV), o resultado incluiu UV, que é o modo de medição M1.

• Se você tentou otimizar uma medida de verificação usando o modo de medição M2 para o Epson SpectroProofer
IL30, nenhuma melhoria pode ser detectada porque a medição M2 não foi salva.

• Em computadores com macOS, o Fiery Command WorkStation parou de responder quando as tarefas eram
classificadas clicando em cabeçalhos de coluna no Centro de tarefas.

• Em Color Tools > Recalibragem por medição, as etapas recomendadas a serem seguidas depois de medir a
primeira tabela foram truncadas em alguns idiomas.

• Com monitores duplos, você pode agora iniciar novamente o Color Tools no monitor secundário. Anteriormente,
o Color Tools sempre abria no monitor principal.

Problemas corrigidos no Fiery Command WorkStation Package v6.3.0.271

Os seguintes problemas foram corrigidos:
Fiery Command WorkStation

• Quando você imprimiu amostras de cores especiais, algumas configurações da guia Propriedades da tarefa >
Imagem não estavam sendo aplicadas.

Fiery XF

• Anteriormente não era possível criar separações de branco para impressoras VUTEk 3r/5r/3r+/5r+ porque a
separação de branco estava ausente na pasta Saída. O problema foi resolvido na versão mais recente.

• No Color Editor, os livros de amostra devem ser impressos em um tamanho de mídia padrão. Não é mais possível
definir um tamanho de mídia personalizado.

Problemas corrigidos Fiery Command WorkStation Package no v 6.3.0.259

Os seguintes problemas foram corrigidos:
Fiery Command WorkStation

• Com o servidor Fiery configurado em um idioma diferente do inglês em um computador macOS, ao acessar
Servidor > Registros > Imprimir > Impressora local > Imprimir, a caixa de diálogo Imprimir era aberta era em
inglês.

• As preferências do Fiery Hot Folders não contêm mais uma seleção de caminho para o modelo do Fiery Impose.
Em vez disso, usam o mesmo caminho que a Fiery Command WorkStation.

• O Calibrador do Fiery inicia e responde mais rapidamente.

Fiery XF

• No Job Editor, não era possível editar os valores de Escala para personalizar uma área de corte.

• Em Color Tools > Criar calibragem > Resumo, não era possível abrir um perfil de mídia no Profile Inspector para
comparar o gamut de cores do perfil com o do arquivo de calibragem.
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• Só era possível imprimir gráficos de calibragem avançados se o sistema operacional tivesse sido definido como
inglês.

• O uso de um dispositivo de medição Barbieri Spectro LFP qb por IP para criar um arquivo de calibragem gerava
dados de IT8 incorretos. Como resultado, não era possível abrir o arquivo calibragem em Color Tools > Criar
calibragem > Resumo > Profile Inspector.

• Se uma tarefa de verificação fosse configurada no Job Editor para medir um Dynamic Wedge usando um
dispositivo para medição incorporado, o Job Editor exibia resultados incorretos de Delta E após a verificação. O
Verifier e o Job Editor agora exibem os valores corretos de Delta E.

• Quando o valor de limite de tinta total (TIL) era modificado em Color Tools > Criar calibragem> Limite de tinta
total para qualquer impressora Vutek, o Color Tools parava de responder.

• Não era possível medir a primeira tabela no processo de calibragem usando o dispositivo de medição ES-2000

Problemas corrigidos na Fiery Command WorkStation Package v6.3.0.234

Os seguintes problemas foram corrigidos:
Fiery Command WorkStation

• Não é possível salvar a opção Duplex em Cores especiais > Propriedades da tarefa.

• Se você acessar a janela Configurações do Calibrator antes de recalibrar o servidor Fiery, o Fiery Calibrator para
de responder.

• Ao recalibrar usando o dispositivo EFI ES-2000, se você selecionar 51 aleatório como valor do conjunto de
amostras, a tabela de cores impressa e o gráfico exibidos na Fiery Command WorkStation não se correspondem.

• No Calibrator, ao criar uma calibragem, a opção Gerar dados de ACD após a calibragem não está disponível para
impressoras compatíveis.

Fiery XF

• Agora você pode salvar as configurações da caixa de PDF em Server Manager > Acabamento > Marcas > Marcas
de corte > Corte de contorno. Anteriormente, somente a configuração de caixa de mídia podia ser aplicada.

• Ao configurar uma impressora para imprimir em uma porta, não era possível configurar uma conexão para
impressoras que não usavam a porta 9100.

• Em computadores com macOS, agora é possível otimizar cores especiais. Anteriormente, um gráfico incorreto
era gerado e causava falha na iteração.

Problemas corrigidos no Fiery Command WorkStation Package v6.3.0.216

Os seguintes problemas foram corrigidos:
Fiery Command WorkStation

• Com o servidor Fiery configurado em um idioma diferente do inglês, quando eram inseridas páginas de um
trabalho salvo no servidor Fiery, o Fiery Impose ou o Fiery JobMaster paravam de responder.

• No Fiery Impose, quando um trabalho era salvo como pdf nivelado, camadas ou objetos marcados como ocultos
no Acrobat apareciam na impressão.
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Fiery XF

• A etiqueta de mosaicos modulares agora é exibida corretamente na guia Visualização de mosaico único.

• O Color Tools não exibia dados de medição linha por linha para as tabelas de calibragem e controle de qualidade.

• Quando um dispositivo de medição i1 Pro2 era usado para criar um perfil, o dispositivo não era detectado.

• Quando o perfil de correção L*a*b* (*.3cc) era definido como Nenhum, uma mensagem de erro incorreta
indicava que o perfil era inválido.

• Em alguns casos, o servidor Fiery XF não iniciava após a atualização para a Fiery Command WorkStation 6.3.

• A atualização para a Fiery Command WorkStation 6.3 SP1 fazia com que a pasta C:\Program Data\Fiery\Fiery
XF\Client\Working fosse excluída. Como resultado, todos os dados de medição salvos anteriormente nessa pasta
não estavam mais disponível, dando origem a relatórios incorretos.

Problemas corrigidos no Fiery Command WorkStation Package v6.3.0.199

Os seguintes problemas foram corrigidos:
Fiery Command WorkStation

• Não foi possível imprimir um trabalho de grampeamento de livretos das Hot Folders devido a um erro de
gramatura do papel. No entanto, o mesmo trabalho pode ser impresso pela Fiery Command WorkStation sem
erro.

• Em um sistema em japonês, tarefas em PDF enviadas para uma Hot Folder não foram processadas se as tarefas
tiverem um modelo de predefinição de tarefa e Impose.

• Se o Visualizar durante processamento opção foi ativada no > Fiery Command WorkStation > Server >
Configure > gerenciamento, Fiery Command WorkStation e Fiery servidor seria parar de responder e você
processados algumas tarefas impostas.

• Se você aplicar uma predefinição do servidor a uma tarefa e alterar a predefinição do servidor da mesma tarefa
clicando com o botão direito na tarefa da fila em espera, o servidor Fiery irá parar de responder.

Fiery XF

• Em computadores com macOS, se a Fiery Command WorkStation foi configurada para alemão, os valores
Recortar imagem em Job Editor > Acabamento > Marcas > Marcas de corte não foram salvas.

• Agora, você pode configurar impressoras conectadas ao computador do servidor Fiery por meio de USB.
Anteriormente, a seleção do tipo de conexão Imprimir via porta exibia uma mensagem incorreta que indicava que
a porta selecionada era inválida.

• A área máxima de sobreposição/colagem para mosaicos foi definida como 3,939 polegadas. Esse valor aumentou
por solicitação de um cliente. Agora, as margens de sobreposição/colagem de mais de 6 polegadas são possíveis.

Problemas resolvidos no Service Pack 1 (SP1)

Modo HyperRIP

Ao conectar-se a um Fiery server, FS200 ou mais recente, com o Modo HyperRIP definido como Várias tarefas, a
barra de progresso pode não ter sido exibida quando você enviou tarefas para a fila Processar e esperar.
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Fiery Software ManagerO Fiery Software Manager não detecta a atualização KB2999226 do
Windows

O Fiery Software Manager (FSM) versão 4.2.0.14 incluída em versões posteriores do pacote SP1 da Fiery Command
WorkStation 6.3 inclui uma correção para o seguinte problema: o FSM não detecta a atualização KB2999226 do
Windows e informa incorretamente que a atualização ainda precisa ser aplicada. Depois de aplicar a atualização, o
erro persiste e, em alguns casos, impede que a CWS 6.3 seja instalada.
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Versienotities voor de klant
Fiery Command WorkStation Package, v6.3

Dit document bevat belangrijke informatie over deze versie. Zorg dat deze informatie bij alle gebruikers bekend is
voordat u doorgaat met de installatie.

Over deze release

Deze release bestaat uit de volgende toepassingen:

• Fiery Command WorkStation Package v6.3.0.333

• Fiery Command WorkStation v6.3.0.58

• Fiery Hot Folders v3.12.0.35

• Fiery Software Manager voor Mac v4.2.0.16

• Fiery Software Manager voor Windows v4.2.0.16

Opmerking:

Dit installatieprogramma zal een bestaande Fiery Command WorkStation Package of Fiery Extended Applications
Package upgraden naar de nieuwste Fiery Command WorkStation Package, bestaande uit Fiery Command
WorkStation en Fiery Hot Folders. U kunt Fiery Remote Scan ook installeren met behulp van Fiery Software
Manager.
Fiery Command WorkStation Package ondersteunt Fiery servers System 10/10e en hoger, en Fiery proServer en
Fiery XF 7.0 en hoger. Het programma maakt geen verbinding met:

• Fiery servers Fiery System 9/9e Rel2-software en vorige versies

• Fiery XF 6.x-servers en eerder

• Fiery Central-servers

Als u toegang tot deze producten nodig hebt, moet u de upgrade niet uitvoeren. Fiery Extended Applications-pakket
is nog steeds beschikbaar op www.efi.com/cws. Raadpleeg http://fiery.efi.com/CWS/supported-printers voor een
volledige lijst met ondersteunde printers.
Ga voor meer informatie over de technische specificaties naar www.efi.com/cws.

Wat is nieuw?

Cut-sheetprinters: http://fiery.efi.com/CWScutsheetWN

HTTP://WWW.EFI.COM/CWS
HTTP://FIERY.EFI.COM/CWS/SUPPORTED-PRINTERS
http://www.efi.com/cws
http://fiery.efi.com/CWScutsheetWN


Grootformaat- en supergrootformaatprinters: http://fiery.efi.com/CWSwideformatWN

64-bits toepassing

Fiery Command WorkStation 6.3 (CWS) is een native 64-bits toepassing voor zowel macOS- als Windows-
platforms.
32-bits besturingssystemen worden niet ondersteund voor CWS 6.3. Als Fiery Software Manager al op een 32-bits
besturingssysteem (OS) wordt uitgevoerd, zoals Windows 7 32-bits, worden de updateberichten voor het CWS 6.3-
pakket niet weergegeven. Als u deze versie van Fiery Software Manager op een 32-bits besturingssysteem probeert
uit te voeren, krijgt u een compatibiliteitsfout te zien en wordt Fiery Software Manager niet uitgevoerd. Raadpleeg 
http://fiery.efi.com/cws-specifications voor meer informatie over ondersteunde besturingssystemen.

Fiery Color Profiler Suite en Fiery Command WorkStation 6.3

Fiery Color Profiler Suite 5.0 (CPS) en eerdere versies zijn niet volledig compatibel met Fiery Command
WorkStation-pakket 6.3 (CWS) voor cut-sheetprinters. Wij raden u aan de update naar Fiery Color Profiler Suite 5.1
uit te voeren.
Wanneer u CPS 5.0 gebruikt met CWS 6.3, kunt u de volgende problemen ondervinden:

• Als u het bericht Sluit de spectrofotometer aan op uw computer in CWS ziet terwijl CPS is geopend, sluit CPS
dan en klik op OK om door te gaan.

• Nadat u een nieuwe kalibratie-instelling hebt gemaakt in Calibrator, is de knop Nieuw profiel maken om CPS te
starten, verborgen. Dit probleem is opgelost na het upgraden naar CPS 5.1.

Opmerking: CWS 6.3 verbonden met Fiery XF-servers met CPS 5.0 is een ondersteunde configuratie.

Fiery JobFlow upgraden voor gebruik met Fiery Command WorkStation6.3

Fiery JobFlow 2.5 is compatibel met Fiery Command WorkStation-pakket 6.3. Eerdere versies van Fiery JobFlow
worden niet ondersteund.
Fiery JobFlow 2.5 is achterwaarts compatibel met Fiery Command WorkStation versies 5.8 tot en met 6.2. Als u
echter een upgrade uitvoert naar Fiery Command WorkStation6.3, moet u ook bijwerken naar Fiery JobFlow 2.5.
Raadpleeg www.efi.com/jobflow voor meer informatie.

HiDPI-monitorondersteuning

Fiery Command WorkStation 6.3 biedt volledige ondersteuning voor HiDPI-monitors volgens de Weergave-
instellingen van Microsoft Windows voor schaal en lay-out, zodat lettertypen en andere items in een ander formaat
op de algemene weergaveresolutie kunnen worden geschaald. Bepaalde lettertypen in de toepassing kunnen
enigszins zacht of onscherp lijken, afhankelijk van de geselecteerde schaalfactor in Windows. De leesbaarheid en
functionaliteit worden echter niet beïnvloed.

Beëindigde functies
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Fiery Hot Folders-filters

De volgende opties worden niet meer ondersteund voor conversie door Fiery Hot Folders:

• Deze filters zijn opgenomen in Fiery Graphic Arts Package, Premium Edition en Fiery Productivity Package:
PDF2GO, ExportPS, CT-LW, DCS 2.0 en TIFF-IT.

• Conversie van PDF naar PS (PostScript) in Fiery Hot Folders is beëindigd omdat de Adobe PDF Print Engine
(APPE) de Fiery server toestaat om PDF-opdrachten op systeemeigen wijze te verwerken en weer te geven
zonder dat deze naar PostScript moeten worden geconverteerd.

Fiery Remote Scan TWAIN-invoegtoepassing

De Fiery Remote Scan TWAIN-invoegtoepassing is beëindigd, waardoor pagina's niet meer rechtstreeks naar
toepassingen van derden, zoals Adobe Acrobat of Adobe Photoshop, kunnen worden gescand. De zelfstandige
toepassing Fiery Remote Scan blijft echter volledig ondersteund om scanopdrachten op te halen en automatisch
scanpostvakken op een ondersteunde Fiery server met uw computer te synchroniseren.

Fiery JobMaster scannen

Fiery JobMaster 5.0 (opgenomen in Fiery Command WorkStation Package6.3) ondersteunt geen TWAIN-
scanstuurprogramma's meer.
Fiery JobMaster 5.0 voegt ondersteuning toe voor:

• WIA-stuurprogramma's (Windows Image Acquisition)

• Mac ICA-stuurprogramma's (Image Capture Application)

• Fiery Remote Scan-invoegtoepassing versie 6.7 (specifiek voor de Fiery JobMaster-toepassing)

Fiery Software Manager-toepassingssnelkoppelingen

Fiery Software Manager maakt geen toepassingssnelkoppelingen op het bureaublad van Windows of in het dock
van macOS. Voor Fiery Command WorkStation-installaties direct op de Fiery server worden echter wel steeds
snelkoppelingen naar het bureaublad van Windows toegevoegd.

Problemen opgelost in Fiery Command WorkStation Package v6.3.0.333

De volgende problemen zijn opgelost:
Fiery Command WorkStation

• Een niet-verwerkt uitzonderingsbericht verschijnt niet meer wanneer u bepaalde PDF-bestanden opent in Fiery
Impose en Fiery-voorbeeld.

Fiery XF

• Het was niet mogelijk om GIF's te maken voor VUTEk 32r-en h3/h5-printers die waren ingesteld voor IP-
afdrukken als de printer eerder was geconfigureerd om naar bestand af te drukken met de optie GIF voorbeeld
van RTL-bestanden maken uitgeschakeld in het venster Speciale instellingen.

• Bij het selecteren van kalibratie-instellingen in Color Tools wordt de uitvoeroptie Puntgrootte nu correct
weergegeven als Multistrike voor Epson SureColor S306X0-printers.
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• De toonwaarden die zijn opgeslagen op visuele plaatcompensatiebestanden komen nu overeen met de waarden
die zijn opgeslagen in Fiery XF 6.5.

• Bij het optimaliseren van een profiel in Color Tools blijft de positie van de knop Optimaliseren nu statisch.
Voorheen verschoof de knop met elke herhaling geleidelijk naar beneden op het venster totdat deze uiteindelijk
onbeschikbaar werd.

Problemen opgelost in Fiery Command WorkStation Package v6.3.0.307

De volgende problemen zijn opgelost:
Fiery Command WorkStation

• U kunt nu eenvoudig toegang krijgen tot Papiercatalogus, Lade uitlijnen en Apparaatcentrum wanneer u zich
aanmeldt bij een Fiery server als beheerder met een wachtwoord met speciale tekens en een lengte van meer dan
10 tekens.

• Op macOS-computers wordt Fiery Calibrator vanaf Fiery Command WorkStation nu gestart met een pieptoon
wanneer u opnieuw kalibreert of een kalibratie maakt met het meetinstrument ES-1000.

• Wanneer u de steunkleuren naar Apparaatcentrum > Hulpbronnen > Steunkleuren sleepte en neerzette,
reageerde Fiery Command WorkStation niet meer.

• In sommige gevallen, wanneer u een taak opende in Fiery Preview, Fiery Impose, Fiery Compose of Fiery
JobMaster, leken de voorbeeldafbeeldingen wazig.

Fiery XF

• Job Editor kon de lijndikte van bijsnijdmarkeringen niet juist weergeven.

• In een nestingtaak met meerdere pagina's, reageerde Job Editor niet meer als door het wijzigen van de
afdrukstand of de afstand tussen pagina's een nieuwe nestingpagina werd gemaakt.

• In sommige gevallen startte de Fiery XF-server niet na een upgrade naar Fiery Command WorkStation 6.3
doordat de EFI-licentiebeheerservice niet beschikbaar was.

Problemen opgelost in Fiery Command WorkStation Package v6.3.0.280

De volgende problemen zijn opgelost:
Fiery Command WorkStation

• Op een Fiery server met een groot aantal Paper Catalog-ingangen kon u niet door alle Paper Catalog-ingangen
scrollen om media toe te wijzen aan een lade, als Fiery Ticker werd uitgevoerd.

• Wanneer Fiery Command WorkStation was ingesteld op een andere taal dan Engels en u een begindatum van
een bereik in het Takenlogboek selecteerde, werden er geen logboeken weergegeven, zelfs niet als er taken
beschikbaar waren in het Takenlogboek.

Fiery XF

• Wanneer u een ISO 12647-7-bedieningsbalk selecteert, bevat het afgedrukte taaklabel alle informatie die nodig is
om aan de ISO-naleving te voldoen. U kunt deze instellingen niet deselecteren. U kunt echter desgewenst
aanvullende instellingen in Editor voor taaklabelsselecteren.

• Het is niet mogelijk om een steunkleuralias te selecteren in Job Editor als Fiery Command WorkStation op
afstand is aangemeld bij een Fiery XF-server.
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• U kunt snijcontourbronnen en -methoden nu op de juiste wijze opslaan als voorkeuze.

• Als Afdrukken zonder rand was geselecteerd, mislukte de in de wachtrij geplaatste taak vanwege een fout
Ongeldig papierformaat gedetecteerd .

• Bij sommige combinaties van Fiery Command WorkStation en Fiery XF werd de instelling voor de M2-
meetmodus niet opgeslagen bij gebruik van een Epson SpectroProofer ILS30-meetinstrument voor het
optimaliseren van een profiel in Color Tools. Zelfs als u M2 (UV afgesneden) selecteerde, bevatte het resultaat
UV, wat overeenkomt met de M1-meetmodus.

• Als u probeerde een controlemeting te optimaliseren met de M2-meetmethode voor de Epson SpectroProofer
IL30, kon geen verbetering worden waargenomen omdat de M2-meting niet was opgeslagen.

• Op macOS-computers reageerde Fiery Command WorkStation niet meer wanneer taken werden gesorteerd
door op kolomkoppen in Taakcentrumte klikken.

• In Color Tools > Herkalibratie door een meting werden de aanbevolen stappen na het meten van de eerste grafiek
in sommige talen afgekapt.

• Met twee monitoren kunt u nu Color Tools opnieuw starten op de secundaire monitor. Voorheen werd Color
Tools altijd geopend op de primaire monitor.

Problemen opgelost in Fiery Command WorkStation Package v6.3.0.271

De volgende problemen zijn opgelost:
Fiery Command WorkStation

• Bij het afdrukken van steunkleurvoorbeelden werden sommige instellingen van het tabblad Taakeigenschappen
> Afbeelding niet toegepast.

Fiery XF

• Het was eerder niet mogelijk om witte scheidingen voor VUTEk 3r/5r/3r+/5r+-printers te creëren omdat de
witte scheiding ontbrak in de uitvoermap. Het probleem is opgelost in de laatste release.

• In de Color Editor moeten boeken met kleurstalen worden afgedrukt op een standaard mediaformaat. Het is niet
meer mogelijk om een aangepaste mediaformaat te definiëren.

Problemen opgelost in Fiery Command WorkStation Package v6.3.0.259

De volgende problemen zijn opgelost:
Fiery Command WorkStation

• Als de Fiery-server was geconfigureerd in een andere taal dan Engels op een macOS-computer en u Server >
Logboeken > Afdrukken > Lokale printer > Afdrukken opende, was het dialoogvenster Afdrukken dat werd
geopend, in het Engels.

• Voorkeuren voor Fiery Hot Folders bevat geen Fiery Impose-sjabloonpadselectie meer. In plaats daarvan
gebruikt het hetzelfde pad als Fiery Command WorkStation.

• Fiery Calibrator wordt sneller gestart en reageert sneller.
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Fiery XF

• In Job Editor kon u de schaalwaarden niet bewerken om een gebied voor bijsnijden aan te passen.

• In Color Tools > Kalibratie maken > Overzicht kon u geen mediaprofiel openen in Profile Inspector om het
kleurengamma ervan te vergelijken met die van het kalibratiebestand.

• U kon alleen geavanceerde kalibratiegrafieken afdrukken als het besturingssysteem was ingesteld op Engels.

• Als een Barbieri spectro LFP qb-meetinstrument via IP werd gebruikt om een kalibratiebestand te maken,
werden onjuiste IT8-gegevens gegenereerd. Dit leidde ertoe dat u het kalibratiebestand niet kon openen in Color
Tools > Kalibratie maken > Overzicht > Profile Inspector.

• Als u een taak voor verifiëren in Job Editor instelde om een dynamic wedge te meten met een ingebouwd
meetinstrument, gaf Job Editor onjuiste delta E-resultaten weer na de verificatie. Zowel Verifier als Job Editor
geven nu de juiste delta E-waarden weer.

• Wanneer u de waarde voor de totale inktlimiet (TIL) wijzigde in Color Tools > Kalibratie maken Totaal inktlimiet
voor een VUTEk-printer, reageerde Color Tools niet meer.

• U kon de eerste grafiek in het kalibratieproces niet meten met het ES-2000-meetinstrument

Problemen opgelost in Fiery Command WorkStation Package v6.3.0.234

De volgende problemen zijn opgelost:
Fiery Command WorkStation

• U kon de optie-instelling voor Dubbelzijdig afdrukken in Steunkleuren > Taakeigenschappen niet opslaan.

• Als u het venster Calibrator-instellingen opende vóór het herkalibreren van de Fiery-server, reageerde Fiery
Calibrator niet meer.

• Als u tijdens het kalibreren met behulp van het EFI ES-2000-apparaat 51 willekeurig had geselecteerd als
vlakkensetwaarde, kwam de kleur van de afgedrukte kleurendiagrammen niet overeen met het weergegeven
diagram in Fiery Command WorkStation.

• In Calibrator was bij het maken van een kalibratie de optie ACD-gegevens genereren na kalibratie niet
beschikbaar voor ondersteunde printers.

Fiery XF

• U kunt nu de PDF Box-instellingen in Server Manager > Afwerking > Markeringen > Snijmarkeringen > Contour
snijden opslaan. Eerder kon alleen de instelling van Mediavak worden toegepast.

• Wanneer u een printer configureerde om af te drukken naar een poort, was het niet mogelijk een verbinding in te
stellen met een printer die niet poort 9100 gebruikte.

• Het is op macOS-computers nu mogelijk om steunkleuren te optimaliseren. Eerder werd een onjuiste grafiek
gegenereerd waardoor de herhaling mislukte.

Opgeloste problemen in Fiery Command WorkStation Package v6.3.0.216

De volgende problemen zijn opgelost:
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Fiery Command WorkStation

• Als de Fiery-server was geconfigureerd in een andere taal dan Engels en u pagina's had ingevoegd van een
opdracht die was opgeslagen op de Fiery-server, reageerde Fiery Impose of Fiery JobMaster niet meer.

• Als u in Fiery Impose een opdracht opsloeg als een pdf met één laag, verschenen lagen of objecten die waren
gemarkeerd als verborgen in Acrobat, op de uitvoer.

Fiery XF

• Het tegellabel van geschaalde tegels wordt nu correct weergegeven op het tabblad Weergave enkele tegels.

• Color Tools werd niet door de rij van de meetgegevens voor de kalibratie en kwaliteitscontrole grafieken
weergegeven.

• Bij gebruik van een i1 Pro2-meetinstrument voor het maken van een profiel kon het apparaat niet worden
gedetecteerd.

• Bij instelling van het L*a*b*-correctieprofiel op Geen werd een onjuist foutbericht weergegeven dat het profiel
ongeldig was.

• In sommige gevallen startte de Fiery XF-server niet na een upgrade naar Fiery Command WorkStation 6.3.

• Bij een upgrade naar Fiery Command WorkStation 6.3 SP1 werd de map C:\Program Data\Fiery\Fiery XF\Client
\Working verwijderd. Als gevolg waren alle meetgegevens die eerder in deze map waren opgeslagen, niet langer
beschikbaar, waardoor onjuiste rapporten werden gemaakt.

Problemen die zijn opgelost in Fiery Command WorkStation Package v6.3.0.199

De volgende problemen zijn opgelost:
Fiery Command WorkStation

• Het was niet mogelijk om een boekjesniettaak uit te voeren vanuit Hot Folders vanwege een fout in het
papiergewicht. Dezelfde taak kon echter wel foutloos worden uitgevoerd vanuit Fiery Command WorkStation.

• In een Japans systeem werden PDF-taken die naar een Hot Folder werden verstuurd, niet verwerkt als de taken
een Taakvoorinstellingen en Impose-sjabloon bevatten.

• Als de optie Voorbeeld tijdens verwerking was ingeschakeld in > Fiery Command WorkStation > Server >
Configure > Taakbeheer, reageerden zowel Fiery Command WorkStation als de Fiery-server niet meer wanneer u
ingeslagen taken verwerkte.

• Wanneer u een Servervoorkeuze toepaste op een taak en de Servervoorkeuze van dezelfde taak wijzigde door
met de rechtermuisknop op de taak in de wachtrij Geblokkeerd te klikken, reageerde de Fiery-server niet meer.

Fiery XF

• Als op macOS-computers Fiery Command WorkStation was geconfigureerd voor Duits, werden de waarden
voor Afbeelding snijden in Job Editor > Afwerking > Markeringen > Bijsnijdmarkeringen niet opgeslagen.

• U kunt nu printers configureren die via USB zijn verbonden met de Fiery-servercomputer. Als u het
verbindingstype Afdrukken via poort selecteerde, werd er een onjuist bericht weergegeven waarin stond dat de
geselecteerde poort ongeldig was.

• Het maximale overlap-/lijmgebied voor tegels was ingesteld op 3,939 inch. Naar aanleiding van het verzoek van
klanten is deze waarde verhoogd Overlap/lijmmarges van meer dan 6 inch zijn nu mogelijk.
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Opgeloste problemen in Service Pack 1 (SP1)

HyperRIP-modus

Als u verbinding hebt gemaakt met een Fiery server die is FS200 of nieuwer is en waarop HyperRIP-modus is
ingesteld op Meerdere taken, is de voortgangsbalk mogelijk niet weergegeven toen u taken verzond om te verwerken
en blokkeren.

Fiery Software Manager kan de Windows-update KB2999226 niet vinden

De Fiery Software Manager (FSM) versie 4.2.0.14 opgenomen in latere versies van het Fiery Command WorkStation
6.3 SP1-pakket bevat een oplossing voor het volgende probleem: FSM kan de Windows-update KB2999226 niet
vinden en geeft ten onrechte aan dat de update nog steeds moet worden uitgevoerd. Nadat u de update uitvoert, blijft
het probleem zich voordoen en kan CWS 6.3 in sommige gevallen niet worden geïnstalleerd.
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客户发行说明
Fiery Command WorkStation Package，v6.3

本文档包含关于此版本的重要信息。请确保先为所有用户提供这些信息，然后再继续安装。

关于此版本

此版本包含以下应用：

• Fiery Command WorkStation Package v6.3.0.333

• Fiery Command WorkStation v6.3.0.58

• Fiery Hot Folders v3.12.0.35

• Fiery Software Manager 适用于 Mac 的版本 v4.2.0.16

• Fiery Software Manager 适用于 Windows 的版本 v4.2.0.16

注释：

此安装程序会将现有 Fiery Command WorkStation Package 或 Fiery Extended Applications Package 升级
至最新的 Fiery Command WorkStation Package（包含 Fiery Command WorkStation 和 Fiery Hot
Folders）。您也可以选择使用 Fiery Software Manager 安装 Fiery Remote Scan。

Fiery Command WorkStation Package 支持运行 Fiery servers System 10/10e 及更高版本，Fiery proServer
和 Fiery XF 7.0 及更高版本。它无法连接至：

• Fiery servers 运行 Fiery System 9/9e Rel2 软件和以前的版本

• Fiery XF 6.x 服务器和更早版本

• Fiery Central 服务器

如果您需要访问这些产品，请勿进行升级。Fiery Extended Applications 程序包仍可从 www.efi.com/cws 上
获取。有关受支持单页纸打印机的完整列表，请参见 http://fiery.efi.com/CWS/supported-printers。

有关技术规格方面的更多信息，请参见 www.efi.com/cws。

新功能

单张纸打印机：http://fiery.efi.com/CWScutsheetWN

宽幅和超宽幅面打印机： http://fiery.efi.com/CWSwideformatWN

HTTP://WWW.EFI.COM/CWS
HTTP://FIERY.EFI.COM/CWS/SUPPORTED-PRINTERS
http://www.efi.com/cws
http://fiery.efi.com/CWScutsheetWN
http://fiery.efi.com/CWSwideformatWN


64 位应用程序

Fiery Command WorkStation 6.3 (CWS) 是一款同时适用于 macOS 和 Windows 平台的本机 64 位应用程序。

CWS 6.3 不支持 32 位操作系统。如果 Fiery Software Manager 已在 Windows 7 32 位等 32 位操作系统
(OS) 上运行，将不会显示 CWS 6.3 软件包的更新通知。如果尝试在 32 位操作系统上运行此版本的 Fiery
Software Manager，将显示兼容性错误，并且 Fiery Software Manager 将不会运行。要查看受支持的操作系
统，请参阅 http://fiery.efi.com/cws-specifications。

Fiery Color Profiler Suite 和 Fiery Command WorkStation 6.3

Fiery Color Profiler Suite 5.0 (CPS) 和更早版本与适用于单张纸打印机的 Fiery Command WorkStation
Package 6.3(CWS) 不完全兼容。我们建议更新到 Fiery Color Profiler Suite 5.1。

当您将 CPS 5.0 与 CWS 6.3 搭配使用时，可能会遇到以下问题：

• 在 CPS 打开的情况下，如果在 CWS 中看到“将分光光度计连接到计算机”的消息，请关闭 CPS，然后单击
确定以继续。

• 在 Calibrator 中创建新的校准设定后，启动 CPS 的创建新的设定档按钮将隐藏。升级到 CPS 5.1 后即可
解决此问题。

注释：CWS 6.3 连接到带有 CPS 5.0 的 Fiery XF 服务器是受支持的配置。

升级 Fiery JobFlow 以与 Fiery Command WorkStation6.3 搭配使用

Fiery JobFlow 2.5 与 Fiery Command WorkStation Package 6.3 兼容。不支持更早版本的 Fiery JobFlow。

Fiery JobFlow 2.5 与 Fiery Command WorkStation 版本 5.8 至 6.2 向后兼容。但如果升级到 Fiery
Command WorkStation6.3，您也必须更新到 Fiery JobFlow 2.5。有关详细信息，请参阅 www.efi.com/
jobflow。

HiDPI 监视器支持

按照 Microsoft Windows 显示 > 缩放和布局设定，Fiery Command WorkStation6.3 完全支持 HiDPI 监视
器，因此字体和其他项目可以缩放到不同大小的整体显示分辨率。根据 Windows 中选择的缩放系数，应用程序
中的某些字体可能会稍微柔化或模糊。但可读性和功能不受影响。

已停用功能

Fiery Hot Folders 过滤器

以下版本不再支持 Fiery Hot Folders 转换：

• Fiery Graphic Arts Package, Premium Edition 和 Fiery Productivity Package 中附带的过滤器：
PDF2GO、ExportPS、CT-LW、DCS 2.0 和 TIFF-IT。

• 在 Fiery Hot Folders 中将 PDF 转换为 PS (PostScript) 的功能已停用，因为 Adobe PDF Print
Engine (APPE) 允许 Fiery server 本机处理和渲染 PDF 作业，而不需要将作业转换为 PostScript。
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Fiery Remote Scan TWAIN 插件

Fiery Remote Scan TWAIN 插件已停用，删除了直接将页面扫描至 Adobe Acrobat or Adobe Photoshop
等第三方应用程序的功能。但 Fiery Remote Scan 独立应用程序仍然完全支持通过计算机在支持的 Fiery
server 上检索扫描作业和自动同步扫描邮箱。

Fiery JobMaster 扫描

Fiery JobMaster 5.0（Fiery Command WorkStation Package6.3 中附带）不再支持 TWAIN 扫描驱动程
序。

Fiery JobMaster 5.0 增加了以下支持：

• WIA (Windows Image Acquisition) 驱动程序

• Mac ICA (Image Capture Application) 驱动程序

• Fiery Remote Scan 6.7 版插件（特定于 Fiery JobMaster 应用程序）

Fiery Software Manager 应用程序快捷方式

Fiery Software Manager 不会在 Windows 桌面或 macOS Dock 上创建应用程序快捷方式。但直接安装在
Fiery server 上的 Fiery Command WorkStation 将继续在 Windows 桌面上添加应用程序快捷方式。

修复了 Fiery Command WorkStation Packagev6.3.0.333 版本中的错误

对以下问题进行了修复：

Fiery Command WorkStation

• 在 Fiery Impose 和 Fiery 预览中打开某些 PDF 文件时, 不会再出现未处理的异常消息。

Fiery XF

• 如果在特殊设定窗口中禁用了创建 RTL 文件的 GIF 预览选项，则无法为设置用于 IP 打印的 VUTEk 32r
和 h3/h5 打印机创建 GIF 文件。

• 在 Color Tools 中选择校准设定时, 输出选项网点大小现在在 Epson SureColor S306X0 打印机上正确显
示为 Multi-strike。

• 保存到视觉印版补偿文件的色调值现在与 Fiery XF 6.5 中保存的色调值对应。

• 在 Color Tools 中优化特性档时, 优化按钮的位置现在保持静止。以前, 该按钮会随着每次迭代逐步向下
移动, 最终变得不可用。

修复了 Fiery Command WorkStation Packagev6.3.0.307 版本中的错误

对以下问题进行了修复：

Fiery Command WorkStation

• 当您以包含特殊字符和长度超过 10 个字符的密码作为管理员登录 Fiery server 时，您可以轻松访问纸张
目录、对齐纸盘和设备中心。

• 在 macOS 计算机上, 当您重新校准或使用 ES-1000 测量设备创建校准时，从 Fiery Command WorkStation
启动的 Fiery 校准器现在会发出蜂鸣音。
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• 在设备中心 > 资源 > 专色中拖放专色时，Fiery Command WorkStation 停止响应。

• 在某些情况下, 当您在 Fiery Preview、Fiery Impose、Fiery Compose 或 Fiery JobMaster 中打开作业
时，预览图像看起来会模糊不清。

Fiery XF

• Job Editor无法正确显示裁切标记的线条粗细。

• 在多页嵌套作业中，如果更改页面方向或页面之间的距离导致创建新的嵌入页，Job Editor将停止响应。

• 在某些情况下，由于 EFI 许可证管理器服务不可用，升级到 Fiery Command WorkStation 6.3 后的 Fiery
XF 服务器会无法启动。

修复了 Fiery Command WorkStation Packagev6.3.0.280 版本中的错误

对以下问题进行了修复：

Fiery Command WorkStation

• 在 Fiery server 具有大量 Paper Catalog 条目的情况下，如果 Fiery Ticker 正在运行，无法滚动所有
Paper Catalog 条目量将承印材料分配到纸盘。

• 如果将 Fiery Command WorkStation 设置为非英语，当您在作业日志中选择了某个范围的起始日期，即使作
业日志中的作业可用，也不会显示日志。

Fiery XF

• 选择任何 ISO 12647-7 控制栏时，已打印作业标签包含了实现 ISO 合规所需的所有信息。不能取消选择这
些设定。但是，如果需要，您可以在作业标签编辑器中选择其他设定。

• 如果 Fiery Command WorkStation 远程登录到 Fiery XF 服务器，则不可能在 Job Editor 中选择别名专
色。

• 现在您可以将剪切轮廓源和方法正确保存为预设。

• 如果选择了无边框打印，则假脱机作业失败，且报错为检测到无效的印张尺寸。

• 利用一些 Fiery Command WorkStation 和 Fiery XF 的组合，使用 Epson SpectroProofer ILS30 测量设
备在 Color Tools 中优化特性档时，M2 测量模式设定未保存。即使您选择了 M2 (UV 剪切)，结果也包括
UV，即测量模式 M1。

• 如果您尝试使用 M2 测量模式方法为 Epson SpectroProofer IL30 优化验证测量，则无法检测到任何改
善，因为 M2 测量未保存。

• 在 macOS 计算机上，通过单击作业中心中的列标题来排序作业时，Fiery Command WorkStation 停止响
应。

• 在 Color Tools > 通过测量重新校准中，在测量第一个图表后推荐遵循的步骤在某些语言中被截断。

• 使用双显示器，您现在可以在第二台显示器上重新启动 Color Tools 。以前，Color Tools总是在主显示
器上打开。

修复了 Fiery Command WorkStation Packagev6.3.0.271 版本中的错误

对以下问题进行了修复：
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Fiery Command WorkStation

• 打印专色样本时，未应用作业属性 > 图像选项卡中的某些设置。

Fiery XF

• 以前无法为 VUTEk 3r/5r/3r+/5r+ 打印机创建白色分隔符，因为“输出”文件夹中缺少白色分隔符。该问
题已在最新版本中解决。

• 在 Color Editor，必须在默认纸张大小上打印色板书。将无法再定义自定义纸张大小。

Fiery Command WorkStation Packagev6.3.0.259 版本中修复的错误

对以下问题进行了修复：

Fiery Command WorkStation

• 在 macOS 计算机上使用的语言为配置非英语的 Fiery 服务器，访问服务器 > 日志 > 打印 > 本地打印机
> 打印时，打开的打印对话框为英文。

• Fiery Hot Folders 预置不再包含 Fiery Impose 模板路径选择。而是使用与 Fiery Command WorkStation
相同的路径。

• Fiery 校准器启动和响应速度更快。

Fiery XF

• 在 Job Editor中，无法编辑缩放值以自定义裁切区域。

• 在 Color Tools > 创建校准 > 摘要中，您无法在特性档检查器中打开承印材料特性档，以将其色域与校准
文件进行比较。

• 如果操作系统设置为英文，则只能打印高级校准图表。

• 使用基于 IP 的 Barbieri Spectro LFP qb 测量设备创建校准文件，生成的错误 IT8 数据。因此，您无法
在 Color Tools > 创建校准 > 概要 > 特性档检查器中打开校准文件。

• 如果您使用内置测量设备在 Job Editor 中设置验证作业以测量动态楔形，Job Editor 在验证后显示不正
确的 delta E 结果。Verifier 和 Job Editor 现在都显示正确的 delta E 值。

• 当您修改任何 VUTEk 打印机 Color Tools > 创建校准 > 总墨水限制中的总墨水限值 (TIL) 时，Color
Tools 停止响应。

• 无法使用 ES-2000 测量设备来测量校准进程中的第一个图表

修复了 Fiery Command WorkStation Packagev6.3.0.234 版本中的错误

对以下问题进行了修复：

Fiery Command WorkStation

• 您无法在专色>作业属性中保存双面选项设定。

• 如果您在 Fiery 服务器重新校准之前访问校准器设置窗口，Fiery 校准器停止响应。

• 使用 EFI ES-2000 设备重新校准时，如果您选择了 51 随机色块集值，已打印的颜色板和 Fiery Command
WorkStation 显示的图表不匹配。

• 在校准器中，当您创建的校准时，在校准后生成 ACD 数据选项对受支持的打印机不可用。

客户发行说明
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Fiery XF

• 您现在可以在 Server Manager>印后处理>标记>剪切标记>轮廓剪切中保存 PDF 框设定。之前，仅可应用承
印材料框设定。

• 在配置打印机以打印到端口时，才可以设置连接到任何未使用 9100 端口的打印机。

• 在 macOS 计算机上，现在可以优化专色。之前，生成了一个错误的图表，导致重新执行失败。

修复了 Fiery Command WorkStation Package v6.3.0.216 版本中的错误

对以下问题进行了修复：

Fiery Command WorkStation

• 使用非英语语言配置的 Fiery 服务器，当您从保存在 Fiery 服务器上的作业中插入页面时，Fiery Impose
或 Fiery JobMaster 停止响应。

• 在 Fiery Impose 中，当您将作业另存为拼合的 pdf，输出时层或对象在 Acrobat 中标记为隐藏。

Fiery XF

• 缩放图像块色块标签现在单个瓷砖视图标签上正确显示。

• Color Tools 未显示逐列的校准测量数据和质量控制图表。

• 使用 i1 Pro2 测量设备以创建特性档时，无法检测设备。

• 将 L*a*b* 修正特性档 (*.3cc) 设置为无时，会有一条错误消息说明特性档是无效的。

• 在某些情况下，升级到 Fiery Command WorkStation 6.3 后的 Fiery XF 服务器会无法启动。

• 升级到 Fiery Command WorkStation 6.3 SP1 导致 C:\Program Data\Fiery\Fiery XF\Client\Working 文
件夹被删除。因此，所有之前保存到该文件夹的测量数据不再可用，导致创建了不正确的报告。

修复了 Fiery Command WorkStation Package 6.3.0.199 版本中的问题

对以下问题进行了修复：

Fiery Command WorkStation

• 由于纸张重量错误，您无法从热文件夹打印小册子装订作业。但是，可以从 Fiery Command WorkStation
打印这一作业而不会出现错误。

• 在日本语系统中，如果发送至热文件夹的 PDF 作业有一个作业预设和强制模板，则不处理这些作业。

• 如果 > Fiery Command WorkStation > 服务器 > 配置 > 作业管理中已经启用了处理时预览选项， 则在您
处理某些强制的作业时，Fiery Command WorkStation 和 Fiery 服务器都将停止响应。

• 如果您对某项作业应用了服务器预设，随后又通过从保留队列右键单击该作业，更改了该作业的服务器预
设，则 Fiery 服务器将停止响应。

客户发行说明
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Fiery XF

• 在 macOS 计算机上，如果 Fiery Command WorkStation 被配置为德语环境，则不保存 Job Editor > 输出
处理 > 标记 > 裁切标记中的裁切图像值。

• 您现在可以通过 USB 来配置连接到 Fiery 服务器计算机的打印机。之前，选择连接类型从端口打印时将显
示错误消息，指出所选的端口无效。

• 图块的最大重叠/胶区域设置为 3.939 英寸。已按客户要求增大此值。现在可以有超过 6 英寸的重叠/胶边
距。

Service Pack 1 (SP1) 中的已修复问题

HyperRIP 模式

连接至 Fiery server（FS200 或更新版本）并且将 HyperRIP 模式设为多个作业时，如果将作业发送至“处理
及保留”，则进度条可能不会显示。

Fiery Software Manager 未检测到 KB2999226 Windows 更新

Fiery Software Manager（状态机）版本 4.2.0.14 包含更高版本的 Fiery Command WorkStation 6.3 SP1
包，包括以下问题的补丁：状态机未检测到 KB2999226 Windows 更新，并错误地指出仍需要应用更新。应用更
新后，错误仍然存在，并在某些情况下阻止 CWS 6.3 安装。

客户发行说明

Fiery Command WorkStation Package，v6.3

62



使用上の注意
Fiery Command WorkStation Package v6.3

本書には、このリリースに関する重要な情報が含まれています。インストールを進める前に、すべてのユーザ
ーにこの情報を提供するようにしてください。

今回のリリースについて
今回のリリースには、次のアプリケーションが含まれています。

• Fiery Command WorkStation Package v6.3.0.333

• Fiery Command WorkStation v6.3.0.58

• Fiery Hot Folders v3.12.0.35

• Mac v4.2.0.16 用 Fiery Software Manager

• Windows v4.2.0.16 用 Fiery Software Manager

メモ：

このインストーラーは、既存の Fiery Command WorkStation Package または Fiery Extended Applications Package
を、Fiery Command WorkStation および Fiery Hot Folders を含む最新の Fiery Command WorkStation Package にア
ップグレードします。オプションで、Fiery Software Manager を使用して Fiery Remote Scan をインストールす
ることもできます。

Fiery Command WorkStation Package では、System 10/10e 以降を搭載した Fiery servers、Fiery proServer、および
Fiery XF 7.0 以降をサポートしています。次のサーバーには接続できません。

• Fiery System 9/9e Rel2 ソフトウェアを搭載した Fiery servers およびそれ以前のバージョン

• Fiery XF 6.x サーバーおよびそれ以前のサーバー

• Fiery Central サーバー

上記の製品にアクセスする必要がある場合は、アップグレードを行わないでください。Fiery Extended
Applications Package は、www.efi.com/cws で入手できます。サポートされているカット紙プリンターの一覧に
ついては、http://fiery.efi.com/CWS/supported-printers を参照してください。

技術仕様の詳細は、www.efi.com/cws を参照してください。

新機能

カット紙プリンター：http://fiery.efi.com/CWScutsheetWN

HTTP://WWW.EFI.COM/CWS
HTTP://FIERY.EFI.COM/CWS/SUPPORTED-PRINTERS
http://www.efi.com/cws
http://fiery.efi.com/CWScutsheetWN


ワイドプリンターおよびスーパーワイドプリンター： http://fiery.efi.com/CWSwideformatWN

64 ビットアプリケーション

Fiery Command WorkStation（CWS）6.3 は、macOS と Windows のどちらのプラットフォームにも対応したネイ
ティブ 64 ビットアプリケーションです。

32 ビットオペレーティングシステムは、CWS 6.3 ではサポートされていません。Fiery Software Manager が
Windows 7 32 ビットなどの 32 ビットオペレーティングシステム（OS）ですでに稼働している場合、CWS 6.3
パッケージのアップデート通知は表示されません。32 ビット OS でこのバージョンの Fiery Software Manager
を実行しようとすると、互換性エラーが表示され、Fiery Software Manager は実行されません。サポートされて
いるオペレーティングシステムについては、http://fiery.efi.com/cws-specifications を参照してください。

Fiery Color Profiler Suite と Fiery Command WorkStation 6.3

Fiery Color Profiler Suite（CPS）5.0 およびそれ以前のバージョンは、カット紙プリンター用の Fiery Command
WorkStation Package（CWS）6.3 と完全には互換性がありません。Fiery Color Profiler Suite 5.1 にアップデート
することをお勧めします。

CPS 5.0 と CWS 6.3 を併用する場合は、次の問題が発生する可能性があります。

• CPS が現在開いているときに「コンピューターに分光測色計を接続してください。」というメッセージが
CWS に表示された場合は、CPS を閉じ、OK をクリックして続行してください。

• Calibrator で新しいキャリブレーション設定を作成すると、CPS を起動するための新規プロファイル作成ボ
タンが非表示になります。この問題は、CPS 5.1 にアップグレードすると解決されます。

メモ：CPS 5.0 を使用している Fiery XF サーバーへの CWS 6.3 の接続はサポートされています。

Fiery Command WorkStation 6.3 で使用するための Fiery JobFlow のアップグレード

Fiery JobFlow 2.5 は Fiery Command WorkStation Package 6.3 と互換性があります。Fiery JobFlow の旧バージョ
ンはサポートされていません。

Fiery JobFlow 2.5 は Fiery Command WorkStation バージョン 5.8～6.2 との下位互換性があります。ただし、Fiery
Command WorkStation 6.3 にアップグレードする場合は、Fiery JobFlow もバージョン 2.5 にアップデートする必
要があります。詳しくは、www.efi.com/jobflow を参照してください。

HiDPI モニターのサポート

Fiery Command WorkStation 6.3 では、Microsoft Windows のディスプレイ > 拡大縮小とレイアウトの設定で指定
できる HiDPI モニターを完全にサポートしているので、フォントなどの項目を表示解像度の上限までさまざ
まなサイズで拡大/縮小することができます。Windows で選択した拡大縮小率によっては、アプリケーション
の一部のフォントが少しぼやけて表示される可能性があります。ただし、読みやすさと機能は影響を受けませ
ん。

廃止された機能

使用上の注意
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Fiery Hot Folders フィルター

以下は、Fiery Hot Folders による変換でサポートされなくなりました。

• Fiery Graphic Arts Package, Premium Edition と Fiery Productivity Package に含まれているフィルター：
PDF2GO、ExportPS、CT-LW、DCS 2.0、TIFF-IT

• Adobe PDF Print Engine（APPE）により、PostScript に変換しなくても Fiery server で PDF ジョブをネイ
ティブに処理およびレンダリングできるので、Fiery Hot Folders 内での PDF から PS（PostScript）への
変換は廃止されました。

Fiery Remote Scan TWAIN プラグイン

Fiery Remote Scan TWAIN プラグインは廃止され、Adobe Acrobat や Adobe Photoshop などのサードパーテ
ィアプリケーションにページを直接スキャンして取り込むことができなくなりました。それでも、Fiery
Remote Scan スタンドアロンアプリケーションを使用すれば、ユーザーのコンピューターで、サポートさ
れている Fiery server 上のスキャンメールボックスからスキャンジョブを取得したり、スキャンメールボ
ックスを自動的に同期させることが問題なくできます。

Fiery JobMaster スキャン

（Fiery Command WorkStation Package 6.3 に含まれている）Fiery JobMaster 5.0 では、TWAIN スキャンドラ
イバーをサポートしなくなりました。

Fiery JobMaster 5.0 では、新たに以下をサポートしています。

• WIA（Windows Image Acquisition）ドライバー

• Mac ICA（Image Capture Application）ドライバー

• Fiery Remote Scan バージョン 6.7 プラグイン（Fiery JobMaster アプリケーション専用）

Fiery Software Manager アプリケーションショートカット

Fiery Software Manager では、Windows デスクトップまたは macOS ドックにアプリケーションショートカ
ットを作成しません。ただし、Fiery Command WorkStation を Fiery server に直接インストールすると、
Windows デスクトップにアプリケーションショートカットが引き続き追加されます。

Fiery Command WorkStation Package v6.3.0.333 で修正された問題
次の問題が修正されました。

Fiery Command WorkStation

• Fiery Impose および Fiery Preview で特定の PDF ファイルを開くと、未処理のエラーメッセージが表示され
なくなります。

Fiery XF

• 特殊設定ウィンドウで RTL ファイルの GIF プレビューを作成オプションを無効にした状態で、ファイルを
印刷するようにプリンターを前もって設定した場合、IP 印刷がセットアップされた VUTEk 32r および
h3/h5 プリンターで GIF を作成できませんでした。

• Color Tools でキャリブレーション設定を選択すると、出力オプションのドットサイズが Epson SureColor
S306X0 プリンターのマルチストライクとして正しく表示されるようになりました。

使用上の注意
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• ビジュアル版補正ファイルに保存された色調値を、Fiery XF 6.5 に保存されている値と対応させました。

• Color Tools でプロファイルを最適化すると、最適化ボタンの位置が固定されたままになります。以前は、
反復が実行されるたびにボタンがウィンドウの下に徐々に移動し、最終的に使用できなくなっていました。

Fiery Command WorkStation Package v6.3.0.307 で修正された問題
次の問題が修正されました。

Fiery Command WorkStation

• 特殊文字を含んでいたり長さが 10 文字を超えるパスワードを使用して Fiery server にシステム管理者とし
てログインする場合、用紙カタログ、調整トレイ、デバイスセンターに容易にアクセスできるようになり
ました。

• macOS コンピューターでは、Fiery Calibrator を Fiery Command WorkStation から起動する場合、ES-1000 測
定デバイスを使用して再キャリブレートするかキャリブレーションを作成するとビープ音が鳴るようにな
りました。

• デバイスセンター > リソース > スポットカラーでスポットカラーをドラッグアンドドロップすると、
Fiery Command WorkStation の応答が停止していました。

• Fiery プレビュー、Fiery Impose、Fiery Compose、Fiery JobMaster のいずれかでジョブを開くと、プレビュ
ー画像がぼやけて表示されることがありました。

Fiery XF

• Job Editor でクロップマークの線の太さを正しく表示できませんでした。

• 複数ページネスティングジョブでは、ページの方向またはページ間の距離を変更した結果、新しいネステ
ィングページが作成されると、Job Editor の応答が停止することがありました。

• Fiery Command WorkStation 6.3 にアップグレードすると、EFI ライセンスマネージャサービスを利用できな
いため Fiery XF サーバーが起動しなくなることがありました。

Fiery Command WorkStation Package v6.3.0.280 で修正された問題
次の問題が修正されました。

Fiery Command WorkStation

• 多数の Paper Catalog エントリーのある Fiery server では、Fiery Ticker が実行されている場合、Paper Catalog
エントリーすべてをスクロールして用紙をトレイに割り当てられませんでした。

• Fiery Command WorkStation が英語以外の言語に設定されている場合、ジョブログで範囲の開始日を選択す
ると、ジョブログでジョブが使用可能であっても、ログが表示されませんでした。

Fiery XF

• ISO 12647-7 のコントロールバーを選択すると、ISO コンプライアンスの達成に必要なすべての情報が、印
刷されたジョブラベルに含まれます。これらの設定の選択は解除できません。ただし、必要に応じて、ジ
ョブラベルエディターで追加の設定を選択できます。

• Fiery Command WorkStation が Fiery XF サーバーにリモートからログオンしている場合、Job Editor でエイ
リアススポットカラーを選択できませんでした。

• カット輪郭のソースと方法をプリセットとして正しく保存できるようになりました。

使用上の注意
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• フチなし印刷が選択されている場合、スプール済みのジョブは、無効なシートサイズが検出されましたと
いうエラーにより失敗していました。

• Fiery Command WorkStation と Fiery XF の組み合わせを使用すると、Epson SpectroProofer ILS30 測定デバイ
スを使用して Color Tools のプロファイルを最適化したときに、M2 測定モード設定が保存されませんでし
た。M2（UV カット）を選択した場合でも、その結果（測定モード M1）に UV が含まれていました。

• Epson SpectroProofer IL30 の M2 測定モード方法を使用して検証測定を最適化しようとすると、M2 測定が
保存されていないために、改善が検出されませんでした。

• macOS コンピューターでは、ジョブセンターの列見出しをクリックしてジョブを並べ替えると、Fiery
Command WorkStation が応答を停止していました。

• Color Tools >測定による再キャリブレーションでは、最初のチャートの測定後、一部の言語で推奨手順が
切り捨てられていました。

• デュアルモニターを使用して、セカンダリーモニターで Color Tools を再起動できるようになりました。
以前は、 Color Tools は常にプライマリーモニターで開かれていました。

Fiery Command WorkStation Package v6.3.0.271 で修正された問題
次の問題が修正されました。

Fiery Command WorkStation

• スポットカラーサンプルを印刷したときに、[ジョブのプロパティ] > [画像] タブの一部の設定が適用され
ませんでした。

Fiery XF

• 出力フォルダにホワイトセパレーションが存在しなかったため、以前は VUTEk 3r/5r/3r+/5r+プリンターで
ホワイトセパレーションを作成できませんでした。この問題は最新のリリースで解決されています。

• Color Editor で、スウォッチブックはデフォルトの用紙サイズで印刷する必要があります。カスタム用紙
サイズを定義できなくなりました。

Fiery Command WorkStation Package v6.3.0.259 で修正される問題
次の問題が修正されました。

Fiery Command WorkStation

• macOS コンピューターで英語以外の言語で設定されている Fiery サーバーを使用している場合、サーバー
>ログ>印刷>ローカルプリンター>印刷にアクセスすると、開いた印刷ダイアログボックスが英語で表示さ
れていました。

• Fiery Hot Folders の環境設定で、Fiery Impose テンプレートパスの選択がなくなりました。代わりに、Fiery
Command WorkStation と同じパスを使用します。

• Fiery キャリブレーターをより迅速に起動して応答します。

Fiery XF

• Job Editor では、拡大縮小値を編集してクロップ領域をカスタマイズできませんでした。

• Color Tools>キャリブレーションを作成>概要では、Profile Inspector で用紙プロファイルを開いて、その
色域をキャリブレーションファイルの色域と比較することができませんでした。

使用上の注意
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• オペレーティングシステムが英語に設定されている場合、高度なキャリブレーションチャートの印刷のみ
行えます。

• IP 経由で Barbieri Spectro LFP qb 測定デバイスを使用して、キャリブレーションファイル作成すると、不正
な IT8 データが生成されていました。そのため、Color Tools>キャリブレーションを作成>概要>Profile
Inspector でキャリブレーションファイルを開くことができませんでした。

• Job Editor でジョブ確認を設定して、内蔵測定デバイスを使用してダイナミックウエッジを測定すると、
検証後に Job Editor で不正な delta E の結果が表示されていました。Verifier と Job Editor の両方で、正し
い delta E の値が表示されるようになりました。

• 任意の VUTEk プリンターの Color Tools>キャリブレーションを作成>インク全体の制限でインク全体の
制限（TIL）値を変更すると、Color Tools で応答が停止していました。

• ES-2000 測定装置を使用して、キャリブレーションプロセスで最初のチャートを測定できませんでした。

Fiery Command WorkStation Package v6.3.0.234 で修正される問題
次の問題が修正されました。

Fiery Command WorkStation

• 両面印刷オプション設定をスポットカラー>ジョブのプロパティで保存できませんでした。

• Fiery サーバーの再キャリブレーションを行う前に、キャリブレーター設定ウィンドウにアクセスすると、
Fiery キャリブレーターが応答を停止しました。

• EFI ES-2000 デバイスを使って再キャリブレーションを行っているときに、51 ランダムをパッチ設定値と
して選択すると、印刷されたカラー表と Fiery Command WorkStation に表示される表が一致しませんでし
た。

• キャリブレーターで、キャリブレーションを作成したときに、サポートされているプリンターでキャリブ
レーション後に ACD データを生成するオプションを使用できませんでした。

Fiery XF

• サーバーマネージャー>仕上げ>マーク>カットマーク>輪郭カットで PDF ボックス設定を保存できるよう
になりました。以前は、用紙ボックス設定のみ適用できました。

• ポート経由で印刷するようにプリンターを設定すると、ポート 9100 を使用していない任意のプリンターへ
の接続を設定できませんでした。

• macOS コンピューターで、スポットカラーを最適化できるようになりました。以前は、不正なチャートが
生成され、反復に失敗していました。

Fiery Command WorkStation Package v6.3.0.216 で修正される問題
次の問題が修正されました。

Fiery Command WorkStation

• 英語以外の言語で設定されている Fiery サーバーで、Fiery Impose または Fiery JobMaster に保存されている
ジョブからページを挿入すると、応答しなくなる。

• Fiery Impose で、フラット化された PDF としてジョブを保存したとき、Acrobat で非表示としてマークした
レイヤーまたはオブジェクトが出力される。

使用上の注意
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Fiery XF

• 単一タイル表示タブで、拡大縮小タイルのタイルラベルが正しく表示できるようになりました。

• Color Tools で、キャリブレーションおよび品質管理のグラフの行ごとの測定データが表示されない。

• i1 Pro2 測定デバイスを使用してプロファイルを作成する場合に、デバイスを検出できない。

• L*a*b 校正プロファイルをなしに設定すると、プロファイルが無効であるという間違ったエラーメッセー
ジが表示される。

• いくつかのケースで、Fiery Command WorkStation 6.3 にアップグレードした後に Fiery XF サーバーを起動
できなくなる。

• Fiery Command WorkStation6.3 SP1 にアップグレードすると、C:\Program Data\Fiery\Fiery XF\Client\Working
フォルダーが削除される。その結果、このフォルダーに保存されたすべての測定データが使用できなくな
り、不正レポート作成の原因となる。

Fiery Command WorkStation Package v6.3.0.199 で修正される問題
次の問題が修正されます。

Fiery Command WorkStation

• 用紙重量エラーのため Hot Folders から製本ステープルジョブを印刷できませんでした。ただし、同じジョ
ブを Fiery Command WorkStation からはエラーなしで印刷できました。

• 日本語のシステムで、Hot Folders に送信された PDF ジョブにジョブプリセットと Fiery Impose テンプレー
トがある場合は処理されませんでした。

• 処理中にプレビューオプションが >Fiery Command WorkStation > サーバー > 設定 > ジョブ管理で有効で
ある場合、Fiery Command WorkStation および Fiery サーバーはともに面付け済みのジョブを処理中に応答
を停止していました。

• ジョブにサーバープリセットを適用し、同ジョブのサーバープリセットを保留キューのジョブを右クリッ
クして変更した場合、Fiery サーバーが応答を停止していました。

Fiery XF

• MacOS コンピューターで、Fiery Command WorkStation がドイツ語に設定された場合、画像の切り取りの値
（Job Editor > 仕上げ > マーク > クロップマーク内）が保存されませんでした。

• USB 経由で Fiery サーバーコンピューターに接続されているプリンターを設定できるようになりました。
これまでは、ポート経由で印刷の接続タイプを選択すると、選択したポートが無効であることを示す誤っ
たメッセージが表示されていました。

• タイルの最大重複/接着領域が 3.939 インチ（≈10 cm）に設定されていました。カスタマーのご要望に応じ
て、この値を増加しました。6 インチ（≈15.24 cm）以上の重複/接着マージンが設定可能になりました。

Service Pack 1（SP1）で修正された問題

超高速 RIP モード

超高速 RIP モードが複数ジョブに設定されている FS200 以降の Fiery server に接続した場合は、ジョブを処理
後待機に送信したときに進行状況バーが表示されていないことがあります。

使用上の注意
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Fiery Software Manager が Windows アップデート KB2999226 を検出しない。

Fiery Command WorkStation 6.3 SP1 以降のバージョンのパッケージに含まれる Fiery Software Manager（FSM）
バージョン 4.2.0.14 には、次の問題の修正が含まれています。FSM が Windows アップデート KB2999226 を検
出せず、アップデートが必要という誤ったステートメントを表示する。アップデートを適用した後もエラーが
解決せず、CWS 6.3 をインストールできないことがある。

使用上の注意
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고객 릴리스 정보
Fiery Command WorkStation Package, v6.3

본 문서에는 이번 릴리스에 관한 중요 정보가 포함되어 있습니다. 설치를 계속하기 전에 이 정보를 모든 사용
자에게 제공하십시오.

본 릴리스에 대한 정보

이 릴리스에 포함되어 있는 어플리케이션은 다음과 같습니다.

• Fiery Command WorkStation Package v6.3.0.333

• Fiery Command WorkStation v6.3.0.58

• Fiery Hot Folders v3.12.0.35

• Mac v4.2.0.16용 Fiery Software Manager

• Windows v4.2.0.16용 Fiery Software Manager

참고:

이 설치 관리자는 기존의 Fiery Command WorkStation Package 또는 Fiery Extended Applications
Package를 Fiery Command WorkStation 및 Fiery Hot Folders가 포함된 최신 Fiery Command
WorkStation Package로 업그레이드합니다. 옵션으로, Fiery Software Manager을(를) 사용하여 Fiery
Remote Scan을 설치할 수 있습니다.

Fiery Command WorkStation Package은(는) 시스템 10/10e 이상을 실행하는 Fiery servers, Fiery
proServer, Fiery XF 7.0 이상을 지원합니다. 다음에는 연결되지 않습니다.

• Fiery System 9/9e Rel2 소프트웨어 및 이전 버전을 실행하는 Fiery servers

• Fiery XF 6.x 서버 및 이전 버전

• Fiery Central 서버

이러한 제품에 엑세스해야 하는 경우 업그레이드하지 마십시오. Fiery Extended Applications 패키지는 
www.efi.com/cws에서 계속 다운로드할 수 있습니다. 지원되는 컷 시트 프린터의 전체 목록은 http://
fiery.efi.com/CWS/supported-printers를 참조하십시오.

기술 사양에 대한 자세한 내용은 www.efi.com/cws를 참조하십시오.

새로운 기능

컷 시트 프린터: http://fiery.efi.com/CWScutsheetWN

HTTP://WWW.EFI.COM/CWS
HTTP://FIERY.EFI.COM/CWS/SUPPORTED-PRINTERS
HTTP://FIERY.EFI.COM/CWS/SUPPORTED-PRINTERS
http://www.efi.com/cws
http://fiery.efi.com/CWScutsheetWN


광폭 및 초광폭 프린터: http://fiery.efi.com/CWSwideformatWN

64비트 어플리케이션

Fiery Command WorkStation 6.3(CWS)은 macOS 및 Windows 플랫폼을 위한 네이티브 64비트 어플리케
이션입니다.

32비트 운영체제는 CWS 6.3에서 지원되지 않습니다. Fiery Software Manager가 Windows 7 32비트와 같
이 32비트 운영체제에서 이미 실행 중인 경우 CWS 6.3 패키지에 대한 업데이트 알림이 표시되지 않습니다.
32 비트 OS에서 이 버전의 Fiery Software Manager를 실행하려고 하면 호환성 오류가 표시되며 Fiery
Software Manager가 실행되지 않습니다. 지원되는 운영체제를 보려면 http://fiery.efi.com/cws-
specifications를 참조하십시오.

Fiery Color Profiler Suite 및 Fiery Command WorkStation 6.3

Fiery Color Profiler Suite 5.0(CPS) 및 이전 버전은 컷 시트 프린터용 Fiery Command WorkStation 패키
지 6.3(CWS)와 완벽하게 호환되지는 않습니다. Fiery Color Profiler Suite 5.1로 업데이트하는 것이 좋습니
다.

CWS 6.3를 CPS 5.0과 함께 사용하는 경우, 다음과 같은 문제가 발생할 수 있습니다.

• CPS가 현재 열려있는 동안 CWS에 "컴퓨터에 분광광도계 연결" 메시지가 표시되면 CPS를 닫고 확인을
클릭하여 계속합니다.

• 보정기에서 새 보정 설정을 만들고 나면, CPS를 시작하기 위한 새 프로필 생성 버튼이 숨겨집니다. CPS
5.1로 업그레이드한 후 이 문제가 해결되었습니다.

참고: CPS 5.0이 탑재된 Fiery XF 서버에 연결된 CWS 6.3는 지원되는 구성입니다.

Fiery Command WorkStation6.3에서 사용할 Fiery JobFlow 업그레이드

Fiery JobFlow 2.5는 Fiery Command WorkStation 패키지 6.3과 호환됩니다. Fiery JobFlow의 이전 버전
은 지원되지 않습니다.

Fiery JobFlow 2.5는 Fiery Command WorkStation 버전 5.8에서 6.2까지 이전 버전과 호환됩니다. 그러나
Fiery Command WorkStation6.3으로 업그레이드하는 경우에는 Fiery JobFlow 2.5로 업데이트해야 합니
다. 자세한 내용은 www.efi.com/jobflow를 참조하십시오.

HiDPI 모니터 지원

Microsoft Windows 디스플레이 > 배율 및 레이아웃 설정을 통해 Fiery Command WorkStation6.3이
HiDPI 모니터를 완벽하게 지원하므로 글꼴과 기타 항목을 전체 디스플레이 해상도로 확장할 수 있습니다. 어
플리케이션의 일부 글꼴은 Windows에서 선택한 배율 비율에 따라 약간 부드럽거나 또는 모호해질 수 있습
니다. 그러나 가독성과 기능은 영향을 받지 않습니다.

단종된 기능
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Fiery Hot Folders 필터

다음은 Fiery Hot Folders에서 더 이상 변환할 수 없습니다.

• Fiery Graphic Arts Package, Premium Edition, Fiery Productivity Package에 포함된 필터:
PDF2GO, ExportPS, CT-LW, DCS 2.0, TIFF-IT.

• Fiery server에서 Adobe PDF Print Engine(APPE)을 사용하면 PDF 작업을 PostScript로 변환하지
않고도 기본적으로 PDF 작업을 처리 및 렌더링할 수 있으므로 Fiery Hot Folders에서 PDF를
PS(PostScript)로의 변환이 중단되었습니다.

Fiery Remote Scan TWAIN 플러그 인

Fiery Remote Scan TWAIN 플러그인이 더 이상 사용되지 않으므로 Adobe Acrobat 또는 Adobe
Photoshop 같은 타사 어플리케이션으로 페이지를 직접 스캔할 수 있습니다. 그러나 Fiery Remote Scan
독립 실행형 어플리케이션은 컴퓨터의 Fiery server에서 검색 작업을 불러오고 검색 사서함을 자동으로
동기화하는 기능을 완전히 지원합니다.

Fiery JobMaster 스캔

Fiery JobMaster 5.0( Fiery Command WorkStation Package6.3 포함)은 더 이상 TWAIN 스캔 드라이
버를 지원하지 않습니다.

Fiery JobMaster 5.0에 다음 지원이 추가되었습니다:

• WIA (Windows Image Acquisition) 드라이버

• Mac ICA (Image Capture Application) 드라이버

• Fiery Remote Scan 버전 6.7 플러그인(Fiery JobMaster 어플리케이션 전용)

Fiery Software Manager 어플리케이션 단축키

Fiery Software Manager는 Windows 바탕 화면 또는 macOS Dock에 어플리케이션 바로 가기를 만들
지 않습니다. 그러나 Fiery Command WorkStation을 Fiery server에 바로 설치하면 Windows 바탕 화
면에 어플리케이션 바로가 기가 추가됩니다.

Fiery Command WorkStation Package v6.3.0.333에서 해결된 문제

다음과 같은 문제가 해결되었습니다.

Fiery Command WorkStation

• Fiery Impose 및 Fiery 미리 보기에서 특정 PDF 파일을 열면 처리되지 않은 예외 메시지가 더 이상 발생
하지 않습니다.

Fiery XF

• 특수 설정 창에서 RTL 파일의 GIF 미리 보기 생성 옵션을 비활성화한 상태로 파일을 인쇄하도록 프린터
가 이전에 구성되어 있는 경우, IP 인쇄용 VUTEk 32r 및 h3/h5 프린터를 위해 GIF를 생성할 수 없습니
다.

• Color Tools에서 보정 설정을 선택하는 경우 출력 옵션인 도트 크기가 이제 EPSON surecolor S306X0
프린터용 여러 번 인쇄로 올바르게 표시됩니다.
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• 시각적 판 보정 파일에 저장된 색조 값이 이제 Fiery XF 6.5에 저장된 것과 일치합니다.

• Color Tools에서 프로필를 최적화할 때 최적화 버튼의 위치가 이제 정적 상태로 유지됩니다. 이전에는 각
반복을 통해 버튼이 점차 창 아래로 이동해 결국 사용할 수 없게 되었습니다.

Fiery Command WorkStation Package v6.3.0.307에서 해결된 문제

다음과 같은 문제가 해결되었습니다.

Fiery Command WorkStation

• 이제 특수 문자가 포함되어 있고 길이가 10자를 초과하는 암호를 사용하여 관리자로 Fiery server에 로
그인하면 용지 카탈로그, 트레이 정렬, 장치 센터에 쉽게 액세스할 수 있습니다.

• MacOS 컴퓨터의 경우, Fiery Command WorkStation에서 실행한 Fiery 보정기가 재보정하거나
ES-1000 측정 장치로 보정을 생성할 때 지금부터 경고음을 냅니다.

• 장치 센터 > 리소스 > 별색에서 별색을 끌어다 놓으면 Fiery Command WorkStation이(가) 응답하지 않
습니다.

• 경우에 따라, Fiery 미리 보기, Fiery Impose, Fiery Compose 또는 Fiery JobMaster에서 작업을 열었
을 때 미리 보기 이미지가 흐리게 표시됩니다.

Fiery XF

• Job Editor에서 자르기 표시선 두께를 올바르게 표시할 수 없습니다.

• 다중 페이지 중첩 작업에서 페이지 방향이나 페이지 간 거리를 변경하여 새 중첩 페이지가 생성되는 경우
Job Editor가 응답하지 않습니다.

• 일부 경우에서 Fiery XF 서버가 EFI 라이선스 관리자를 사용할 수 없기 때문에 Fiery Command
WorkStation 6.3으로 업그레이드된 후 시작되지 않습니다.

Fiery Command WorkStation Package v6.3.0.280에서 해결된 문제

다음과 같은 문제가 해결되었습니다.

Fiery Command WorkStation

• Fiery server에서 Paper Catalog 항목 수가 많은 경우에는 트레이에 용지 할당을 위해 모든 Paper
Catalog 항목을 스크롤할 수 없었습니다.

• Fiery Command WorkStation을 영어 이외의 언어로 설정하면 작업 로그에서 범위의 시작 날짜를 선택
할 때 작업 로그에서 작업을 사용할 수 있었던 경우에도 로그가 표시되지 않습니다.

Fiery XF

• 어떠한 ISO 12647-7 컨트롤 바를 선택해도 인쇄된 작업 레이블에 ISO 준수를 달성하는 데 필요한 모든
정보가 포함됩니다. 이러한 설정은 선택 취소할 수 없습니다. 그러나 필요한 경우 작업 라벨 에디터에서
추가 설정을 선택할 수 있습니다.

• Fiery Command WorkStation이 Fiery XF 서버에 원격으로 로그온 한 경우에는 Job Editor에서 별칭 별
색을 선택할 수 없습니다.

• 이제 등위선 소스 및 방법을 프리셋으로 올바르게 잘라내기 저장할 수 있습니다.

• 경계선 없이 인쇄를 선택한 경우에는 잘못된 시트 크기 감지 오류로 인해 스풀링된 작업이 실패했습니다.
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• 일부 Fiery Command WorkStation 및 Fiery XF 조합에서, Color Tools에서 프로필를 최적화하기 위해
Epson SpectroProofer ILS30 측정 장치를 사용할 때 M2 측정 모드 설정이 저장되지 않았습니다.
M2(UV 잘라내기)를 선택한 경우에도 측정 모드 M1인 UV가 포함되었습니다.

• Epson SpectroProofer IL30에 대한 M2 측정 모드 방법을 사용하여 검증 측정을 최적화할 경우, M2 측
정이 저장되지 않았기 때문에 개선이 감지되지 않을 수 있습니다.

• MacOS 컴퓨터에서 작업 센터에서 열 제목을 클릭하여 작업을 정렬할 때 Fiery Command WorkStation
응답이 중지됩니다.

• Color Tools > 측정별 재보정에서 첫 번째 차트를 측정 한 후의 단계가 몇 가지 언어에서 잘려서 표시됩니
다.

• 듀얼 모니터를 사용하면 이제 보조 모니터에서 Color Tools를 다시 시작할 수 있습니다. 이전에는 Color
Tools가 항상 기본 모니터에서 열렸습니다.

Fiery Command WorkStation Package v6.3.0.271에서 해결된 문제

다음과 같은 문제가 해결되었습니다.

Fiery Command WorkStation

• 별색 샘플을 인쇄할 때 작업 속성 > 이미지 탭의 일부 설정이 적용되지 않았습니다.

Fiery XF

• 이전에는 출력 폴더에서 흰색 분리가 없었기 때문에 VUTEk 3r/5r/3r +/5r + 프린터에서 흰색 분판을
할 수 없었습니다. 이 문제는 최신 릴리스에서 해결되었습니다.

• Color Editor에서 견본 책은 기본 용지 크기로 인쇄해야 합니다. 더 이상 사용자 지정 용지 크기를 정의할
수 없습니다.

Fiery Command WorkStation Package v 6.3.0.259에서 해결된 문제

다음과 같은 문제가 해결되었습니다.

Fiery Command WorkStation

• macOS 컴퓨터에서 영어 이외의 언어로 구성된 Fiery 서버를 사용하는 경우, 서버 > 기록 > 인쇄 > 로컬
프린터 > 인쇄로 액세스하면 인쇄 대화 상자가 영어로 열립니다 .

• Fiery Hot Folders 환경설정에 더 이상 Fiery Impose 템플릿 경로 선택 항목이 없습니다. 대신에, Fiery
Command WorkStation와(과) 동일한 경로를 사용합니다.

• Fiery 보정기가 더 빠르게 시작되고 응답합니다.

Fiery XF

• Job Editor에서 크기 조정 값을 편집하여 자르기 영역을 사용자 지정할 수 없었습니다.

• Color Tools > 보정 생성 > 요약에서 용지 프로필을 Profile Inspector에서 열어서 색공간을 보정 파일의
색공간과 비교할 수 없었습니다.

• 운영 체제가 영어로 설정된 경우 고급 보정 차트만 인쇄할 수 있었습니다.

• 보정 파일을 생성하기 위해 IP를 통해 Barbieri Spectro LFP qb 측정 장치를 사용하면 잘못된 IT8 데이
터가 생성되었습니다. 따라서, Color Tools > 보정 생성 > 요약 > Profile Inspector에서 보정 파일을 열
수 없었습니다.
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• 내장된 측정 장치를 사용하여 동적 웨지를 측정하기 위해 Job Editor에서 확인 작업을 설정하는 경우, 확
인 후에 Job Editor에 잘못된 델타 E 결과가 표시되었습니다. 이제 Verifier와 Job Editor 모두 정확한 델
타 E 값을 표시합니다.

• VUTEk 프린터에 대해 Color Tools > 보정 생성 > 총 잉크 제한의 총 잉크 제한(TIL) 값을 수정하면
Color Tools가 응답을 중지했습니다.

• ES-2000 측정 장치를 사용하여 보정 프로세스에서 첫 번째 차트를 측정할 수 없었습니다.

Fiery Command WorkStation Package v6.3.0.234에서 해결된 문제

다음과 같은 문제가 해결되었습니다.

Fiery Command WorkStation

• 별색 > 작업 속성에서 양면 인쇄 옵션 설정을 저장할 수 없습니다.

• Fiery 서버를 다시 보정하기 전에 보정기 설정 창에 액세스하면 Fiery 보정기가 응답하지 않습니다.

• EFI ES-2000 장치를 사용하여 다시 보정할 때 51 랜덤을 패치 설정 값으로 선택하면 인쇄된 색상 차트
와 Fiery Command WorkStation에 표시된 차트가 일치하지 않았습니다.

• 보정기에서 보정을 생성할 때 보정 후 지원되는 프린터에서 ACD 데이터 생성 옵션을 사용할 수 없습니
다.

Fiery XF

• 이제 Server Manager > 마감 > 표시 > 절단 표시 > 등위선 절단에서 PDF 상자를 저장할 수 있습니다. 이
전에는 용지 상자 설정만 적용할 수 있었습니다.

• 포트로 인쇄하도록 프린터를 구성할 때 포트 9100을 사용하지 않는 프린터와는 연결을 설정할 수 없었습
니다.

• 이제 MacOS 컴퓨터에서 별색를 최적화할 수 있습니다. 이전에는 잘못된 차트가 생성되어 반복에 실패했
습니다.

Fiery Command WorkStation Package v6.3.0.216에서 해결된 문제

다음과 같은 문제가 해결되었습니다.

Fiery Command WorkStation

• 영어를 제외한 다른 언어에서 구성된 Fiery 서버에서, Fiery 서버에 저장된 작업에서 페이지를 삽입한 경
우 Fiery Impose 또는 Fiery JobMaster가 응답하지 않습니다.

• Fiery Impose에서 작업을 병합된 PDF로 저장하는 경우 Acrobat에서 숨겨진 것으로 표시된 레이어나 개
체가 출력에 나타납니다.

Fiery XF

• 크기 조정 타일의 타일 라벨이 이제 단일 타일 보기 탭에 올바르게 표시됩니다.

• Color Tools가 보정 및 품질 제어 차트에 행별로 측정 데이터를 표시하지 않습니다.

• i1 Pro2 측정 장치를 사용하여 프로필을 생성할 경우 장치가 감지되지 않습니다.

• L*a*b* 수정 프로필(*.3cc)을 없음으로 설정할 경우 프로필이 무효하다는 잘못된 오류 메시지가 표시됩
니다.
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• 일부 경우에서 Fiery XF 서버가 Fiery Command WorkStation 6.3으로 업그레이드된 후 시작되지 않습
니다.

• Fiery Command WorkStation 6.3 SP1으로 업그레이드하면 C:\Program Data\Fiery\Fiery XF
\Client\Working 폴더가 삭제됩니다. 따라서, 이전에 이 폴더에 저장한 모든 측정 데이터를 더 이상 사
용할 수 없어서 잘못된 보고서가 생성됩니다.

Fiery Command WorkStation Package v6.3.0.199 문제 해결

다음과 같은 문제가 해결 되었습니다.

Fiery Command WorkStation

• 용지 무게 오류로 인해 Hot Folders에서 소책자 스테이블 작업을 인쇄할 수 없습니다. Fiery Command
WorkStation에서는 동일한 작업을 오류 없이 인쇄할 수 있습니다.

• 일본어 시스템에서는, Hot Folders로 전송된 PDF 작업에 사전 설정 및 Impose 템플릿이 있는 경우 작업
이 처리되지 않았습니다.

• 처리 중 미리 보기 옵션이 다음에서 활성화 된 경우: > Fiery Command WorkStation > 서버 > 구성 > 작
업 관리 Fiery Command WorkStation 및 Fiery 서버 모두 사용자가 일부 부과된 작업을 처리하는 동안
응답을 중지합니다.

• 사용자가 작업에 서버 사전 설정을 적용하고 동일 작업의 서버 사전 설정을 보류 대기열에서 오른쪽 클릭
하여 변경하는 경우, Fiery 서버는 응답을 중지합니다.

Fiery XF

• MacOS 컴퓨터에서 Fiery Command WorkStation이 독일어로 구성된 경우, 이미지 잘라내기 값(Job
Editor > 마감 > 표시 > 자르기 표시)은 저장되지 않았습니다.

• 이제 USB를 통해 Fiery 서버 컴퓨터에 연결된 프린터를 구성할 수 있습니다. 기존에는 포트를 통한 인쇄
연결 유형을 선택하면 선택된 포트가 유효하지 않다는 잘못된 메시지가 표시되었습니다.

• 타일의 최대 겹침/접착 영역은 3.939인치로 설정되었습니다. 이 값은 고객의 요청에 따라 증가되었습니
다. 이제 겹침/접착 여백보다 6인치 넘게 사용할 수 있습니다.

서비스 팩 1(SP1) 문제 해결

HyperRIP 모드

버전이 FS200 이상이고 HyperRIP 모드가 복수 작업으로 설정된 Fiery server에 연결된 경우, 작업을 처리
후 보류로 보내면 진행 바가 표시되지 않을 수 있습니다.

Fiery Software Manager가 KB2999226 Windows 업데이트를 감지할 수 없습니다.

Fiery Command WorkStation 6.3 SP1 패키지에 포함된 Fiery Software Manager(FSM) 4.2.0.14는 FSM
이 KB2999226 Windows 업데이트를 인식하지 못하고 업데이트를 계속 적용해야 한다는 상태를 표시하는
오류를 해결합니다. 업데이트를 적용한 후에도 오류가 계속되며, 일부 경우에는 CWS 6.3이 설치되지 않습니
다.
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客戶版本資訊
Fiery Command WorkStation Package 版本 6.3

本文件包含有關此版本的重要資訊。在繼續安裝之前，請務必將這項資訊提供給所有使用者。

關於本版本
本版本包含以下應用程式：

• Fiery Command WorkStation Package v6.3.0.333

• Fiery Command WorkStation v6.3.0.58

• Fiery Hot Folders v3.12.0.35

• Fiery Software Manager v4.2.0.16 (Mac 版)

• Fiery Software Manager v4.2.0.16 (Windows 版)

附註：

此安裝程式會將任何現有的 Fiery Command WorkStation Package 或 Fiery Extended Applications Package
升級至最新版 Fiery Command WorkStation Package (包含 Fiery Command WorkStation 與 Fiery Hot
Folders)。您可以選擇使用 Fiery Software Manager 來安裝 Fiery Remote Scan。

Fiery Command WorkStation Package 支援 Fiery servers 執行系統 10/10e 和更新版本，以及 Fiery
proServer 及 Fiery XF 7.0 和更新版本。它將不會連線至：

• Fiery servers 執行 Fiery 系統 9/9e Rel2 軟體和先前版本

• Fiery XF 6.x 伺服器和更舊版本

• Fiery Central 伺服器

如果您存取這些產品，請勿升級。Fiery Extended Applications 套件仍可在 www.efi.com/cws 取得。如需完
整的受支援單頁印表機清單，請參閱 http://fiery.efi.com/CWS/supported-printers。

如需有關技術規格的更多資訊，請參閱 www.efi.com/cws。

新功能

單頁印表機：http://fiery.efi.com/CWScutsheetWN

寬幅和超寬幅印表機： http://fiery.efi.com/CWSwideformatWN

HTTP://WWW.EFI.COM/CWS
HTTP://FIERY.EFI.COM/CWS/SUPPORTED-PRINTERS
http://www.efi.com/cws
http://fiery.efi.com/CWScutsheetWN
http://fiery.efi.com/CWSwideformatWN


64 位元應用程式

Fiery Command WorkStation 6.3 (CWS) 是一款同時適用於 macOS 和 Windows 平台的原生 64 位元應用程
式。

CWS 6.3 不支援 32 位元作業系統。如果 Fiery Software Manager 已在 Windows 7 32 位等 32 位元作業系
統 (OS) 上執行，將不會顯示 CWS 6.3 套裝軟體的更新通知。如果嘗試在 32 位元作業系統上運行此版本的
Fiery Software Manager，將顯示相容性錯誤，並且 Fiery Software Manager 將不會執行。要檢視受支援的
作業系統，請參閱 http://fiery.efi.com/cws-specifications。

Fiery Color Profiler Suite 與 Fiery Command WorkStation 6.3

Fiery Color Profiler Suite 5.0 (CPS) 和較舊版本與適用於單頁印表機的 Fiery Command WorkStation
Package 6.3 (CWS) 不完全相容。建議您更新到 Fiery Color Profiler Suite 5.1。

當您將 CPS 5.0 與 CWS 6.3 搭配使用時，可能會遇到以下問題：

• 如果在 CPS 處於開啟的情況下，您在 CWS 中看到「將光譜儀連線到電腦」的訊息，請關閉 CPS，然後按一

下確定以繼續。

• 您在校正器中建立新的校正設定後，就會隱藏可啟動 CPS 的建立新設定檔按鈕。升級到 CPS 5.1 後，即可
解決此問題。

附註：CWS 6.3 連線到含有 CPS 5.0 的 Fiery XF 伺服器是支援的組態。

升級 Fiery JobFlow 以與 Fiery Command WorkStation6.3 搭配使用

Fiery JobFlow 2.5 與 Fiery Command WorkStation Package 6.3.相容。不支援更早版本的 Fiery JobFlow、

Fiery JobFlow 2.5 與 Fiery Command WorkStation 版本 5.8 至 6.2 回溯相容。但如果您升級到 Fiery
Command WorkStation6.3，也必須更新到 Fiery JobFlow 2.5。如需更多資訊，請參閱 www.efi.com/
jobflow。

HiDPI 顯示器支援

按照 Microsoft Windows 顯示 > 縮放和版面設定，Fiery Command WorkStation6.3 完全支援 HiDPI 顯示，
因此字型和其他項目可以縮放到不同大小的整體顯示解析度。根據 Windows 中選取的縮放係數，應用程式中的
某些字型可能會稍微柔化或模糊。但可讀性和功能不受影響。

已停用功能

Fiery Hot Folders 篩選器

以下版本不再支援 Fiery Hot Folders 轉換：

• Fiery Graphic Arts Package, Premium Edition 和 Fiery Productivity Package 內含的篩選器：
PDF2GO、ExportPS、CT-LW、DCS 2.0 和 TIFF-IT。

• Fiery Hot Folders 中將 PDF 轉換為 PS (PostScript) 的功能已停用，因為 Adobe PDF Print
Engine (APPE) 允許 Fiery server 以原生方式處理和上色 PDF 工作，而不需要將工作轉換為
PostScript。
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Fiery Remote Scan TWAIN 外掛程式

Fiery Remote Scan TWAIN 外掛程式已停用，刪除了直接將頁面掃描至 Adobe Acrobat or Adobe
Photoshop 等第三方應用程式的功能。但 Fiery Remote Scan 獨立應用程式仍然完全支援透過電腦在支援
的 Fiery server 上擷取掃描工作和自動同步掃描信箱。

Fiery JobMaster 掃描

Fiery JobMaster 5.0 (Fiery Command WorkStation Package6.3 中附帶) 不再支援 TWAIN 掃描驅動程
式。

Fiery JobMaster 5.0 新增了以下支援：

• WIA (Windows Image Acquisition) 驅動程式

• Mac ICA (Image Capture Application) 驅動程式

• Fiery Remote Scan 版本 6.7 外掛程式 (特定於 Fiery JobMaster 應用程式)

Fiery Software Manager 應用程式捷徑

Fiery Software Manager 不會在 Windows 桌面或 macOS Dock 上建立應用程式捷徑。但直接安裝在
Fiery server 上的 Fiery Command WorkStation 將繼續在 Windows 桌面上添加應用程式捷徑。

Fiery Command WorkStation Package v6.3.0.333 已修正的問題
已修正以下問題：

Fiery Command WorkStation

• 在 Fiery Impose 和 Fiery 預覽中，開啟某些 PDF 檔案時，不會再出現未處理的例外狀況訊息。

Fiery XF

• 如果先前設定印表機，在停用特殊設定視窗的建立 RTL 檔案的 GIF 預覽選項情況下列印檔案，無法為設定
用於 IP 列印 VUTEk 32r 和 h3/h5 印表機建立 GIF。

• 在 Color Tools 中選擇校正設定時，網點大小輸出選項現在可以正確顯示為 Epson SureColor S306X0 印

表機的列印多次。

• 儲存到視覺色板補償檔案的色調值現在對應到 Fiery XF 6.5 中儲存的色調值。

• 在 Color Tools 中最佳化設定檔時，最佳化按鈕的位置現在會保持靜止不動。該按鈕先前會隨著每次反覆
測量逐漸向下移動，最後變得無法使用。

Fiery Command WorkStation Packagev6.3.0.307 已修正的問題
已修正以下問題：
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Fiery Command WorkStation

• 當您以管理員身分，使用含有特殊字元且長度超過 10 個字元的密碼登入至 Fiery server 時，現在可以輕

鬆存取紙張型錄、對齊紙匣及裝置中心。

• 當您使用 ES-1000 量測裝置重新校正或建立校正時，在 macOS 電腦上從 Fiery Command WorkStation 啟
動 Fiery 校正器，現在會發出嗶聲。

• 當您在裝置中心 > 資源 > 特別色中拖放特別色時，Fiery Command WorkStation 會停止回應。

• 在某些情況下，當您在 Fiery 預覽、Fiery Impose、Fiery Compose 或 Fiery JobMaster 中開啟工作時，
預覽影像看起來會模糊不清。

Fiery XF

• Job Editor 無法正確顯示裁切標記的線條粗細。

• 在多頁合併列印工作中，如果變更頁面方向或頁面之間的距離造成建立新的合併列印頁，Job Editor 就會
停止回應。

• 在某些情況下，由於無法使用 EFI 授權管理員服務，升級至 Fiery Command WorkStation 6.3 之後，
Fiery XF 伺服器會無法啟動。

Fiery Command WorkStation Packagev6.3.0.280 已修正的問題
已修正以下問題：

Fiery Command WorkStation

• 在具有大量 Paper Catalog 項目的 Fiery server 上，如果 Fiery Ticker 正在執行，則無法捲動所有
Paper Catalog 項目，對紙匣指定底材。

• 如果將 Fiery Command WorkStation 設定為英文以外的語言，當您在工作記錄中選取某範圍的開始日期

時，即使工作記錄有工作，也不會顯示任何記錄。

Fiery XF

• 當您選取任何 ISO 12647-7 控制列時，列印的工作標籤會包含達到 ISO 合規性所需的所有資訊。您無法取

消選取這些設定。但若有必要，您可以在工作標籤編輯器中選取其他設定。

• 如果 Fiery Command WorkStation 從遠端登入 Fiery XF 伺服器，則無法在 Job Editor 中選取別名特別
色。

• 現在您可以將裁切輪廓來源和方法正確地儲存為預設值。

• 如果選取無邊框列印，則多工緩衝處理的工作會失敗，並發生檢測到無效的印張尺寸錯誤。

• 有部分為 Fiery Command WorkStation 與 Fiery XF 組合時，使用 Epson SpectroProofer ILS30 量測裝

置來將 Color Tools 的設定檔最佳化時，不會儲存 M2 量測模式設定。即使您選取 M2 (防紫外線)，結果
還是會包含紫外線，亦即量測模式 M1。

• 因為並未儲存 M2 量測值，如果您嘗試使用 Epson SpectroProofer IL30 的 M2 量測模式方法將驗證量測
值最佳化，並無法偵測到任何改善。

• 在 macOS 電腦上，按一下 Job Center 的欄標題來排序工作時，Fiery Command WorkStation 停止回應。

• 在 Color Tools > 使用量測值重新校正中，量測第一個色卡後，某些語言的建議執行步驟會遭截斷。

• 現在使用雙顯示器時，可以在次要顯示器上重新啟動 Color Tools。先前總會在主要顯示器上開啟 Color
Tools。

客戶版本資訊
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Fiery Command WorkStation Packagev6.3.0.271 已修正的問題
已修正以下問題：

Fiery Command WorkStation

• 列印特別色範例時，未應用工作屬性 > 圖像 索引標籤中的某些設定。

Fiery XF

• 以前無法為 VUTEk 3r/5r/3r+/5r+ 印表機建立白色的分隔符號，因為“輸出”資料夾中缺少白色的分隔符
號。該問題已在最新版本中解決。

• 在 Color Editor 中，必須在預設底材大小上列印樣本書。不再可能定義自訂的底材大小。

在 v6.3.0.259 Fiery Command WorkStation Package 中已修正的問題
已修正以下問題：

Fiery Command WorkStation

• 在 macOS 電腦使用配置英語以外的 Fiery 伺服器，當您存取伺服器>記錄>列印>本地印表機> 列印時，打

開的列印對話框為英文。

• Fiery Hot Folders 喜好設定不再包含 Fiery Impose 範本路徑選擇。而是使用與 Fiery Command
WorkStation 相同的路徑。

• Fiery 校正器啟動和回應速度更快。

Fiery XF

• 在 Job Editor 中，無法編輯縮放值以自訂裁切區域。

• 在 Color Tools >建立校正>摘要中，您無法在設定檔檢查器中開啟底材設定檔，以比較色域及其校正檔
案。

• 如果作業系统設定為英文，則只能列印高級校正圖表。

• 透過 IP 使用 Barbieri Spectro LFP 測量設備以建立由錯誤的 IT8 數據所生成的校正文件。因此，您無

法在 Color Tools>建立校正>摘要>設定檔檢查器中開啟校正檔案。

• 如果您在 Job Editor 中設置驗證工作，透過內建測量設備以測量動態楔型，驗證之後 Job Editor 會顯示不

正确的 delta E 结果。Verifier 和 Job Editor 現在都顯示正確的 delta E 值。

• 當您在 Color Tools > 建立校正 > 總墨水限制為任何 VUTEk 印表機修改了總墨水限制 (TIL)，Color
Tools 會停止回應。

• 無法使用 ES-2000 測量，來測量校正程序中的第一個圖表設備

Fiery Command WorkStation Packagev6.3.0.234 已修正的問題
已修正以下問題：
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Fiery Command WorkStation

• 您無法在特別色>工作屬性中，儲存雙面選項的設定。

• 如果您重新校正 Fiery 伺服器之後，存取 校正器設定 視窗的話，Fiery 校正器會停止回應。

• 當您重新校正使用 EFI ES-2000 裝置時，如果您選取 51 隨機當作色標設定值，列印的色彩色卡和圖表中
會在 Fiery Command WorkStation 顯示不相符。

• 在校正器，當您建立校正時，校正後產生 ACD 資料選項已不提供支援的印表機使用。

Fiery XF

• 您可以立即在 Server Manager >裝訂作業>標記>裁切標記> Contour 切割機中，儲存 PDF 方塊設定。先
前，只有底材方塊設定可供套用。

• 當您設定印表機列印至連接埠，您當時不使用連接埠 9100 的話，就不可能設定連線至任何印表機。

• 在 macOS 電腦上，可能是現在最佳化特別色。先前，不正確的色卡產生出來，造成項目反覆失敗。

修復的問題 Fiery Command WorkStation Packagev6.3.0.216
已修正以下問題：

Fiery Command WorkStation

• 使用 Fiery 伺服器「 設定 」 中的語言以外的英文，當您從工作儲存在 Fiery 伺服器的，Fiery Impose
或 Fiery JobMaster 插入頁面會停止回應。

• 在 Fiery Impose 中，當您的工作儲存為壓平 pdf，圖層與物件標示為隱藏在 Acrobat 內顯示，輸出。

Fiery XF

• 縮放底板的底板標籤會立即顯示正確單一底板檢視索引標籤上。

• 色彩工具不會顯示校正和品質控制圖表行的行量測資料。

• 若要建立設定檔，使用 i1 Pro2 量測裝置時, 可能無法偵測裝置。

• 當您將 L*a*b* 改正設定檔(*.3cc) 設定為無時，將會顯示提示設定檔無效的錯誤訊息。

• 在某些情況下，Fiery XF 伺服器會無法啟動後升級至 Fiery Command WorkStation 6.3。

• 升級至 Fiery Command WorkStation6.3 SP1 造成 C:\Program Data\Fiery\Fiery XF\Client\Working 資
料夾，以刪除。因此，所有量測資料先前已儲存至此資料夾已不再可用，並會建立不正確的報告。

Fiery Command WorkStation Packagev6.3.0.199 已修正的問題
已修正以下問題：

Fiery Command WorkStation

• 可能因為紙張重量錯誤而無法從 Hot Folders 列印手冊釘裝工作。然而，相同的工作可以從 Fiery
Command WorkStation 正確列印。

• 日語系統上如果工作有工作預設值和 Impose 範本，傳送至 Hot Folder 的 PDF 工作則未處理。
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• 如果 Fiery Command WorkStation > 伺服器 > Configure > 工作管理中已啟用處理時預覽選項，您處
理一些已落版的工作時，Fiery Command WorkStation 和 Fiery 伺服器都會停止回應。

• 如果已在工作中套用伺服器預設值，並變更相同工作的伺服器預設值（從已保留佇列以滑鼠右鍵按一下該工
作），Fiery 伺服器會停止回應。

Fiery XF

• 在 macOS 電腦上，如果 Fiery Command WorkStation 設定為德語 ，在 Job Editor > 裝訂作業 > 標記 >

裁切標記中不會儲存剪下影像的值。

• 您現在可以設定透過 USB 與 Fiery 伺服器電腦連線的印表機。先前，選取連線類型透過連接埠列印會顯示
所選連接埠無效的錯誤訊息。

• 並排中最大重疊/粘貼區域已設定為 3.939 英吋。此值已根據客戶的要求增加。您現在可以設定超過 6 英
吋的重疊/粘貼邊界。

Service Pack 1 (SP1) 中已修正的問題

HyperRIP 模式

當您連接的 Fiery server 為 FS200 或更新版本，並將 HyperRIP 模式設定為多個工作時，將工作傳送至
「處理並保留」時，可能不會顯示進度列。

Fiery Software Manager 偵測不到 KB2999226 Windows 更新檔

Fiery Command WorkStation Package 6.3 SP1 較新版本所含的 Fiery Software Manager (FSM) 版本
4.2.0.14 包含下列問題的修正程式：FSM 偵測不到 KB2999226 Windows 更新檔，並錯誤地指出仍需要套用更
新。套用更新之後，錯誤持續發生，並會在某些情況下禁止安裝 CWS 6.3。
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Примечания к выпуску для заказчика
Fiery Command WorkStation Package 6.3

Данный документ содержит важную информацию об этом выпуске. Обязательно предоставьте эту
информацию всем пользователям перед началом установки.

Об этом выпуске

В данный выпуск входят следующие приложения:

• Fiery Command WorkStation Package v6.3.0.333

• Fiery Command WorkStation v6.3.0.58

• Fiery Hot Folders v3.12.0.35

• Fiery Software Manager v4.2.0.16 для Mac

• Fiery Software Manager v4.2.0.16 для Windows

Примечание:

Эта программа установки обновит пакеты Fiery Command WorkStation Package и Fiery Extended Applications
Package до новейшей версии пакета Fiery Command WorkStation Package, содержащего Fiery Command
WorkStation и Fiery Hot Folders. При необходимости можно установить Fiery Remote Scan с помощью Fiery
Software Manager.
Fiery Command WorkStation Package поддерживает серверы Fiery servers, работающие под управлением
System 10/10e или более поздних версий, а также Fiery proServer и Fiery XF 7.0 или более поздних версий. Эта
версия не позволяет подключаться к следующим серверам.

• Серверы Fiery servers, работающие под управлением программного обеспечения Fiery System 9/9e Rel2 и
более ранних версий.

• Серверы Fiery XF 6.x и более ранние версии.

• Серверы Fiery Central.

Если вам необходим доступ к этим продуктам, не обновляйте версию. Пакет Fiery Extended Applications по-
прежнему доступен по адресу www.efi.com/cws. Полный список поддерживаемых листовых принтеров см. по
адресу http://fiery.efi.com/CWS/supported-printers.
Дополнительную информацию о технических характеристиках см. по адресу www.efi.com/cws.

HTTP://WWW.EFI.COM/CWS
HTTP://FIERY.EFI.COM/CWS/SUPPORTED-PRINTERS
http://www.efi.com/cws


Новые возможности

Листовые принтеры: http://fiery.efi.com/CWScutsheetWN
Широкоформатные и сверхширокоформатные принтеры: http://fiery.efi.com/CWSwideformatWN

64-разрядное приложение

Fiery Command WorkStation 6.3 (CWS) — это встроенное 64-разрядное приложение для платформ macOS и
Windows.
CWS 6.3 не поддерживает 32-разрядные операционные системы. Если программа Fiery Software Manager уже
запущена в 32-разрядной операционной системе, например в 32-разрядной версии Windows 7, в ней не будут
отображаться уведомления об обновлениях для пакета CWS 6.3. При попытке запустить эту версию Fiery
Software Manager в 32-разрядной ОС появится ошибка совместимости, и приложение Fiery Software Manager
не откроется. Список поддерживаемых операционных систем см. по адресу http://fiery.efi.com/cws-
specifications.

Fiery Color Profiler Suite и Fiery Command WorkStation 6.3

Fiery Color Profiler Suite 5.0 (CPS) и более ранние версии не полностью совместимы с пакетом Fiery Command
WorkStation Package 6.3 (CWS) для листовых принтеров. Рекомендуется обновить программу до версии Fiery
Color Profiler Suite 5.1.
При использовании CPS 5.0 с CWS 6.3 могут возникнуть следующие проблемы.

• Если в CWS появилось сообщение «Подключите спектрофотометр к компьютеру», когда открыта
программа CPS, закройте CPS и нажмите ОК, чтобы продолжить.

• После создания новой настройки калибровки в калибраторе кнопка Создать новый профиль для запуска
CPS не отображается. Для решения этой проблемы необходимо выполнить обновление до версии CPS 5.1.

Примечание: Пакет CWS 6.3, подключенный к серверам Fiery XF с помощью CPS 5.0, является
поддерживаемой конфигурацией.

Обновление Fiery JobFlow для использования с Fiery Command WorkStation6.3

Приложение Fiery JobFlow 2.5 совместимо с Fiery Command WorkStation Package 6.3. Предыдущие версии
Fiery JobFlow не поддерживаются.
Fiery JobFlow 2.5 поддерживает обратную совместимость с версиями Fiery Command WorkStation от 5.8 до 6.2.
Однако при обновлении Fiery Command WorkStation до версии 6.3 необходимо также обновить и Fiery
JobFlow до версии 2.5. Дополнительные сведения см. по адресу www.efi.com/jobflow.

Поддержка мониторов HiDPI

Fiery Command WorkStation6.3 полностью поддерживает мониторы HiDPI с учетом параметров,
установленных в разделе Microsoft Windows Дисплей > Масштаб и разметка. Таким образом, шрифты и
другие элементы можно масштабировать до другого размера, соответствующего разрешению экрана.
Некоторые шрифты в приложениях могут отображаться немного нечетко или размыто в зависимости от
коэффициента масштабирования, выбранного в Windows. Однако это не влияет на разборчивость и
функциональные возможности.
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Неподдерживаемые функции

Фильтры Fiery Hot Folders

Следующие фильтры больше не поддерживаются для преобразования с помощью Fiery Hot Folders.

• Фильтры, входящие в пакеты Fiery Graphic Arts Package, Premium Edition и Fiery Productivity Package:
PDF2GO, ExportPS, CT-LW, DCS 2.0 и TIFF-IT.

• Fiery Hot Folders больше не поддерживает преобразование из PDF в PS (PostScript), поскольку Adobe
PDF Print Engine (APPE) позволяет серверу Fiery server обрабатывать и визуализировать задания PDF
без необходимости их преобразовывать в PostScript.

Подключаемый модуль TWAIN для Fiery Remote Scan

Подключаемый модуль TWAIN для Fiery Remote Scan больше не поддерживается. Возможность
сканировать страницы напрямую в сторонние приложения, например Adobe Acrobat или Adobe
Photoshop, больше недоступна. Однако по-прежнему поддерживается отдельное приложение Fiery
Remote Scan, которое позволяет получать задания сканирования и выполнять автоматическую
синхронизацию почтовых ящиков для сканирования на поддерживаемом сервере Fiery server с
компьютером.

Сканирование в Fiery JobMaster

Fiery JobMaster 5.0 (входит в состав Fiery Command WorkStation Package6.3) больше не поддерживает
драйверы сканирования TWAIN.
В Fiery JobMaster 5.0 добавлена поддержка следующих компонентов.

• Драйверы WIA (служба загрузки изображений Windows)

• Драйверы Mac ICA (Image Capture Application)

• Подключаемый модуль Fiery Remote Scan версии 6.7 (для приложения Fiery JobMaster)

Ярлыки приложений Fiery Software Manager

Fiery Software Manager не создает ярлыки приложений на рабочем столе Windows и на панели macOS
Dock. Однако при установке Fiery Command WorkStation непосредственно на сервере Fiery server ярлыки
приложений по-прежнему будут добавляться на рабочий стол Windows.

Проблемы, исправленные в Fiery Command WorkStation Package v6.3.0.333

Были исправлены следующие проблемы.
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Fiery Command WorkStation

• Сообщение о необработанном исключении больше не возникает при открытии определенных файлов
PDF в приложениях Fiery Impose и Fiery Preview.

Fiery XF

• Невозможно было создать файлы GIF для принтеров VUTEk 32r и h3/h5, настроенных для IP-печати, если
принтер ранее был настроен на печать в файл с параметром Создать предварительное изображение GIF
для файлов RTL, отключенным в окне Специальные настройки.

• При выборе настроек калибровки в Color Tools выходной параметр Размер точки для принтеров Epson
SureColor S306X0 теперь корректно отображается как Многократная печать.

• Значения тонов, сохраненные в файлах визуальной компенсации клише, теперь соответствуют значениям,
сохраненным в Fiery XF 6.5.

• При оптимизации профиля в Color Tools положение кнопки Оптимизировать теперь остается
неизменным. Ранее кнопка постепенно перемещалась по окну с каждой итерацией и в итоге становилась
недоступной.

Проблемы, исправленные в Fiery Command WorkStation Package v6.3.0.307

Были исправлены следующие проблемы.
Fiery Command WorkStation

• Теперь можно легко получить доступ к функциям Каталог бумаги, Выровнять лоток и Центр устройств
при входе в серверы Fiery server в качестве администратора с паролем, содержащим специальные
символы и длиной более 10 символов.

• На компьютерах под управлением macOS калибратор Fiery, запущенный из Fiery Command WorkStation,
теперь издает звуковой сигнал при повторной калибровке или создании калибровки с измерительным
устройством ES-1000.

• При перетаскивании плашечных цветов в Центр устройств > Ресурсы > Плашечные цвета Fiery Command
WorkStation перестает отвечать.

• В некоторых случаях при открытии задания в приложении Fiery Preview, Fiery Impose, Fiery Compose или
Fiery JobMaster изображения в окне предварительного просмотра отображаются размытыми.

Fiery XF

• Толщина линий меток обрезки в Job Editor отображается неправильно.

• При обработке вложенного многостраничного задания приложение Job Editor перестает отвечать на
запросы, если изменение ориентации страницы или расстояния между страницами приводит к созданию
новой вложенной страницы.

• В некоторых случаях сервер Fiery XF не запускался после обновления до Fiery Command WorkStation 6.3.
Это было вызвано недоступностью службы EFI Менеджер лицензий.

Проблемы, исправленные в Fiery Command WorkStation Package v6.3.0.280

Были исправлены следующие проблемы.
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Fiery Command WorkStation

• Если было запущено приложение Fiery Ticker, то на сервере Fiery server с большим количеством записей
Paper Catalog невозможно прокрутить все записи Paper Catalog, чтобы назначить материал для печати
лотку.

• Если в Fiery Command WorkStation настроен язык, отличный от английского, то при выборе начальной
даты диапазона в разделе Журнал заданий не отображаются журналы, даже когда Журнал заданий
содержит доступные задания.

Fiery XF

• При выборе любой контрольной шкалы ISO 12647-7 напечатанная этикетка задания содержит всю
информацию, необходимую для обеспечения соответствия стандартам ISO. Эти настройки нельзя
отменить. Однако при необходимости можно выбрать дополнительные настройки в Редакторе этикеток
заданий.

• Невозможно было выбрать плашечный цвет с псевдонимом в Редакторе заданий, если не был выполнен
удаленный вход Fiery Command WorkStation на сервер Fiery XF.

• Теперь можно правильно сохранить методы и источники обрезки по контуру в качестве шаблона задания.

• При выборе параметра Печать без полей не удается поставить задание в очередь и отображается ошибка
Обнаружен недопустимый формат листа.

• При оптимизации профиля в Color Tools с помощью измерительного устройства Epson SpectroProofer
ILS30 и при использовании некоторых комбинаций Fiery Command WorkStation и Fiery XF значение
параметра режима измерения M2 не сохранялось. Даже если был выбран режим M2 (УФ-фильтр),
результат содержал УФ-излучение, допустимое в режиме измерения M1.

• При попытке оптимизировать проверочное измерение с использованием режима измерения M2 для
Epson SpectroProofer IL30 не удается обнаружить никаких улучшений, поскольку измерение M2 не было
сохраняется.

• На компьютерах под управлением macOS приложение Fiery Command WorkStation перестает отвечать на
запросы при попытке выполнить сортировку заданий, нажимая на заголовки столбцов в окне Центр
заданий.

• Описание рекомендуемых шагов, которые необходимо выполнить после измерения первой диаграммы в
Color Tools > Повторная калибровка с помощью измерения, на некоторых языках было сокращено.

• При использовании двух мониторов теперь можно перезапустить Color Tools на дополнительном
мониторе. Ранее приложение Color Tools всегда открывались только на основном мониторе.

Проблемы, исправленные в Fiery Command WorkStation Package v6.3.0.271

Были исправлены следующие проблемы.
Fiery Command WorkStation

• При печати образцов плашечных цветов не применялись некоторые настройки из Свойства задания >
вкладка Изображение.

Fiery XF

• Ранее невозможно было создать белые разделения для принтеров VUTEk 3r/5r/3r+/5r+, потому что белое
разделение отсутствовало в папке вывода. Проблема решена в последнем выпуске.

• В приложении Color Editor каталоги образцов должны печататься на материале с выбранным по
умолчанию форматом. Теперь невозможно использовать настраиваемый формат материала для печати.
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Проблемы, исправленные в Fiery Command WorkStation Package v6.3.0.259

Были исправлены следующие проблемы.
Fiery Command WorkStation

• Если на компьютере под управлением macOS для сервера Fiery был настроен другой язык, кроме
английского, при переходе в меню Сервер > Журналы > Печать > Локальный принтер > Печать,
диалоговое окно Печать открывалось на английском языке.

• На странице предпочтений Fiery Hot Folders больше недоступен выбор пути к шаблону Fiery Impose.
Вместо этого используется тот же путь, что и в Fiery Command WorkStation.

• Калибратор Fiery запускается и реагирует быстрее.

Fiery XF

• В редакторе Job Editor нельзя редактировать значения в поле Масштаб для настройки области
кадрирования.

• В меню Color Tools > Создать калибровку > Сводка невозможно открыть профиль материала для печати в
Profile Inspector , чтобы сравнить его цветовую гамму с содержимым файла калибровки.

• Если для операционной системы установлен английский язык, можно печатать только расширенные
диаграммы калибровки.

• При подключении измерительного устройства Barbieri Spectro LFP qb по протоколу IP для создания
файла калибровки создаются неправильные данные IT8. В результате невозможно открыть файл
калибровки в меню Color Tools > Создать калибровку > Сводка > Profile Inspector.

• Если в редакторе Job Editor настроена проверка заданий для измерения параметра Dynamic Wedge с
помощью встроенного измерительного устройства, после проверки Job Editor отображает неверные
результаты дельта E. Теперь оба инструмента Verifier и Job Editor отображают правильные значения
дельта E.

• Если в меню Color Tools > Создать калибровку > Максимальное общее количество краски любого
принтера VUTEk изменить значение максимального общего количества краски (TIL), инструмент Color
Tools переставал отвечать.

• Невозможно измерить первую диаграмму в процессе калибровки с помощью измерительного устройства
ES-2000

Проблемы, исправленные в Fiery Command WorkStation Package v6.3.0.234

Были исправлены следующие проблемы.
Fiery Command WorkStation

• Не удается сохранить значение параметра Двусторонняя в окне Плашечные цвета > Параметры задания.

• Если открыть окно Настройки калибратора перед повторной калибровкой сервера Fiery, приложение Fiery
Calibrator перестает отвечать на запросы.

• Если при выполнении калибровки с помощью устройства EFI ES-2000 для расположения зон выбрать
значение 51 случайная, напечатанная диаграмма цветов не совпадает с диаграммой, показанной в Fiery
Command WorkStation.

• После создания калибровки в приложении Calibrator параметр Создать данные ACD после калибровки
недоступен для поддерживаемых принтеров.
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Fiery XF

• Теперь можно сохранить настройки обрезки PDF в окне Server Manager > Заключительная обработка >
Метки > Метки обрезки > Обрезка по контуру. Ранее можно было применить только обрезку по размеру
материала для печати.

• При настройке принтера для печати в порт было невозможно настроить подключение к любому
принтеру, который не использует порт 9100.

• На компьютерах под управлением macOS теперь можно оптимизировать плашечные цвета. Ранее
создавалась неправильная диаграмма, которая приводила к сбою итерации.

Проблемы, исправленные в Fiery Command WorkStation Package v6.3.0.216

Были исправлены следующие проблемы.
Fiery Command WorkStation

• Если сервер Fiery настроен для работы на языке, отличном от английского, то при вставке страниц из
задания, сохраненного на сервере Fiery, приложения Fiery Impose и Fiery JobMaster переставали отвечать
на запросы.

• В Fiery Impose при сохранении задания в виде сведенного файла pdf на выходе появлялись слои или
объекты, помеченные как скрытые в Acrobat.

Fiery XF

• Ярлык маштабированных элементов мозаики на вкладке Представление отдельных элементов мозаики
теперь отображается правильно.

• Инструменты цвета не отображали построчные данные измерений для диаграмм калибровки и контроля
качества.

• При использовании измерительного устройства i1 Pro2 для создания профиля не удавалось обнаружить
устройство.

• При выборе значения Нет для профиля коррекции L*a*b* (*.3cc) появлялось некорректное сообщение об
ошибке, указывающее, что был выбран недопустимый профиль.

• В некоторых случаях сервер Fiery XF не запускался после обновления до Fiery Command WorkStation 6.3.

• Обновление до версии Fiery Command WorkStation 6.3 SP1 приводило к удалению папки C:\Program Data
\Fiery\Fiery XF\Client\Working. В результате все данные измерений, ранее сохраненные в этой папке,
становились недоступны, что приводило к созданию неправильных отчетов.

Проблемы, исправленные в Fiery Command WorkStation Package v6.3.0.199

Исправлены следующие проблемы:
Fiery Command WorkStation

• Задание сшивания брошюры не удавалось отправить на печать из Hot Folders из-за ошибки плотности
бумаги. Однако то же самое задание отправлялось на печать из Fiery Command WorkStation без
возникновения ошибки.

• В системах с японским языком задания PDF, отправленные в Hot Folder, не обрабатывались, если они
имели предустановку задания и шаблон Impose.
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• Если был включен параметр Preview While Processing (Предварительный просмотр во время обработки) в
меню > Fiery Command WorkStation > Server (Сервер) > Configure (Настроить) > Job Management
(Управление заданиями), то Fiery Command WorkStation и сервер Fiery Server переставали отвечать на
запросы во время обработки некоторых заданий Impose.

• При применении предустановок сервера Server Preset к заданию и изменении предустановок сервера
Server Preset для него же правым щелчком по заданию в очереди Held (Удержание) сервер Fiery Server
переставал отвечать на запросы.

Fiery XF

• На компьютерах с macOS при выборе немецкого языка для Fiery Command WorkStation переставали
сохраняться значения Cut image (Обрезка изображения) в Job Editor > Finishing (Финишная обработка) >
Marks (Отметки) > Crop Marks (Отметки обрезки).

• Теперь можно настраивать принтеры, подключенные по USB к компьютеру, на котором работает сервер
Fiery Server. Ранее при выборе типа подключения Print via port (Печать через порт) отображалось неверное
сообщение, в котором указывалось, что выбранный порт якобы является недопустимым.

• Для области перекрывания/проклеивания максимальное значение составляло 10 см. По просьбе
заказчиков это значение увеличено. Теперь поддерживаются области перекрывания/проклеивания
размером более 15 см.

Проблемы, исправленные в пакете обновления 1 (SP1)

Режим HyperRIP

Если при подключении к Fiery server версии FS200 или более поздней версии для параметра Режим HyperRIP
было выбрано значение Несколько заданий, индикатор хода выполнения может не отображаться при
отправке заданий в очередь «Обработать и отложить».

Fiery Software Managerне может обнаружить обновление Windows KB2999226

Fiery Software Manager (FSM) версии 4.2.0.14 входит в состав более поздних версий пакета Fiery Command
WorkStation 6.3 SP1 и содержит исправление следующей проблемы: FSM не может обнаружить обновление
Windows KB2999226 и ошибочно сообщает, что обновление все еще необходимо применить. После
применения обновления ошибка сохраняется и в некоторых случаях не позволяет выполнить установку CWS
6.3.
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Informacje o wersji dla klientów
Fiery Command WorkStation Package, wersja 6.3

Niniejszy dokument zawiera ważne informacje dotyczące tej wersji. Informacje te należy koniecznie przekazać
wszystkim użytkownikom przed kontynuowaniem instalacji.

Informacje dotyczące tej wersji

W tej wersji dostępne są następujące aplikacje:

• Fiery Command WorkStation Package wersja 6.3.0.333

• Fiery Command WorkStation wersja 6.3.0.58

• Fiery Hot Folders Wersja 3.12.0.35

• Fiery Software Manager wersja 4.2.0.16 dla komputerów Mac

• Fiery Software Manager wersja 4.2.0.16 dla systemu Windows

Uwaga:

Za pomocą tego instalatora można uaktualnić dowolny istniejący pakiet Fiery Command WorkStation Package lub
Fiery Extended Applications Package do najnowszej wersji pakietu Fiery Command WorkStation Package
zawierającej program Fiery Command WorkStation i aplikację Fiery Hot Folders. Można także zainstalować program
Fiery Remote Scan przy użyciu narzędzia Fiery Software Manager.
Fiery Command WorkStation Package obsługuje Fiery servers z zainstalowanym oprogramowaniem System 10/10e
lub nowszym, a także serwery Fiery proServer i Fiery XF 7.0 lub nowsze. Brak możliwości łączenia z serwerami:

• Fiery servers z zainstalowanym oprogramowaniem Fiery System 9/9e Rel2 i starszymi wersjami

• Serwery Fiery XF 6.x i wcześniejsze

• Serwery Fiery Central

Jeżeli musisz korzystać z tych produktów, nie dokonuj uaktualnienia. Pakiet Fiery Extended Applications jest nadal
dostępny na stronie www.efi.com/cws. Pełną listę obsługiwanych arkuszowych maszyn cyfrowych można znaleźć na
stronie http://fiery.efi.com/CWS/supported-printers.
Więcej informacji na temat specyfikacji technicznych można znaleźć na stronie www.efi.com/cws.

Co nowego?

Arkuszowe maszyny cyfrowe: http://fiery.efi.com/CWScutsheetWN

HTTP://WWW.EFI.COM/CWS
HTTP://FIERY.EFI.COM/CWS/SUPPORTED-PRINTERS
http://www.efi.com/cws
http://fiery.efi.com/CWScutsheetWN


Maszyny szerokoformatowe i superszerokoformatowe: http://fiery.efi.com/CWSwideformatWN

Aplikacja 64-bitowa

Fiery Command WorkStation 6.3 (CWS) jest natywną aplikacją 64-bitową dla systemów macOS i Windows.
32-bitowe systemy operacyjne nie są obsługiwane w wersji CWS 6.3. Jeśli program Fiery Software Manager działa w
systemie 32-bitowym, np. Windows 7 w wersji 32-bitowej, nie będą wyświetlane powiadomienia o aktualizacji
pakietu CWS 6.3. Jeśli użytkownik spróbuje uruchomić tę wersję programu Fiery Software Manager w systemie 32-
bitowym, zostanie wyświetlony błąd zgodności, a program Fiery Software Manager nie zostanie uruchomiony.
Informacje na temat obsługiwanych systemów operacyjnych można znaleźć pod adresem http://fiery.efi.com/cws-
specifications.

Fiery Color Profiler Suite i Fiery Command WorkStation 6.3

Pakiet Fiery Color Profiler Suite 5.0 (CPS) i starsze wersje nie są w pełni zgodne z oprogramowaniem Fiery
Command WorkStation Package 6.3 (CWS) dla arkuszowych maszyn cyfrowych. Zaleca się aktualizację do pakietu
Fiery Color Profiler Suite 5.1.
W przypadku korzystania z programu CPS 5.0 z programem CWS 6.3 mogą wystąpić następujące problemy:

• Jeśli w programie CWS jest wyświetlany komunikat „Podłącz spektrofotometr do komputera”, gdy pakiet CPS
jest otwarty, należy zamknąć pakiet CPS i kliknąć przycisk OK, aby kontynuować.

• Po utworzeniu nowego ustawienia kalibracji w narzędziu Kalibrator przycisk Utwórz nowy profil pozwalający
uruchomić pakiet CPS jest ukryty. Ten problem został rozwiązany po uaktualnieniu do wersji CPS 5.1.

Uwaga: Obsługiwana konfiguracja składa się z programu CWS 6.3 połączonego z serwerami Fiery XF z użyciem
programu CPS 5.0.

Modernizacja programu Fiery JobFlow w celu współpracy z oprogramowaniem Fiery
Command WorkStation6.3

Program Fiery JobFlow 2.5 jest zgodny z oprogramowaniem Fiery Command WorkStation Package 6.3. Starsze
wersje programu Fiery JobFlow nie są obsługiwane.
Program Fiery JobFlow 2.5 jest zgodny wstecznie z oprogramowaniem Fiery Command WorkStation w wersjach od
5.8 do 6.2. Jednak w przypadku modernizacji oprogramowania Fiery Command WorkStation6.3 należy również
wykonać aktualizację programu Fiery JobFlow do wersji 2.5. Więcej informacji można znaleźć pod adresem 
www.efi.com/jobflow.

Obsługa monitora HiDPI

Program Fiery Command WorkStation 6.3 w pełni obsługuje monitory HiDPI zgodnie z ustawieniami systemu
Microsoft Windows Ekran > Skala i układ, więc skalę czcionek i innych elementów można dostosować do ogólnej
rozdzielczości ekranu. Niektóre czcionki w aplikacji mogą się wydawać nieco rozmyte lub nieostre, co jest
uzależnione od współczynnika skalowania wybranego w systemie Windows. Nie ma to jednak wpływu na ich wygląd
ani działanie.

Funkcje niedostępne
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Filtry Fiery Hot Folders

Następujące pliki nie są już obsługiwane przez aplikację Fiery Hot Folders:

• Filtry zawarte w pakiecie Fiery Graphic Arts Package, Premium Edition i Fiery Productivity Package:
PDF2GO, ExportPS, CT-LW, DCS 2.0 i TIFF-IT.

• Konwersja z pliku PDF do PS (PostScript) w aplikacji Fiery Hot Folders nie jest już dostępna, ponieważ
mechanizm Adobe PDF Print Engine (APPE) pozwala na bezpośrednie przetwarzanie i renderowanie zadań
PDF na serwerach Fiery server bez konieczności konwertowania tych zadań do formatu PostScript.

Dodatek typu plug-in TWAIN Fiery Remote Scan

Dodatek typu plug-in TWAIN Fiery Remote Scan nie jest już dostępny, co spowodowało usunięcie możliwości
skanowania stron bezpośrednio do aplikacji innych firm, takich jak Adobe Acrobat lub Adobe Photoshop.
Jednak samodzielna aplikacja Fiery Remote Scan jest w pełni obsługiwana i umożliwia pobieranie zadań
skanowania i automatyczną synchronizację skrzynek pocztowych skanowania na obsługiwanych serwerach Fiery
server z użyciem komputera.

Skanowanie Fiery JobMaster

Program Fiery JobMaster 5.0 (zawarty w zestawie z pakietem Fiery Command WorkStation Package6.3) nie
obsługuje sterowników skanowania TWAIN.
W programie Fiery JobMaster 5.0 dodano obsługę:

• Sterowników WIA (Windows Image Acquisition)

• Sterowników Mac ICA (Image Capture Application)

• Dodatku typu plug-in Fiery Remote Scan w wersji 6.7 (dla aplikacji Fiery JobMaster )

Skróty aplikacji Fiery Software Manager

Program Fiery Software Manager nie umożliwia tworzenia skrótów aplikacji na pulpicie systemu Windows ani
na pasku Dock w systemie macOS. Jednak instalacje oprogramowania Fiery Command WorkStation wdrożone
bezpośrednio na serwerach Fiery server będą zawierały skróty aplikacji dodane na pulpicie w systemie Windows.

Problemy rozwiązane w programie Fiery Command WorkStation Package w wersji
6.3.0.333

Zostały rozwiązane następujące problemy:
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Fiery Command WorkStation

• Komunikat dotyczący nieobsługiwanego wyjątku nie jest już wyświetlany po otwarciu niektórych plików PDF w
aplikacjach Fiery Impose i Podgląd Fiery.

Fiery XF

• Tworzenie plików GIF dla maszyn drukarskich VUTEk 32r i h3/h5 skonfigurowanych do drukowania IP było
niemożliwe, jeśli maszyna drukarska została wcześniej skonfigurowana tak, aby drukowała do pliku, a opcja
Utwórz podgląd GIF plików RTL w oknie Ustawienia specjalne była wyłączona.

• Po wybraniu ustawień kalibracji w Color Toolsopcja Rozmiar punktu wydruku jest teraz poprawnie wyświetlana
jako Wiele przejść dla maszyn drukarskich Epson SureColor S306X0.

• Wartości tonalne zapisane w plikach kompensacji wizualnej płyty są teraz zgodne z wartościami zapisanymi w
Fiery XF 6.5.

• Podczas optymalizowania profilu w narzędziach Color Toolspołożenie przycisku Optymalizuj jest teraz stałe.
Poprzednio przycisk przesuwał się stopniowo w dół okna z każdą iteracją i ostatecznie stawał się niedostępny.

Problemy rozwiązane w programie Fiery Command WorkStation Package w wersji
6.3.0.307

Zostały rozwiązane następujące problemy:
Fiery Command WorkStation

• Teraz można łatwo uzyskać dostęp do opcji Wykaz papieru, Wyrównaj tacę i Centrum urządzeń po zalogowaniu
się na serwerze Fiery server jako administrator, używając hasła składającego się z ponad 10 znaków
i zawierającego znaki specjalne.

• Na komputerach z systemem macOS narzędzie Fiery Calibrator uruchomione z poziomu programu Fiery
Command WorkStation wydaje teraz sygnał dźwiękowy w przypadku tworzenia nowej lub zmiany istniejącej
kalibracji za pomocą urządzenia pomiarowego ES-1000.

• Po przeciągnięciu i upuszczeniu kolorów dodatkowych w Centrum urządzeń > Zasoby > Kolory dodatkowe
program Fiery Command WorkStation przestawał odpowiadać.

• W niektórych przypadkach po otwarciu zadania w aplikacji Podgląd Fiery, Fiery Impose, Fiery Compose lub Fiery
JobMaster podgląd zadania był rozmyty.

Fiery XF

• Job Editor nie był w stanie poprawnie wyświetlić grubości znaczników przycinania.

• W przypadku wielostronicowych zadań zagnieżdżonych Job Editor przestawał odpowiadać, gdy zmiana
orientacji strony lub odległości między stronami powodowała utworzenie nowej strony zagnieżdżonej.

• W niektórych przypadkach kontroler Fiery XF nie działał po uaktualnieniu oprogramowania Fiery Command
WorkStation do wersji 6.3 przez niedostępność usługi menedżera licencji EFI.

Problemy rozwiązane w programie Fiery Command WorkStation Package w wersji
6.3.0.280

Zostały rozwiązane następujące problemy:

Informacje o wersji dla klientów
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Fiery Command WorkStation

• Na serwerze Fiery server z dużą liczbą wpisów Paper Catalog nie można było przewijać wszystkich wpisów Paper
Catalog w celu przypisania nośników do kasety, jeśli uruchomiona była aplikacja Fiery Ticker.

• Przy ustawieniu dla Fiery Command WorkStation języka innego niż angielski po wybraniu daty początkowej
zakresu w dzienniku zadań nie były wyświetlane żadne dzienniki, mimo że zadania były dostępne w dzienniku
zadań.

Fiery XF

• Po wybraniu dowolnego paska kontrolnego ISO 12647-7 etykieta zadania druku zawiera wszystkie informacje
wymagane do osiągnięcia zgodności z normą ISO. Nie można usunąć zaznaczenia tych ustawień. Można jednak
wybrać dodatkowe ustawienia w Edytorze etykiet zadań, jeśli jest to wymagane.

• Wybranie aliasu koloru dodatkowego w programie Job Editor nie było możliwe, jeśli użytkownik Fiery Command
WorkStation zalogował się zdalnie do serwera Fiery XF.

• Teraz można poprawnie zapisywać źródła i metody wycinania konturów jako ustawienie wstępne.

• Jeżeli wybrano opcję Drukowanie bez obramowania, zbuforowane zadanie nie powiodło się z powodu błędu
Wykryto nieprawidłowy rozmiar arkusza.

• W przypadku niektórych kombinacji Fiery Command WorkStation i Fiery XFustawienie opcji Tryb pomiaru m2
nie zostało zapisane w przypadku korzystania z urządzenia do pomiaru ILS30 firmy Epson SpectroProofer w celu
zoptymalizowania profilu w Color Tools. Nawet w przypadku wybrania trybu M2 (przycięcie UV) wynik
obejmował utrwalanie UV, czyli tryb pomiaru M1.

• W przypadku próby zoptymalizowania pomiaru weryfikacyjnego za pomocą metody trybu pomiarowego M2 w
odniesieniu do urządzenia Epson SpectroProofer IL30 nie można było wykryć żadnej poprawy, ponieważ pomiar
M2 nie został zapisany.

• Na komputerach z systemem macOS Fiery Command WorkStation przestał odpowiadać podczas sortowania
zadań przez kliknięcie nagłówków kolumn w Centrum zadań.

• W narzędziu Color Tools > Ponowna kalibracja według pomiarów zalecane kroki, które należy wykonać po
dokonaniu pomiaru pierwszego wykresu, zostały skrócone w niektórych językach.

• W przypadku dwóch monitorów można teraz ponownie uruchomić Color Tools na monitorze pomocniczym.
Poprzednio moduł Color Tools był zawsze otwierany na monitorze podstawowym.

Problemy rozwiązane w programie Fiery Command WorkStation Package w wersji
6.3.0.271

Zostały rozwiązane następujące problemy:
Fiery Command WorkStation

• Podczas drukowania próbek kolorów dodatkowych niektóre ustawienia z karty Właściwości zadania > Obraz nie
były stosowane.

Fiery XF

• Wcześniej nie było możliwe utworzenie białych separacji dla drukarek VUTEk 3r/5r/3r+/5r+, ponieważ w
folderze wyjściowym brak było białej separacji. Problem został rozwiązany w najnowszej wersji.

• W Color Editor książki próbek muszą być drukowane na domyślnym rozmiarze nośnika. Nie jest już możliwe
zdefiniowanie niestandardowego rozmiaru nośnika.

Informacje o wersji dla klientów
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Problemy rozwiązane w programie Fiery Command WorkStation Package w wersji
6.3.0.259

Zostały rozwiązane następujące problemy:
Fiery Command WorkStation

• Po skonfigurowaniu serwera Fiery w języku innym niż angielski na komputerze z systemem macOS kliknięcie
opcji Serwer > Dzienniki > Drukowanie > Drukarka lokalna > Drukowanie powodowało wyświetlanie okna
dialogowego Drukowanie w języku angielskim.

• Preferencje aplikacji Fiery Hot Folders nie zawierają już wyboru ścieżki szablonu Fiery Impose. Zamiast tego
używana jest ta sama ścieżka co Fiery Command WorkStation.

• Kalibrator Fiery uruchamia się i reaguje szybciej.

Fiery XF

• W aplikacji Job Editornie można było edytować wartości skalowania w celu dostosowania obszaru kadrowania.

• Po kliknięciu opcji Color Tools > Utwórz kalibrację > Podsumowanie nie można było otworzyć profilu nośnika w
programie Profile Inspector, aby porównać jego gamę kolorystyczną z plikiem kalibracji.

• Można było drukować zaawansowane wykresy kalibracji tylko jeżeli językiem systemu operacyjnego był angielski.

• Korzystanie z przyrządu pomiarowego Barbieri spectro LFP qb za pomocą połączenia IP w celu utworzenia pliku
kalibracji powodowało generowanie nieprawidłowych danych IT8. W rezultacie nie można było otworzyć pliku
kalibracji po kliknięciu opcji Color Tools > Utwórz kalibrację > Podsumowanie > Profile Inspector.

• W przypadku skonfigurowania zadania weryfikacji w aplikacji Job Editor w celu zmierzenia ustawienia Dynamic
Wedge za pomocą wbudowanego urządzenia pomiarowego aplikacja Job Editor wyświetlała nieprawidłowe
wartości Delta E po zakończeniu weryfikacji. Verifier i Job Editor wyświetlają teraz prawidłowe wartości Delta E.

• Po zmodyfikowaniu wartości całkowitego limitu tuszu (TIL) w menu Color Tools > Utwórz kalibrację > Całkowity
limitu tuszu dla dowolnej drukarki VUTEk aplikacja Color Tools przestawała odpowiadać.

• Nie można było zmierzyć pierwszego wykresu w procesie kalibracji za pomocą urządzenia pomiarowego ES-2000

Problemy rozwiązane w programie Fiery Command WorkStation Package w wersji
6.3.0.234

Zostały rozwiązane następujące problemy:
Fiery Command WorkStation

• Nie można było zapisać ustawienia opcji drukowania dwustronnego w obszarze Kolory dodatkowe >
Właściwości zadania.

• W przypadku dostępu do okna Ustawień programu Kalibrator przed ponowną kalibracją serwera Fiery Kalibrator
Fiery przestawał odpowiadać.

• Podczas ponownej kalibracji za pomocą urządzenia EFI ES-2000, jeżeli jako wartość zestawu pól kontrolnych
wybrano 51 random, wydrukowane tablice kolorów oraz tablice wyświetlane w Fiery Command WorkStation nie
były zgodne.

• Podczas tworzenia kalibracji w programie Kalibrator opcja Generowanie danych ACD po kalibracji nie była
dostępna dla obsługiwanych drukarek.

Informacje o wersji dla klientów
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Fiery XF

• Można teraz zapisać ustawienia pól PDF w programie Server Manager > Wykończenie > Znaczniki > Znaczniki
cięcia > Kontury cięcia. Wcześniej można było używać tylko ustawienia pola nośnika.

• Podczas konfigurowania drukarki tak, aby drukowała do portu, nie było możliwe skonfigurowanie połączenia z
drukarką, która nie korzystała z portu 9100.

• Na komputerach z systemem macOS możliwa jest teraz optymalizacja kolorów dodatkowych. Dotychczas
generowana była nieprawidłowa tablica, co skutkowało niepowodzeniem interacji.

Problemy rozwiązane w programie Fiery Command WorkStation Package w wersji
6.3.0.216

Zostały rozwiązane następujące problemy:
Fiery Command WorkStation

• Jeśli kontroler Fiery był skonfigurowany w języku innym niż angielski i wstawiono strony z zadania zapisanego na
kontrolerze Fiery, aplikacja Fiery Impose lub Fiery JobMaster przestawała odpowiadać.

• Jeśli w aplikacji Fiery Impose zadanie zostało zapisane jako spłaszczony plik PDF, warstwy lub obiekty oznaczone
w programie Acrobat jako ukryte pojawiały się na wydruku.

Fiery XF

• Etykieta kafelka w przypadku kafelków skalowanych jest obecnie wyświetlana prawidłowo na karcie Widok
pojedynczego kafelka

• W narzędziach Color Tools nie były wyświetlane dane pomiarowe z poszczególnych wierszy dla tabel kalibracji i
kontroli jakości.

• Podczas tworzenia profilu za pomocą urządzenia pomiarowego Pro2 i1 nie można było wykryć urządzenia.

• Po ustawieniu dla profilu korekcji L*a*b* (*.3cc) wartości Brak był wyświetlany nieodpowiedni komunikat o
błędzie informujący o tym, że profil jest nieprawidłowy.

• W niektórych przypadkach kontroler Fiery XF nie działał po uaktualnieniu oprogramowania Fiery Command
WorkStation do wersji 6.3.

• Uaktualnienie programu Fiery Command WorkStation do wersji 6.3 SP1 powodowało usunięcie folderu C:
\Program Data\Fiery\Fiery XF\Client\Working. W rezultacie wszystkie dane pomiarowe poprzednio zapisane w
tym folderze nie były już dostępne, co powodowało tworzenie nieprawidłowych raportów.

Problemy rozwiązane w Fiery Command WorkStation Package w wersji 6.3.0.199

Zostały rozwiązane następujące problemy:
Fiery Command WorkStation

• Nie udało się wykonać zadania druku stosu broszur z Hot Folders z powodu błędu gramatury papieru. Jednakże
takie samo zadanie druku można wykonać z Fiery Command WorkStation bez komunikatu o błędzie.

• W systemie języka japońskiego zadania PDF przesłane do Hot Folder nie zostały przetworzone, jeśli zadania te
posiadały ustawienia wstępne i szablon z impozycją.

Informacje o wersji dla klientów
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• Jeśli opcja podglądu podczas przetwarzania była włączona w > Fiery Command WorkStation > Serwer >
Konfiguracja > Zarządzanie zadaniami, zarówno Fiery Command WorkStation, jak i serwer Fiery przestaną
odpowiadać podczas przetwarzania niektórych zadań z impozycją.

• Po zastosowaniu ustawień wstępnych serwera do zadania i dokonaniu zmiany ustawień wstępnych serwera dla
tego samego zadania, klikając prawym przyciskiem myszy zadanie z kolejki wstrzymanych, serwer Fiery
przestanie odpowiadać.

Fiery XF

• Na komputerach z systemem macOS, jeśli Fiery Command WorkStation została skonfigurowana w języku
niemieckim wartości przycinania obrazu w Job Editor > Wykończenie > Znaczniki > Znaczniki przycięcia nie
zostały zapisane.

• Teraz można skonfigurować drukarki, które są podłączone do komputera będącego serwerem Fiery za
pośrednictwem portu USB. Wcześniej wybranie typ połączenia drukuj za pośrednictwem portu powodowało
wyświetlenie komunikatu o nieprawidłowości, który oznaczał, że wybrany port był nieprawidłowy.

• Obszar maksymalny powierzchni zachodzenia/klejenia dla kafelków był ustawiony na 3,939 cale. Wartość ta
została zwiększona zgodnie z żądaniem klienta. Możliwe są teraz marginesy zachodzenia/klejenia większe niż 6
cali.

Problemy rozwiązane w dodatku Service Pack 1 (SP1)

Tryb HyperRIP

Po nawiązaniu połączenia z serwerem Fiery server w wersji FS200 lub nowszej z trybem HyperRIP ustawionym na
wiele zadań i wysłaniu zadań do kolejki Przetwórz i wstrzymaj pasek postępu może nie być wyświetlany.

Program Fiery Software Manager nie wykrywa aktualizacji KB2999226 systemu Windows

Program Fiery Software Manager (FSM) w wersji 4.2.0.14 zawarty w późniejszych wersjach pakietu Fiery Command
WorkStation 6.3 SP1 obejmuje poprawkę następującego błędu: program FSM nie wykrywa aktualizacji KB2999226
systemu Windows i błędnie informuje, że trzeba zastosować tę aktualizację. Po zastosowaniu aktualizacji błąd nadal
występuje, a w niektórych przypadkach uniemożliwia zainstalowanie programu CWS 6.3.

Informacje o wersji dla klientów
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Müşteri sürüm notları
Fiery Command WorkStation Package, v6.3

Bu belge, sürüm hakkında önemli bilgiler içermektedir. Yükleme işlemine devam etmeden önce tüm kullanıcılara bu
bilgileri sağladığınızdan emin olun.

Bu sürüm hakkında

Aşağıdaki uygulamalar bu sürüme dahil edilmiştir:

• Fiery Command WorkStation Package v6.3.0.333

• Fiery Command WorkStation v6.3.0.58

• Fiery Hot Folders v3.12.0.35

• Mac v4.2.0.16 için Fiery Software Manager

• Windows v4.2.0.16 için Fiery Software Manager

Not:

Bu yükleyici, tüm mevcut Fiery Command WorkStation Package veya Fiery Extended Applications Package'ı Fiery
Command WorkStation ve Fiery Hot Folders ögelerini içeren en son Fiery Command WorkStation Package ögesine
yükseltir. İsteğe bağlı olarak, Fiery Software Manager ögesini kullanarak Fiery Remote Scan'i yükleyebilirsiniz.
Fiery Command WorkStation Package, System 10/10e veya üstünü çalıştıran Fiery servers ögesini ve Fiery proServer
ve Fiery XF 7.0 ve üstünü destekler. Aşağıdakilere bağlanmaz:

• Fiery System 9/9e Rel2 yazılımı ve önceki sürümleri çalıştıran Fiery servers

• Fiery XF 6.x sunucuları ve daha önceki sürümleri

• Fiery Central sunucuları

Bu ürünlere erişmeniz gerekiyorsa, yükseltmeyin. Fiery Extended Applications Paket hala www.efi.com/cws
adresinde mevcuttur. Desteklenen tüm kesilmiş yaprak baskı makinelerinin bir listesi için bkz. http://
fiery.efi.com/CWS/supported-printers.
Teknik özellikler hakkında daha fazla bilgi için www.efi.com/cws adresini ziyaret edin.

Yenilikler

Kesilmiş yaprak baskı makineleri: http://fiery.efi.com/CWScutsheetWN
Geniş ve süper geniş yazıcılar: http://fiery.efi.com/CWSwideformatWN

HTTP://WWW.EFI.COM/CWS
HTTP://FIERY.EFI.COM/CWS/SUPPORTED-PRINTERS
HTTP://FIERY.EFI.COM/CWS/SUPPORTED-PRINTERS
http://www.efi.com/cws
http://fiery.efi.com/CWScutsheetWN
http://fiery.efi.com/CWSwideformatWN


64 bit uygulama

Fiery Command WorkStation 6.3 (CWS), hem macOS hem de Windows platformlarında kullanılan yerel bir 64 bit
uygulamadır.
32 bit işletim sistemlerinde CWS 6.3 desteklenmez. Fiery Software Manager Windows 7 32 bit gibi 32 bitlik bir
işletim sisteminde çalışıyorsa, CWS 6.3 paketi için güncelleme bildirimlerini görüntülemez. Bu Fiery Software
Manager sürümünü 32 bit işletim sisteminde çalıştırmayı denerseniz bir uyumluluk hatası alırsınız ve Fiery Software
Manager çalışmaz. Desteklenen işletim sistemlerini görüntülemek için bkz. http://fiery.efi.com/cws-specifications.

Fiery Color Profiler Suite ve Fiery Command WorkStation 6.3

Fiery Color Profiler Suite 5.0 (CPS) ve ve önceki sürümler, kesilmiş yaprak baskı makineleri için Fiery Command
WorkStation Package 6.3 (CWS) ile tam olarak uyumlu değildir. Fiery Color Profiler Suite 5.1'e güncellemenizi
öneririz.
CPS 5.0'ı CWS 6.3 ile kullanırken aşağıdaki sorunlarla karşılaşabilirsiniz:

• CPS açıkken CWS'de "Spektrofotometreyi bilgisayarınıza bağlayın" mesajını görürseniz, CPS'yi kapatın ve devam
etmek için Tamam'a tıklayın.

• Kalibratör'de yeni bir kalibrasyon ayarı oluşturduktan sonra CPS'yi başlatmak için kullanılan Yeni profil oluştur
düğmesi gizlenir. CPS 5.1'e yükselttikten sonra bu sorun giderilmiştir.

Not: CPS 5.0 ile Fiery XF sunucularına bağlı bir CWS 6.3, desteklenen bir yapılandırmadır.

Fiery Command WorkStation6.3 ile kullanım için Fiery JobFlow öğesini yükseltme

Fiery JobFlow 2.5, Fiery Command WorkStation Package 6.3ile uyumludur. Önceki Fiery JobFlow sürümleri
desteklenmez.
Fiery JobFlow 2.5, Fiery Command WorkStation 5.8 ila 6.2 sürümleri ile geriye dönük uyumluluğa sahiptir. Ancak
Fiery Command WorkStation6.3sürümüne yükseltirseniz, Fiery JobFlow 2.5'e de güncellemelisiniz. Daha fazla bilgi
için bkz. www.efi.com/jobflow.

HiDPI monitör desteği

Fiery Command WorkStation 6.3uygulaması Microsoft Windows Görüntü > Ölçek ve düzen ayarlarını izleyerek
HiDPI monitörlerini tam olarak destekler, böylece yazı tipleri genel ekran çözünürlüğüne göre farklı bir boyutta
ölçeklenebilir. Uygulamadaki bazı yazı tipleri, Windows'da seçilen ölçeklendirme faktörüne bağlı olarak biraz
yumuşak veya bulanık görünebilir. Ancak okunabilirlik ve işlevsellik etkilenmez.

Durdurulan özellikler
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Fiery Hot Folders filtreleri

Aşağıdakiler artık, Fiery Hot Folders tarafından dönüştürülmeyecektir:

• Fiery Graphic Arts Package, Premium Edition ve Fiery Productivity Package'da bulunan filtreler: PDF2GO,
ExportPS, CT-LW, DCS 2.0 ve TIFF-IT.

• Adobe PDF Print Engine (APPE), Fiery server öğesinin PDF işlerini PostScript'e dönüştürme gereksinimi
olmadan yerel olarak işlemesini ve çevirmesini sağladığı için Fiery Hot Folders içinde PDF'den PS'ye
(PostScript) dönüştürme özelliği durdurulmuştur.

Fiery Remote Scan TWAIN eklentisi

Fiery Remote Scan TWAIN eklentisi kaldırıldığı için sayfaları Adobe Acrobat veya Adobe Photoshop gibi
üçüncü taraf uygulamalara doğrudan tarama özelliği de artık desteklenmemektedir. Ancak Fiery Remote Scan
bağımsız uygulaması tarama işlerini almaya ve desteklenen bir Fiery server'daki tarama posta kutularını otomatik
olarak bilgisayarınızla eşitlemeyi desteklemeye devam edecektir.

Fiery JobMaster taraması

Fiery JobMaster 5.0 (Fiery Command WorkStation Package6.3uygulamasına dahil olan) artık TWAIN tarama
sürücülerini desteklemiyor.
Artık, Fiery JobMaster 5.0 ile aşağıdakiler de desteklenmektedir:

• WIA (Windows Image Acquisition) sürücüleri

• Mac ICA (Image Capture Application) sürücüleri

• Fiery Remote Scan sürüm 6.7 eklentisi (Fiery JobMaster'a özgüdür)

Fiery Software Manager uygulama kısayolları

Fiery Software Manager, Windows masaüstünde veya macOS Dock'ta uygulama kısayolları oluşturmaz. Ancak
Fiery server'a doğrudan yapılan Fiery Command WorkStation yüklemeleri, Windows masaüstünde uygulama
kısayolları oluşturmaya devam eder.

Fiery Command WorkStation Package v6.3.0.333'de düzeltilen sorunlar

Aşağıdaki sorunlar düzeltilmiştir:
Fiery Command WorkStation

• Fiery Impose ve Fiery Preview'da belirli PDF dosyalarını açtığınızda artık işlenmeyen bir özel durum mesajı
oluşmaz.

Fiery XF

• Özel ayarlar penceresinde RTL dosyaları için GIF önizlemesi oluştur seçeneği devre dışı bırakılmış halde baskı
makinesi önceden dosyaya yazdıracak şekilde yapılandırılmışsa, IP baskısı için kurulmuş VUTEk 32r ve h3/h5
baskı makineleri için GIF oluşturmak mümkün değildi.

• Color Tools'da kalibrasyon ayarları seçildiğinde Nokta boyutu çıktı seçeneği artık Epson SureColor S306X0 baskı
makineleri için Çoklu vuruş olarak doğru şekilde görüntülenir.
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• Görsel plaka telafi dosyalarına kaydedilen ton değerleri artık Fiery XF 6.5'de kaydedilenlere karşılık gelir.

• Color Tools'da bir profili optimize ederken En iyi duruma getir düğmesinin konumu artık statik kalır. Daha önce
düğme her bir yinelemede pencerede giderek aşağı hareket ediyor ve sonunda görünmez hale geliyordu.

Fiery Command WorkStation Package v6.3.0.307'de düzeltilen sorunlar

Aşağıdaki sorunlar düzeltilmiştir:
Fiery Command WorkStation

• Artık bir Fiery server sisteminde bir Yönetici olarak özel karakterler içeren ve en az 10 karakterden oluşan bir
şifre ile oturum açtığınızda Kağıt katalogu, Kaseti hizalamave Cihaz merkezi bölümlerine kolayca erişebilirsiniz.

• MacOS bilgisayarlarda, ES-1000 ölçüm cihazı ile yeniden kalibre ettiğinizde veya bir kalibrasyon
oluşturduğunuzda Fiery Command WorkStation ile çalıştırılan Fiery Calibrator artık bip sesi çıkarır.

• Nokta renklerini Cihaz merkezi > Kaynaklar > Nokta renkleri içine sürükleyip bıraktığınızda Fiery Command
WorkStation yanıt vermeyi durduruyordu.

• Bazı durumlarda, Fiery Preview, Fiery Impose, Fiery Compose veya Fiery JobMaster' da bir iş açtığınızda
önizleme görüntüleri bulanık olarak görünüyordu.

Fiery XF

• Job Editor, kırpma işaretlerinin çizgi kalınlığını doğru şekilde görüntüleyemiyordu.

• Çok sayfalı bir iç içe yerleştirme işinde, sayfa yönünün veya sayfalar arasındaki mesafenin değiştirilmesi yeni bir
iç içe yerleştirme sayfasının oluşturulmasına neden olduğunda Job Editor yanıt vermeyi durduruyordu.

• Bazı durumlarda, EFI lisans yöneticisi hizmetinin kullanılamaması nedeniyle, Fiery Command WorkStation 6.3
sürümüne yükselttikten sonra Fiery XF sunucusu başlamıyordu.

Fiery Command WorkStation Package v6.3.0.280'de düzeltilen sorunlar

Aşağıdaki sorunlar düzeltilmiştir:
Fiery Command WorkStation

• Çok sayıda Paper Catalog girişi olan Fiery server ögesinde, Fiery Ticker çalışıyorsa kasete ortam atamak için tüm
Paper Catalog girişlerine kaydırarak ilerleyemezdiniz.

• Fiery Command WorkStation İngilizce dışında bir dile ayarlı ise İş günlüğü içinde bir başlangıç tarihi aralığı
seçtiğinizde işler İş günlüğü'nde mevcutsa bile görüntülenmiyordu.

Fiery XF

• Herhangi ISO 12647-7 denetim çubuğu seçtiğinizde yazdırılan iş etiketi, ISO uygunluğu sağlamak için gerekli
olan tüm bilgileri içerir. Bu ayarların seçimini kaldıramazsınız. Ancak gerekiyorsa İş etiketi düzenleyicisi'nde ek
ayarları seçebilirsiniz.

• Fiery Command WorkStation ile bir Fiery XF sunucusunda uzaktan oturum açıldıysa Job Editor'da bir diğer
nokta rengi seçmek mümkün olmayabiliyordu.

• Artık kesim kontur kaynaklarını ve yöntemleri ön ayar olarak doğru şekilde kaydedebilirsiniz.

• Kenarlıksız yazdırma seçildiyse bekletilen iş, Geçersiz yaprak boyutu algılandı hatası ile başarısız oluyordu.
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• Fiery Command WorkStation ve Fiery XF ögelerinin bazı kombinasyonlarında, Color Tools'da bir profili en iyi
duruma getirmek için Epson SpectroProofer ILS30 kullanırken M2 ölçüm modu kaydedilmiyordu. M2 (UV
kesim) seçeneğini belirlediyseniz bile sonuç, ölçüm modu M1 olan UV'yi içeriyordu.

• Epson SpectroProofer IL30 için M2 ölçüm modu yöntemini kullanarak bir doğrulama ölçüsünü en iyi duruma
getirmeye çalıştıysanız, M2 ölçümü kaydedilmediğinden hiçbir iyileşme algılanmayabiliyordu.

• macOS bilgisayarlarda Fiery Command WorkStation, İş merkezi sütun başlıkları üzerine tıklayarak işler
sıralanırken yanıt vermeyi durduruyordu.

• Color Tools > Ölçümle yeniden kalibrasyon'da ilk grafiğin ölçülmesi sonrasında takip eden önerilen adımlar bazı
dillerde kesiliyordu.

• Çift monitörlerde artık ikincil monitörde Color Tools'u yeniden başlatabilirsiniz. Daha önce Color Tools her
zaman birinci monitörde açılıyordu.

Fiery Command WorkStation Package v6.3.0.271'de düzeltilen sorunlar

Aşağıdaki sorunlar düzeltilmiştir:
Fiery Command WorkStation

• Nokta rengi örnek baskısı yazdırdığınızda, İş özellikleri > Görüntü sekmesinden bazı ayarlar uygulanmıyordu.

Fiery XF

• Beyaz ayrım Çıktı klasöründe eksik olduğu için VUTEk 3r/5r/3r+/5r+ yazıcılar için önceden beyaz ayrımlar
oluşturmak mümkün değildi. Sorun en son sürümde çözüldü.

• Color Editor'de örnek kitaplar varsayılan ortam boyutuna yazdırılmalıdır. Artık özel bir ortam boyutu tanımlamak
mümkün değildir.

V 6.3.0.259 ile Fiery Command WorkStation Package giderilen sorunlar

Aşağıdaki sorunlar düzeltilmiştir:
Fiery Command WorkStation

• macOS bilgisayarda İngilizce dışındaki bir dilde yapılandırılmış Fiery sunucusu ile Sunucu > Günlükler > Yazdır >
Yerel yazıcı > Yazdır seçimini yaptığınızda açılan Yazdır iletişim kutusu İngilizce idi.

• Fiery Hot Folders tercihleri artık Fiery Impose şablonu yol seçimi içermez. Bunun yerine Fiery Command
WorkStation ile aynı yolu kullanır.

• Fiery Kalibratör daha hızlı başlar ve yanıt verir.

Fiery XF

• Job Editor'de kırpma alanını özelleştirmek için Ölçek değerlerini düzenleyemiyordunuz.

• Color Tools > Kalibrasyon oluştur > Özet'te renk gamını kalibrasyon dosyasıyla karşılaştırmak için Profile
Inspector'da ortam profili açılamıyordu.

• İşletim sistemi Ingilizce olarak ayarlanmamışsa yalnızca gelişmiş kalibrasyon grafikleri yazdırabiliyordunuz.

• Kalibrasyon dosyası oluşturmak için IP üzerinden bir Barbieri Spectro LFP qb ölçüm cihazı kullanmak, yanlış IT8
verisi oluşumuna neden oluyordu. Bunun sonucu olarak kalibrasyon dosyasını Color Tools > Kalibrasyon oluştur
> Özet > Profile Inspector'da açamıyordunuz.
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• Dahili bir ölçüm cihazı kullanarak dynamic wedge ölçmek için Job Editor'da doğrulama işi ayarlarsanız,
doğrulama sonrası Job Editor hatalı delta E sonuçları görüntülüyordu. Hem Verifier hem de Job Editor şimdi
doğru delta E değerlerini görüntüler.

• Herhangi bir VUTEk yazıcı için Color Tools > Kalibrasyon oluştur> Toplam mürekkep sınırı seçiminde toplam
mürekkep sınırı (TIL) değerini değiştirdiğinizde Color Tools yanıt vermeyi durduruyordu.

• ES-2000 ölçüm cihazını kullanarak kalibrasyon işleminde ilk grafiği ölçemiyordunuz

Düzeltilen sorunlar Fiery Command WorkStation Package v6.3.0.234

Aşağıdaki sorunlar düzeltilmiştir:
Fiery Command WorkStation

• Nokta renkleri > İş özelikleri'nde Çift taraflı seçenek ayarını kaydedemediniz.

• Fiery sunucusunu yeniden kalibre etmeden önce Kalibratör ayarları penceresine erişirseniz, Fiery Kalibratör yanıt
vermeyi durduruyordu.

• EFI ES-2000 cihazını kullanarak yeniden kalibre ederken ek seti değeri olarak 51 rastgele seçtiyseniz, yazdırılan
renk grafiği ve Fiery Command WorkStation içinde görüntülenen şema eşleşmiyordu.

• Kalibratör'de bir kalibrasyon oluşturduğunuzda, Kalibrasyondan sonra ACD verileri oluştur seçeneği desteklenen
yazıcılar için mevcut değildi.

Fiery XF

• Şimdi PDF kutu ayarlarını Server Manager > Sonlandırma > İşaretler > Kesme İşaretleri > Kontur kesme'de
kaydedebilirsiniz. Daha önce sadece ortam kutusu ayarı uygulanabiliyordu.

• Bir yazıcıyı bağlantı noktasına yazdıracak şekilde yapılandırırken, bağlantı noktası 9100 kullanmayan herhangi bir
yazıcıyla bağlantı kurmak mümkün değildi.

• macOS bilgisayarlarda şimdi nokta renklerini optimize etmek mümkündür. Daha önce yinelemenin başarısız
olmasına neden olan yanlış bir grafik oluşturuluyordu.

Fiery Command WorkStation Package v6.3.0.216 sürümünde düzeltilen sorunlar

Aşağıdaki sorunlar düzeltilmiştir:
Fiery Command WorkStation

• Fiery sunucusu İngilizce haricinde bir dile ayarlıyken Fiery sunucusuna kaydedilmiş bir işten sayfalar
eklediğinizde Fiery Impose veya Fiery JobMaster yanıt vermeyi bırakıyordu.

• Fiery Impose'da bir işi düzleştirilmiş bir pdf olarak kaydettiğinizde, Acrobat'ta gizli olarak işaretlenen katman
veya nesneler çıktıda görünüyordu.

Fiery XF

• Ölçekli döşemelerin döşeme etiketi artık Tek döşeme görünümü sekmesinde doğru olarak gösteriliyor.

• Renk Araçları, kalibrasyon ve kalite kontrol çizelgelerine yönelik satır satır ölçüm verilerini görüntülemiyordu.

• Profil oluşturmak için bir i1 Pro2 ölçüm cihazı kullanırken cihaz algılanamıyordu.

• L*a*b* düzeltme profilini (*.3cc) Yok olarak ayarladığınızda, profilin geçersiz olduğu belirtilen yanlış bir hata
mesajı görüntüleniyordu.
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• Bazı durumlarda, Fiery Command WorkStation 6.3 sürümüne yükselttikten sonra Fiery XF sunucusu
başlamıyordu.

• Fiery Command WorkStation 6.3 SP1 sürümüne yükseltmek C:\Program Data\Fiery\Fiery XF\Client\Working
klasörünün silinmesine neden oluyordu. Bunun neticesinde, daha önce bu klasöre kaydedilen ölçüm verilerinin
hiçbiri artık kullanılamıyordu ve raporlar bu nedenle yanlış oluşturuluyordu.

Fiery Command WorkStation Package v6.3.0.199 sürümünde düzeltilen sorunlar

Aşağıdaki sorunlar düzeltilmiştir:
Fiery Command WorkStation

• Kağıt ağırlığı hatası nedeniyle Çalışma Klasörlerinden Kitapçık Zımbası işi yazdırılamıyordu. Ancak aynı iş, Fiery
Command WorkStation üzerinden bir hata olmadan yazdırılabiliyordu.

• Japonca dil sisteminde, Çalışma Klasöründe gönderilen PDF işleri, işlerde bir İş Ön Ayarı ve Impose şablonu
bulunması durumunda işlenmiyordu.

• , Fiery Command WorkStation > Sunucu > Yapılandırma > İş Yönetimi'nde İşlem sırasında ön izleme seçeneği
etkinleştirildiğinde hem Fiery Command WorkStation hem Fiery sunucusu, yüklenen işler işlenirken yanıt
vermeyi durduruyordu.

• Bir işe Sunucu Ön Ayarı uygulandığında ve aynı işin Sunucu Ön Ayarı, işe sağ tıklanarak Tutulanlar sırasından
değiştirildiğinde Fiery sunucusu yanıt vermeyi durduruyordu.

Fiery XF

• MacOS bilgisayarlarda, Fiery Command WorkStation'ın Almanca için yapılandırılmış olduğu durumlarda Job
Editor > Sonlandırma > İşaretler > Kırpma İşaretleri'ndeki Görüntüyü kesme değerleri kaydedilmiyordu.

• Fiery sunucusu bilgisayarına USB yoluyla bağlı olan yazıcılar artık yapılandırılabilir. Daha önce, Bağlantı noktası
ile yazdır bağlantı türünün seçilmesi, seçilen bağlantı noktasının geçersiz olduğunu belirten yanlış bir mesajın
görüntülenmesine neden oluyordu.

• Döşemeler için maksimum çakışma/tutkal alanı 3,939 inç olarak ayarlanmıştı. Bu değer müşteri talebi üzerine
artırılmıştır. Artık çakışma/tutkal kenar boşluklarının 6 inçten daha geniş olması mümkündür.

Service Pack 1'de (SP1) bulunan sorunlar giderildi

HyperRIP Modu

HyperRIP modu Birden fazla iş olarak ayarlanmış FS2000 veya daha yenisine sahip bir Fiery server ögesine
bağlandığınızda, işleri İşle ve Tut'a gönderdiğinizde ilerleme çubuğu görüntülenmeyebilir.

Fiery Software Manager, KB2999226 Windows güncellemesini tespit etmiyor

Fiery Command WorkStation 6.3 SP1 paketinin daha ileri sürümlerine dahil edilmiş olan Fiery Software Manager
(FSM) sürüm 4.2.0.14, şu soruna bir çözüm içerir: FSM KB2999226 Windows güncellemesini tespit etmiyor ve hatalı
bir şekilde güncellemenin hala uygulanması gerektiğini belirtiyor. Güncelleme uygulandıktan sonra hata devam eder
ve bazı durumlarda CWS 6.3'ün yüklenmesini engeller.
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Poznámky k verzi pro zákazníky
Fiery Command WorkStation Package, v6.3

Tento dokument obsahuje důležité informace o této verzi produktu. Než budete pokračovat v instalaci, nezapomeňte
tyto informace poskytnout všem uživatelům.

Informace o této verzi

Tato verze obsahuje následující aplikace:

• Fiery Command WorkStation Packagev6.3.0.333

• Fiery Command WorkStationv6.3.0.58

• Fiery Hot Foldersv3.12.0.35

• Fiery Software Manager pro Mac v4.2.0.16

• Fiery Software Manager pro Windows v4.2.0.16

Poznámka:

Tento instalační program provede upgrade vašeho stávajícího balíčku Fiery Command WorkStation Package nebo
balíčku Fiery Extended Applications Package na poslední verzi Fiery Command WorkStation Package obsahující
Fiery Command WorkStation a Fiery Hot Folders. Aplikaci Fiery Remote Scan můžete také volitelně nainstalovat
pomocí Fiery Software Manager.
Fiery Command WorkStation Package podporuje Fiery servers se systémem Fiery System 10/10e a novějším, Fiery
proServer a Fiery XF 7.0 a novějším. Nepřipojí se k:

• Fiery servers se systémem Fiery System 9/9e Rel2 a předchozími verzemi

• Servery Fiery XF 6.x a starší

• Serverům Fiery Central

Pokud potřebujete přístup k těmto produktům, neprovádějte upgrade. Fiery Extended Applications Package je stále k
dispozici na adrese www.efi.com/cws. Úplný seznam podporovaných tiskáren na volné listy viz http://
fiery.efi.com/CWS/supported-printers.
Další informace o technických specifikacích naleznete na adrese www.efi.com/cws.

Co je nového?

Digitální tiskové stroje na volné listy: http://fiery.efi.com/CWScutsheetWN

HTTP://WWW.EFI.COM/CWS
HTTP://FIERY.EFI.COM/CWS/SUPPORTED-PRINTERS
HTTP://FIERY.EFI.COM/CWS/SUPPORTED-PRINTERS
http://www.efi.com/cws
http://fiery.efi.com/CWScutsheetWN


Širokoformátové a super širokoformátové tiskárny: http://fiery.efi.com/CWSwideformatWN

64bitová aplikace

Fiery Command WorkStation 6.3 (CWS) je nativní 64bitová aplikace pro platformy macOS i Windows.
32bitové operační systémy nejsou aplikací CWS 6.3 podporovány. Pokud je nástroj Fiery Software Manager již
spuštěný v 32bitovém operačním systému (OS), například systému Windows 7, nezobrazí oznámení o aktualizaci
týkající se balíčku CWS 6.3. Pokud se pokusíte spustit tuto verzi nástroje Fiery Software Manager ve 32bitovém
operačním systému, zobrazí se chyba kompatibility a Fiery Software Manager se nespustí. Chcete-li zobrazit
podporované operační systémy, navštivte web http://fiery.efi.com/cws-specifications.

Fiery Color Profiler Suite a Fiery Command WorkStation 6.3

Fiery Color Profiler Suite 5.0 (CPS) a starší verze nejsou plně kompatibilní s aplikací Fiery Command WorkStation
Package 6.3 (CWS) pro digitální tiskové stroje na volné listy. Doporučujeme aktualizovat na nástroj Fiery Color
Profiler Suite 5.1.
Při používání CPS 5.0 s aplikací CWS 6.3 můžete zaznamenat následující problémy:

• Pokud v nástroji CWS uvidíte zprávu „Připojte spektrofotometr k počítači“ zatímco je nástroj CPS otevřen,
zavřete CPS a pokračujte kliknutím na tlačítko OK.

• Jakmile vytvoříte nové nastavení kalibrace v modulu Kalibrátor, skryje se tlačítko Vytvořit nový profil ke spuštění
CPS. Tento problém je vyřešen po upgradu na CPS 5.1.

Poznámka: CWS 6.3 připojený k serverům Fiery XF s CPS 5.0 je podporovanou konfigurací.

Aktualizace Fiery JobFlow k použití s aplikací Fiery Command WorkStation6.3

Nástroj Fiery JobFlow 2.5 je kompatibilní s aplikací Fiery Command WorkStation Package 6.3. Starší verze nástroje
Fiery JobFlow podporovány nejsou.
Nástroj Fiery JobFlow 2.5 je zpětně kompatibilní s verzemi aplikace Fiery Command WorkStation 5.8 až 6.2. Pokud
však provedete upgrade na aplikaci Fiery Command WorkStation6.3, musíte také aktualizovat na verzi nástroje Fiery
JobFlow 2.5. Další informace naleznete na stránkách www.efi.com/jobflow.

Podpora monitoru HiDPI

Aplikace Fiery Command WorkStation6.3plně podporuje monitory HiDPI po nastavení měřítka a rozvržení Displeje
systému Microsoft Windows, takže lze změnit velikost písma a dalších položek podle celkového rozlišení displeje.
Některá písma v aplikaci se mohou jevit mírně rozostřená nebo rozmazaná v závislosti na vybrané změně měřítka v
systému Windows. Čitelnost a funkčnost však nebudou ovlivněny.

Zrušené funkce
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Filtry Fiery Hot Folders

Následující položky již nejsou podporovány pro převod pomocí Fiery Hot Folders

• Filtry obsažené v balíčku Fiery Graphic Arts Package, Premium Edition a Fiery Productivity Package:
PDF2GO, ExportPS, CT-LW, DCS 2.0 a TIFF-IT.

• Převod z formátu PDF do formátu PS (PostScript) v rámci Fiery Hot Folders byl zrušen, protože modul
Adobe PDF Print Engine (APPE) umožňuje serveru Fiery server zpracovat a reprodukovat úlohy formátu
PDF nativně bez převodu do formátu PostScript.

Modul plug-in Fiery Remote Scan TWAIN

Modul plug-in Fiery Remote Scan TWAIN byl zrušen, což odebere schopnost skenovat stránky přímo do
aplikací třetích stran, například Adobe Acrobat nebo Adobe Photoshop. Samostatná aplikace Fiery Remote Scan
však zůstane plně podporována pro načítání úloh skenování a automatickou synchronizaci schránek skenování
na podporovaném serveru Fiery server pomocí vašeho počítače.

Skenování Fiery JobMaster

Fiery JobMaster 5.0 (zahrnutá v produktu Fiery Command WorkStation Package6.3) již nepodporuje ovladače
skenování TWAIN.
Fiery JobMaster 5.0 přidává podporu pro:

• Ovladače WIA (Windows Image Acquisition)

• Ovladače pro aplikaci Mac ICA (Image Capture Application)

• Modul plug-in Fiery Remote Scan verze 6.7 (specifický pro aplikaci Fiery JobMaster )

Klávesové zkratky aplikace Fiery Software Manager

Fiery Software Manager nevytváří zástupce aplikace na ploše systému Windows nebo v systému macOS Dock.
Instalace aplikace Fiery Command WorkStation přímo na serveru Fiery server však budou nadále mít přidané
zkratky aplikací na plochu systému Windows.

Problémy opravené ve verzi Fiery Command WorkStation Package v6.3.0.333

Opraveny byly následující problémy:
Fiery Command WorkStation

• Při otevření určitých souborů PDF v aplikaci Fiery Impose a Fiery Preview se již nezobrazuje zpráva o neošetřené
výjimce.

Fiery XF

• Pokud byla tiskárna dříve nakonfigurována pro tisk do souboru s vypnutou možností vytvořit GIF náhled souborů
RTL v okně Speciální nastavení, nebylo možné vytvořit soubory GIF pro tiskárny VUTEk 32r a H3/H5 nastavené
pro IP tisk.

• Při volbě nastavení kalibrace v Color Tools se pro tiskárny Epson SureColor S306X0 možnost výstupu Velikost
bodu nyní zobrazuje správně jako Více tahů.
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• Tonální hodnoty uložené v souborech kompenzace vizuální desky nyní odpovídají hodnotám uloženým v
zařízení Fiery XF 6.5.

• Když optimalizujete profil v Color Tools, poloha tlačítka Optimalizovat zůstává nyní statická. Dříve docházelo k
posunu tlačítka v okně dolů při každé iteraci. V některých případech pak bylo nedostupné.

Problémy opravené ve verzi Fiery Command WorkStation Package v6.3.0.307

Opraveny byly následující problémy:
Fiery Command WorkStation

• Když se přihlásíte jako správce do Fiery server s heslem obsahujícím speciální znaky a délkou více než 10 znaků,
můžete nyní snadno otevřít Paper Catalog, Zarovnat zásobníka Středisko zařízení.

• Pokud na počítačích se systémem macOS spustíte modul Fiery Calibrator z Fiery Command WorkStation, při
rekalibraci nebo vytvoření kalibrace s měřicím zařízením ES-1000 se nyní ozve pípnutí.

• Při přetažení přímých barev v části Středisko zařízení > Prostředky > Přímé barvy přestala aplikace Fiery
Command WorkStation reagovat.

• V některých případech se při otevření úlohy v nástrojích Fiery Preview, Fiery Impose, Fiery Compose nebo Fiery
JobMaster, zobrazovaly rozmazané obrázky.

Fiery XF

• Nástroj Job Editor nedokázal správně zobrazit tloušťku čáry značek oříznutí.

• V úlohách vnoření s více stránkami přestal nástroj Job Editor reagovat, pokud změna orientace stránky nebo
vzdálenosti mezi stránkami způsobovala vytvoření nové vnořené stránky.

• V některých případech se po upgradu na Fiery Command WorkStation 6.3 nespouštěl server Fiery XF, z důvodu
nedostupnosti služby správce licencí EFI.

Problémy opravené ve verzi Fiery Command WorkStation Package v6.3.0.280

Opraveny byly následující problémy:
Fiery Command WorkStation

• Na serveru Fiery server s velkým počtem položek v modulu Paper Catalog nebylo možné projít všechny položky
modulu Paper Catalog a přiřadit média k zásobníkům, pokud byl supštěný Fiery Ticker.

• Když byla aplikace Fiery Command WorkStation nastavená na jiný jazyk než angličtinu, tak se při zadání
počátečního data rozsahu v Protokolu úloh nezobrazily žádné záznamy, i když byly v Protokolu úloh dostupné
úlohy.

Fiery XF

• Když vyberete jakýkoli kontrolní proužek ISO 12647-7, tak vytištěný štítek úlohy obsahuje všechny informace
potřebné k dosažení souladu s ISO. Označení těchto možností nelze zrušit. V případě potřeby však můžete v
nástroji Editor štítku úlohy vybrat další nastavení.

• V aplikaci Job Editor nebylo možné vybrat přímou barvu alias, pokud byla aplikace Fiery Command WorkStation
vzdáleně přihlášená k serveru Fiery XF.

• Nyní můžete správně uložit zdroje řezu kontur a metody jako předvolbu.

• Pokud byl vybrán Tisk bez okrajů, zařazená úloha se nezdařila s chybou Zjištěna neplatná velikost archu.
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• S některými kombinacemi Fiery Command WorkStation a Fiery XF se při použití měřicího přístroje Epson
SpectroProofer ILS30 k optimalizaci profilu v nástroji Color Tools neuložilo nastavení režimu zařízení M2. I když
byl vybrán režim M2 (bez UV), výsledek přesto zahrnoval UV, což by mělo být pouze v režimu zařízení M1.

• Pokud jste se pokusili optimalizovat ověřovací měření pomocí metody režimu zařízení M2 pro zařízení EPSON
SpectroProofer IL30, nebylo možné zjistit žádné zlepšení, protože měření M2 nebylo uloženo.

• Na počítačích se systémem MacOS přestala aplikace Fiery Command WorkStation reagovat, když byly ve
Středisku úloh úlohy seřazeny kliknutím na záhlaví sloupců.

• Ve funkci Color Tools > Opětovná kalibrace měřením se doporučené kroky, které je nutné dodržovat po změření
prvního grafu, v některých jazycích nezobrazovaly celé.

• Při použití dvou monitorů můžete nyní nástroj Color Tools znovu spustit na sekundárním monitoru. Dříve se
nástroj Color Tools vždy otevřel pouze na primárním monitoru.

Problémy opravené ve verzi Fiery Command WorkStation Package v6.3.0.271

Opraveny byly následující problémy:
Fiery Command WorkStation

• Když jste vytiskli ukázky přímých barev, některá nastavení z nabídky Vlastnosti úlohy > Obrázek nebyla použita.

Fiery XF

• Dříve nebylo možné vytvořit bílé separace pro tiskárny VUTEk 3R/5R/3R +/5R +, protože ve výstupní složce
chyběla bílá separace. V poslední verzi je tento problém vyřešen.

• V aplikaci Color editor musí být vzorníky vytištěny na výchozí velikost média. Již není možné definovat vlastní
velikost média.

Chyby opravené ve verzi Fiery Command WorkStation Package v 6.3.0.259

Opraveny byly následující problémy:
Fiery Command WorkStation

• Pokud byl v počítači se systémem macOS nakonfigurován server Fiery v jiném jazyce než v angličtině, při
přechodu do části Server > Protokoly > Tisk > Místní tiskárna > Tisk, se dialogové okno Tisk otevřelo v angličtině.

• Předvolby Fiery Hot Folders již neobsahují výběr cesty k šabloně Fiery Impose. Místo toho se používá stejná cestu
jako u Fiery Command WorkStation.

• Kalibrátor Fiery se rychleji spouští i reaguje.

Fiery XF

• V nástroji Job Editor nebylo možné upravit hodnoty Měřítka pro přizpůsobení oblasti ořezu.

• V části Color Tools > Vytvořit kalibraci > Souhrn nebylo možné v nástroji Profile Inspector otevřít profil média za
účelem porovnání palety barev s nastavením v souboru kalibrace.

• Pokud byl v operačním systému nastavený jazyk angličtina, bylo možné vytisknout pouze rozšířené grafy
kalibrace.

• Při použití měřicího zařízení Barbieri Spectro LFP qb přes IP, za účelem vytvoření souboru kalibrace, došlo k
vygenerování chybných dat IT8. V důsledku toho nebylo možné otevřít soubor kalibrace v části Color Tools >
Vytvořit kalibraci > Souhrn > Profile Inspector.
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• Pokud jste v nástroji Job Editor nastavili úlohu ověření tak, aby prováděla měření položky dynamic wedge
pomocí vestavěného měřicího zařízení, nástroj Job Editor zobrazil po ověření nesprávné výsledky Delta E.
Nástroje Verifier i Job Editor nyní zobrazují správné hodnoty delta E.

• Pokud jste upravili hodnotu celkového limitu inkoustu (TIL) v části Color Tools > Vytvořit kalibraci > Celkový
limit inkoustu pro jakoukoli tiskárnu VUTEk, nástroj Color Tools přestal reagovat.

• První graf v procesu kalibrace nebylo možné měřit pomocí měřicího zařízení ES-2000

Problémy opravené ve verzi Fiery Command WorkStation Package v6.3.0.234

Opraveny byly následující problémy:
Fiery Command WorkStation

• Možnost nastavení Oboustranný tisk nelze uložit v části Přímé barvy > Vlastnosti úlohy.

• Je-li otevřít okno Nastavení nástroje kalibrátor před provedením rekalibrace server Fiery, Fiery Calibrator přestal
reagovat.

• Pokud jste při rekalibraci pomocí zařízení EFI ES-2000 jako hodnotu políčka vybrali 51 náhodných, vytištěný
barevný graf a graf zobrazený v Fiery Command WorkStation se neshodují.

• Pokud jste v nástroji Kalibrátor vytvořili kalibraci, možnost Generovat data ACD po kalibraci nebyla k dispozici
pro podporované tiskárny.

Fiery XF

• Nyní můžete uložit nastavení v okně PDF v nástroji Server Manager > Dokončování > Značky > Značky řezání
>Obrys řezání. Dříve bylo možné použít pouze nastavení rámečku média.

• Při konfiguraci tiskárny pro tisk do portu nebylo možné nastavit připojení k tiskárně, která nepoužívala port
9100.

• Na počítačích se systémem macOS lze nyní optimalizovat přímé barvy. Dříve docházelo ke generování
nesprávného grafu, což způsobovalo selhání iterací.

Problémy opravené ve Fiery Command WorkStation Package v6.3.0.216

Opraveny byly následující problémy:
Fiery Command WorkStation

• Pokud byl server Fiery nakonfigurován v jiném jazyce než v angličtině, pak při vložení stránek úlohy uložené na
serveru Fiery, ve Fiery Impose nebo Fiery JobMaster přestal reagovat.

• Když jste v aplikaci Fiery Impose uložili úlohu jako sloučený soubor pdf, vrstvy nebo objekty označené v aplikaci
Acrobat jako skryté se zobrazily ve výstupu.

Fiery XF

• Na kartě Zobrazení jedné dlaždice se nyní u dlaždic se změněným měřítkem správně zobrazuje štítek dlaždice.

• Nástroj Color Tools nezobrazoval v grafech kalibrace a řízení kvality data měřená po řádcích.

• Při vytváření profilu s pomocí měřicího zařízení i1 Pro2 nebylo možné zařízení detekovat.

• Pokud jste nastavili korekční profil L*a*b* (*.3cc) na hodnotu Žádný, zobrazila se nesprávná chybová zpráva, že
profil je neplatný.
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• V některých případech se po upgradu na Fiery Command WorkStation 6.3 nespustí server Fiery XF.

• Upgrade na Fiery Command WorkStation 6.3 SP1 způsobil smazání složky C:\Program Data\Fiery\Fiery XF
\Client\Working. V důsledku toho všechna data měření, která byla dříve uložená do této složky, přestala být k
dispozici, což vedlo k vytváření nesprávných zpráv.

Problémy opravené v aplikaci Fiery Command WorkStation Package v6.3.0.199

Byly opraveny následující problémy:
Fiery Command WorkStation

• Nebylo možné vytisknout úlohu Sešití brožury z Hot Folders z důvodu chyby gramáže papíru. Stejnou úlohu však
bylo možné bez chyby vytisknout z aplikace Fiery Command WorkStation.

• V japonském jazykovém systému nedocházelo ke zpracování úloh PDF odeslaných do Hot Folder, pokud úlohy
obsahovaly předvolbu úlohy a šablonu vyřazování.

• Pokud byla povolena možnost Náhled při zpracování v nastavení > Fiery Command WorkStation > Server >
Configure > Správa úloh, tak aplikace Fiery Command WorkStation i server Fiery přestali reagovat při
zpracování některých úloh vyřazování.

• Když jste použili Předvolbu serveru na úlohu a změnili Předvolbu serveru stejné úlohy kliknutím pravým
tlačítkem na úlohu z fronty Podrženo, server Fiery přestal reagovat.

Fiery XF

• U počítačů se systémem Mac se neukládaly hodnoty Vyjmout snímek vEditoru úloh > Dokončování > Značky >
Značky ořezu pokud byla aplikace Fiery Command WorkStation konfigurována na němčinu.

• Nyní můžete nakonfigurovat tiskárny, které jsou připojeny k serveru Fiery prostřednictvím USB. Dříve došlo
výběrem typu připojení Tisk prostřednictvím portu k zobrazení chybné zprávy, uvádějící, že vybraný port je
neplatný.

• Maximální překrytí/spojovací oblast dlaždic byla nastavena na 3,939 palců. Tato hodnota byla zvýšena podle
požadavku zákazníka. Teď jsou možné okraje překrytí/spojování větší než 6 palců.

Potíže opravené aktualizací Service Pack 1 (SP1)

Režim HyperRIP

Když jste připojení k Fiery server FS200 nebo novějšímu a režim HyperRIP je nastavený na Více úloh, nemusí se při
odesílání úloh do fronty Zpracovat a podržet zobrazit indikátor průběhu.

Fiery Software Manager nedetekuje aktualizaci systému Windows KB2999226

Nástroj Fiery Software Manager (FSM) verze 4.2.0.14, který je součástí novějších verzí balíčku Fiery Command
WorkStation 6.3 SP1, obsahuje opravu následujícího problému: nástroj FSM nedetekuje aktualizaci systému
Windows KB2999226 a chybně uvádí, že aktualizaci je třeba znovu nainstalovat. Chyba přetrvává i po instalaci
aktualizace a v některých případech zabrání instalaci aplikace CWS 6.3.
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